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1. Installation Requirements and Preparation
Introduction

The document provides instructions for installing and upgrading to the 2017 release of
Changepoint. Upgrade instructions for service packs are in the service pack team folders.

Some of the information in this document is for the ongoing maintenance of a Changepoint
installation.

Changepoint components

A minimal Changepoint installation consists of the following required components:

• database (Changepoint database, CPTempDB, CPExtended)

• website

• scheduled jobs

• Redis (third-party caching component)

Optional applications, features, and services include Changepoint software and third-party
software.

About the secondary databases

CPTempDB and CPExtended are secondary databases that are on the same server as the
main Changepoint database, and are installed automatically when you install the Changepoint
database using the installer.

CPTempDB provides dedicated temporary storage and processes transient, session-based
data and code. By design, the CPTempDB database is created using Simple Recovery Mode
to minimize log space requirements. The session-based architecture virtually eliminates the
need for dynamic SQL and schema level locks, thereby drastically minimizing time
consuming recompilation within the SQL Server.

CPExtended provides storage for logging error messages and performance data as well as
background job scheduling and management.

InfinitiDB is the storage location for Intelligent Forms. The database stores the forms as well
as the administration and configuration data.

File path conventions

Throughout this document, the following conventions are used for common paths:
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Convention Meaning

<cp_root> The root path of the Changepoint installation.

The default is:

C:\Program Files (x86)\Changepoint\Changepoint\

<cp_common> The root location for commonChangepoint utilities, such as the Login

Settings utility.

The default is:

C:\Program Files (x86)\Common Files\Changepoint\Changepoint\

Note: The Login Settings utility is installed in
C:\Program Files\Common Files\Changepoint\Changepoint\LoginSettings\

regardless of the root folder for Changepoint installation.

Changepoint documentation

This guide contains references to the following documentation, which is available in the
2017 Release Notes and Patches team folder in Client Portal, or from your client manager:

• Changepoint Product Architecture and Technology Matrix

• Changepoint Hardware Recommendations Guide

• User Basics User Guide

• Changepoint API Installation Guide

• Microsoft Dynamics GP Toolkit Administration Guide

Hardware and software requirements

Changepoint server software can be deployed on a single server or on multiple servers.

Ensure that each server meets the following requirements:

• hardware requirements in the Changepoint Hardware Recommendations Guide.

• software requirements in the Changepoint Product Architecture and Technology Matrix

Warning: If the servers do not meet the hardware and software requirements, the
installation might fail silently.
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Required skills

To install Changepoint, you must be familiar with administering the following software:

• Microsoft SQL Server

• Microsoft Windows Server

• Microsoft Internet Information Services (IIS)

• .NET

If you do not have these skills, or require assistance with implementing Changepoint, contact
your Changepoint client services representative or client manager.

Latest patches and service packs

Check the 2017 Release Notes and Patches team folder, for service packs and for general
patches that have been posted for this release.

You install service packs and general patches according to the instructions in the service pack
or patch release notes.

Required accounts and permissions

You require the following credentials on each host:

• All servers – local or domain administrator account

• The user account running the SQL server service must have write permission to the
Changepoint data and log folders.

• Database server:

• SQL administrator (sa) account, which is required to install and configure the
Changepoint database

• SQL account, which is required for the Changepoint applications to access the
database

If the SQL account does not already exist on the SQL Server, it is created with the same
password as the user ID during installation. Therefore it is strongly recommended that you
create this account with an appropriate password before you start installation.
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Installation considerations

Installation using Remote Desktop Protocol (RDP)

Set the connection to more than 256 colors in the RDP dialog:

Remote Desktop Connection > Display > Colors

Otherwise installation fails with the message:

"Error Number: 0x80004005 Description: Unspecified error Setup will now

terminate"

Enabling enhanced session management

Keep the following points in mind if you plan to enable enhanced session management, which
restricts authenticated users to one active session per browser container.

• Report scheduling and security – the Changepoint Report Prerender service required for
the report scheduling feature is incompatible with Enhanced session management.

• Web server name

• Client Portal website

• Mobile access to Changepoint

• Naming constraints for the web server name – ensure that the web server name does not
contain an underscore, otherwise client workstations need to connect to the server using
the IP address instead of server name to log into Changepoint.

Custom headers to emulate Internet Explorer 7 mode for Report Designer
websites

The Report Designer website requires a custom HTTP response header to emulate Internet
Explorer 7 mode. The Changepoint installer takes care of this configuration.

Note: The EmulateIE7 custom header is not required for the Changepoint website.

1. Select Start > Administrative Tools > Internet Information Services (IIS) Manager.

The IIS Manager opens.

2. Expand the tree view and locate the website under Sites.

The home page of the website appears.

3. In the IIS section, double-click the HTTP Response Headers icon.
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4. On the Actions menu, click Add.

5. In the Name field, enter “X-UA-Compatible.”

6. In the Value field, enter “IE=EmulateIE7”.

7. Click OK.

Removing emulate Internet Explorer 7 mode

On the Changepoint web server, if Emulate IE7 was added at the server/system level in IIS, it
may cause the Report Designer websites to crash, and alter the layout in the UI in
Changepoint.

To correct this problem, in IIS Manager, remove any existing server/system-level HTTP
Response Header that has Name “X-UA-Compatible” and Value “IE=EmulateIE7”.

Perform a backup

To prevent data loss, back up each host before installation.

Install on a test environment first

It is strongly recommended that you install the Changepoint database and applications in a test
environment before installing in a production environment.

Required components on the web server

The following are required on the web server:

• You must enable the following roles/features on IIS:

• NET Framework 3.5 Features

• WebSocket Protocol

Microsoft SQL Server Native Client 2012 SP1

SQL Server services required

Before installing Changepoint, ensure that the following SQL Server services are running on
the database server:

• SQL Server (MSSQLSERVER)

• SQL Server Agent (MSSQLSERVER)

• SQL FullText Filter Daemon Launcher (MSSQLSERVER)
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Installation parameters

Before you start installation, determine the values in the following table. You are prompted for
this information during installation.

Information needed Notes Your installation value

Setup Language • Dutch

• English

• French

• German

• Spanish

New Instance, or

Maintain or update an

existing instance

Setup type Complete – installs the entire Changepoint
application including the database files,

website files, and tools on a single server. This

is the recommended option for a new

installation when all features will be installed

on a single server.

Database Only – Installs the required
database files and scheduled jobs. The Login

Settings utility is also installed.

Website Only – Installs and configures only
the web application files. Use this option to

install the web application files on a separate

server from the SQL database.

Custom – Installs the features that you select.

Note: For an upgrade, the features are
preselected based on the previous installation.

Clearing the check box of a feature uninstalls

the feature from themachine.

Destination folders for application files
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Information needed Notes Your installation value

Destination Location

(root folder for

installation)

Default:
C:\Program Files (x86)
\Changepoint\Changepoint\

Referred to throughout this document as <cp_

root>.

Destination Location

(Changepoint web

application files)

Default:
<cp_root>\Enterprise\

Destination Location

(Report Designer files)

Default:
<cp_root>\ReportDesigner\

Destination Location

(Intelligent Forms web

files)

Default:
<cp_root>\Intelligent Forms\Websites\

Destination Location

(Web Services API

files)

Default:
<cp_root>\API\CP Web Services\

Destination Location

(Redis cache service)

<cp_root>\Redis\

Note: The Redis cache service will use

"RedisService" as the service name and 6379

as the port number. If either is already in use,

the Redis service install and startup will fail.

Refer to the RedisCacheService.log file under

the Changepoint InstallLog folder for details.

You will need to perform manual steps to

install and start the Redis service with a

unique service name and port number. For

more information, see "Installing and

Configuring Redis" on page 31.

Website names and ports
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Information needed Notes Your installation value

Name and port for the

Changepoint website

Default: Enterprise, 8080

Note: The name and port must be dedicated to
the Changepoint website.

Name of the Intelligent

Forms application pool

Default: CPInfiniti

Changepoint URL URL, including the protocol (http or https) for

end users to access Changepoint.

Destination locations for database files

Destination Location

(Changepoint.mdf

database file)

Default:

<cp_root>\Database\Data\

For best performance, select a dedicated I/O

channel (LUN, RAID set or physical disk) for

each of the file types (.mdf, .ndf, and .ldf)

If only three channels are available, you can

put the log and tempdb on the same channel.

Destination Location

(Changepoint2.ndf

database file)

Destination Location

(Changepoint3.ndf

database file)

Destination Location

(Changepoint4.ndf

database file)

Destination Location

(database log file)

Default:

<cp_root>\Database\Log\

Destination Location

(Intelligent Forms

database file -

InfinitiDB.mdf)

Default: The same location as the

Changepoint.mdf database file.
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Information needed Notes Your installation value

Destination Location

(Intelligent Forms

database log file -

InfinitiDB.ldf)

Default: The same location as the

Changepoint database log file.

Database login information

Database server Select the SQL Server namewhere the

Changepoint database will be installed.

Login ID (SQL Server) sa

Password (SQL Server) password for the sa account

Database Name Recommended default: Changepoint

User ID for the SQL

account that will be

used for the database

connection

Used in the Login Settings (Connection

settings) setup.

Intelligent Forms

database name

Recommended default: InfinitiDB

Mode

Mode • PSA –Changepoint PSA (Professional

Services Automation)

• ITD –Changepoint PPM (Project Portfolio

Management)
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2. Installing Required Changepoint Components
Installing Changepoint using the installer

The installer sets the Anonymous Authentication Credential to use Application Pool Identity.
The Changepoint website is assigned to its own application pool (sitename_AppPool).

1. Copy the contents of the product media to a location on the server.

2. Run the setup.exe file from the copied location.

The Changepoint 2017 window opens.

3. On the Changepoint tab, click the Install Changepoint 2017 link.

4. At each prompt, select or type the appropriate parameter from the table in "Installation
parameters" on page 18, and click OK or Next to move to the next prompt.

5. After you select the Changepoint Application Mode, click Next.

The Start Copying Files screen appears.

6. Review the current settings to ensure all information is correct.

7. If correct, click Next to continue with the installation.

When installation is complete, the InstallShield Wizard Complete screen displays.

8. To review the installation log for any errors or warnings, select I would like to open the
Installation Log file. The installation log file provides details about the issues that were
encountered and possible remedies that you can apply manually after the installation.

9. To run the Login Settings utility after the installation, select I would like to launch
Login Settings (Connection Settings). This utility is used to configure and encrypt the
connection settings for security purposes. At this time, you can configure the connection
settings for:

• Changepoint

• Enterprise\global.asa

• Enterprise Report Server\global.asa

• Enterprise\WebAPI\web.config

• Enterprise\WebSocket\web.config
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• Intelligent Forms\Websites\InfinitiLaunch\web.config

• Intelligent Forms\Websites\IntelledoxSchedulerIntelledoxScheduler.exe.config

• Intelligent Forms\Websites\ChangepointDataService\web.config

• Intelligent Forms\Websites\Manage\web.config

• Intelligent Forms\Websites\Product\web.config

• API\CP Web Services\web.config

• Intelligent Forms

• Web Services API

• the executables associated with Changepoint scheduled jobs

See "About configuring database connection settings" on page 65 for instructions.

10. Click Finish.

11. To install additional instances of Changepoint on this server, see "Installing multiple
Changepoint instances" on page 24.

12. Configure Redis. For more information, see "About Redis" on page 31

13. Complete the post-installation instructions.

For more information, see "Configuring Changepoint" on page 47.

Installing multiple Changepoint instances

You can run the InstallShield Wizard as many times as needed on the same servers to install
multiple Changepoint websites and databases.

A common scenario for creating multiple databases on a server is setting up training and test
environments. For more information, see "Creating a Test and Training Environment" on page
219.

Note the following:

• The Changepoint website names and database names must be unique for each instance on
the server.

• The port number for each Changepoint website on the server must be unique.
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• Scheduled jobs are created for each database with the database name prepended to the job
names.

• You must configure the database access settings for the appropriate database and the
applicable .exe jobs

• Because you can install only one instance of each Changepoint Windows service (for
example, Report Prerender Service, Report Scheduler Service, and Changepoint Mail
Service) on a server, Windows service instances for each database after the first must be
set up on separate servers.

1. Install the first website instance using the procedure described in "Installing Changepoint
using the installer" on page 23.

2. Run the setup.exe file again.

The Changepoint 2017 window opens.

3. On the Changepoint tab, click the Install 2017 link.

The Existing Installed Instances Detected screen displays.

4. Select the Install a new instance option, and then click Next.

5. The remaining steps are the same as the standard procedure for installing using the wizard.

Note: The Redis cache service will use "RedisService" as the service name and 6379 as
the port number. If either is already in use, the Redis service install and startup will fail.
Refer to the RedisCacheService.log file under the Changepoint InstallLog folder for
details. You will need to perform manual steps to install and start the Redis service with a
unique service name and port number. For more information, see "Installing and
Configuring Redis" on page 31.

Modifying a Changepoint instance

To add or remove features, use the Windows Control Panel, or run the InstallShield Wizard
again on an installed Changepoint instance.

Note: You must use SQL Server Management Studio to remove a database.

Modifying Changepoint using the InstallShield Wizard

1. Run the setup.exe file again.

The Changepoint 2017 window opens.
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2. On the Changepoint tab, click the Install Changepoint 2017 link.

The Existing Installed Instances Detected screen displays.

3. Do the following:

a. Select the Maintain or update the instance of this application selected below
option.

b. Select the instance that you want to modify from the list of instances.

c. Click Next.

The Welcome screen appears.

4. Select the Modify option and click Next.

The Select Features screen displays.

5. Do the following:

• To install a feature, select the check box.

• To remove a feature, clear the check box.

6. The remaining steps are the same as the standard procedure for using the wizard.

Uninstalling a Changepoint instance

You can uninstall Changepoint using the Windows Control Panel, or the InstallShield Wizard.

Note: All features are removed except the database. To remove the database you must use
SQL Server.
If you uninstall Changepoint after an upgrade, the previous installation of Changepoint is
not restored.

To uninstall a Changepoint instance using the InstallShieldWizard

1. Run the setup.exe file.

The Changepoint window appears.

2. On the Changepoint tab, click the Install Changepoint link.

The Existing Installed Instances Detected screen appears.

3. Do the following:
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a. Select the Maintain or update the instance of this application selected below
option.

b. Select the instance that you want to uninstall.

c. Click Next.

The Preparing Setup screen appears, followed by the Welcome screen.

4. Select the Remove option, and then click Next.

5. Click OK to confirm.

6. Click Finish.

Installing the Changepoint database manually
When you install the database manually, you must also install the scheduled jobs, CPTempDB,
and CPExtendedDB.

The default name of the CPTempDB database is: <Changepoint database name>_CPTempDb,
and the default location is the location of the Changepoint database files (mdf, ldf). However,
you can specify a different name and location, if necessary.

1. Review "Destination locations for database files" on page 20.

2. Copy the following database files for the appropriate language from the Changepoint
product media to the target locations on the database server:

\Changepoint\Manual Install\New Database\<language>\Changepoint.mdf

\Changepoint\Manual Install\New Database\<language>\Changepoint2.ndf

\Changepoint\Manual Install\New Database\<language>\Changepoint3.ndf

\Changepoint\Manual Install\New Database\<language>\Changepoint4.ndf

\Changepoint\Manual Install\New Database\<language>\Changepoint_log.ldf

Ensure that the newly copied files are read-write.

3. From the Changepoint product media, copy the files from the following folder:

\Changepoint\Manual Install\New Database\

to:

<cp_root>

Ensure that the .sql files are read-write.
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Note: For the remaining steps in this procedure, use the files in the destination folder.
After installation is complete you can delete the files in the destination folder.

4. Connect to the database server using the SQL server sa account or equivalent.

5. Edit Setup_Changepoint.sql:

a. Replace the path for the following files with the paths to these files on your database
server:

D:\DataFiles\MSSQL\DATA\Changepoint.mdf

D:\DataFiles\MSSQL\INDEX\Changepoint2.ndf

D:\DataFiles\MSSQL\INDEX\Changepoint3.ndf

D:\DataFiles\MSSQL\DATA\Changepoint4.ndf

D:\DataFiles\MSSQL\LOG\Changepoint_log.ldf

b. If the database name is not “Changepoint”

• replace “Changepoint” with the database name
• rename the files you copied in step 2

c. Execute Setup_Changepoint.sql.

6. Execute: Exec DBM_EnableSQLDependency 'webconfiguser'.

7. To create CPTempDB, execute DBM_SetupCPTempDB.

a. Open Setup_CPTempDB.sql in an editor, and replace the variables with following:

• @CPTemp_DB with the Changepoint database name
• @CPTempDB_MdfPath with the path of the MDF file
• @CPTempDB_LdfPath with the path of the LDF file

b. Run the script against the Changepoint database.

8. Execute Setup_Full_Text.sql. against the Changepoint database.

9. Execute stored procedure DBM_SetupCPExtended against the Changepoint database

Installing the scheduled jobs manually

1. Open the following script:

<cp_root>\Manual Install\New Database\Setup_Scheduled_Jobs.sql

a. Replace @SCHEDULE_JOB_PATH with the path for the scheduled jobs folder. The default
folder is:

<cp_root>\ScheduledJobs\
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b. Replace @DATAARCHIVING_JOB_PATH with the path for the archiving scheduled jobs
folder. The default folder is:

<cp_root>\Changepoint\Data Archiving\

2. Do the following:

a. Copy the Login Settings utility (Login Settings.exe) from:

<cp_root>\Manual Install\Components\LoginSettings\

to:

<cp_common>\LoginSettings\

b. Run the Login Settings utility on CPEffectiveDates.exe.config to configure the
database connection settings.

c. Run the Login Settings utility on CPGuestLicenses.exe.config to configure the
database connection settings.

For more information on the Login Settings utility, see "About configuring database
connection settings" on page 65.
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About Redis

Redis is an open source (BSD licensed), in-memory data structure store, used as a database,
cache and message broker. Redis also supports master-slave asynchronous replication and
optionally provides high availability with Redis Sentinel.

Redis is designed to be accessed by trusted clients inside trusted environments. Therefore,
the Redis instance must not be exposed directly to the Internet or to an environment where
untrusted clients can directly access the Redis TCP port. Redis should be directly accessible
only by authorized operators, and the computers that implement the application that uses
Redis.

While Redis does not implement Access Control, it does provide a simple layer of
authentication that you can enable by editing the redis.windows.conf file. When the
authentication layer is enabled, Redis will refuse any query by clients that are not
authenticated. A client can authenticate itself by sending the AUTH command followed by
the password.

The goal of the authentication layer is to optionally provide a layer of redundancy. If
firewalls or any other system that was implemented to protect Redis from external attackers
fail, an external client will still not be able to access the Redis instance without providing the
authentication password.

About installing the Redis server
The Changepoint installer automatically creates a new Redis Server instance that is
preconfigured for a single web server deployment. The installer also creates a new Redis
service instance that has a temporary authentication password and is linked one-to-one with
the Changepoint website instance that is being installed or upgraded on the web server.

The startup configuration for the Redis Server is in the redis.windows.conf file in the Redis
Server folder, and the corresponding Redis cache settings are in the web.config file for the
website.

The following are the default settings for the Redis service:

• name – RedisService

• port – 6379

• authentication password is required (temporary password is provided)
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Warning: It is highly recommended that you use a strong password that is unique to your
organization. For more information about the importance of using a strong password, see
the redis.windows.conf file.

Note: This guide includes the basic information that is required to install and configure
Redis for use with Changepoint. For more information, see the Redis website at
https://redis.io/.

Multiple web servers

If you are setting up multiple Changepoint website instances that are load balanced across
multiple web servers, then the Redis Server installed and preconfigured with the default
service name, port, and authentication password on each instance. You must designate a
master server and configure the remaining server instances as slave servers.

Common Redis commands

Use these commands for Redis service installations.

Installing the Redis service manually

redis-server --service-install redis.windows.conf --service-name RedisService --port 6379

The service is configured as Autostart and will be launched as "NT
AUTHORITY\NetworkService". Upon successful installation, a success message is displayed
and Redis exits. Redis will listen on the specified port number.

This command does not start the service.

Uninstalling the Redis service

redis-server --service-uninstall --service-name RedisService

This command removes the Redis service configuration information from the registry. Upon
successful uninstallation, a success message is displayed and Redis exits.

This command does not stop the service. To remove the service completely, stop the service
first.

Starting the Redis service

redis-server --service-start --service-name RedisService
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This command starts the Redis service. Upon successful startup, a success message is
displayed. You can also start the service by using the Services dialog or the net start command.

Stopping the Redis service

redis-server --service-stop --service-name RedisService

This command stops the Redis service. Upon successful termination, a success message is
displayed and Redis exits. You can also stop the service by using the Services dialog or the net
stop command.

Naming the Redis service

--service-name name

This parameter can be used with any of the preceding commands to set the name of the
installed service. This command is required if you plan on deploying multiple instances (for
example, development, test, production) of Changepoint on the same server because each
Changepoint instance requires a separate Redis instance. If there are only one instance of the
Changepoint website on the machine, the service name change is not required.

Specifying the Redis server port

--port 6379

You can use this parameter to configure the port that Redis listens on. If you do not configure a
port, Redis uses the port that is specified in the redis.windows.conf file (default port is 6379).
If you are accessing Redis from an external machine you must ensure that a firewall exception
exists.

Single web server deployment
This configuration is set up by default when you use the Changepoint installer to install or
upgrade. A single web server deployment requires a single Redis master server, which is
responsible for all requests (read/write).

You must do the following:

• Configure a single Changepoint web server: Web01

• Implement a single master Redis server with authentication enabled:

• Redis service name: RedisService

• Redis port: 6379
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Note: To edit the Redis configuration file (redis.windows.conf), you require a text
editor, such as Notepad++, that recognizes Unix-style line breaks. You cannot use
Windows Notepad for this purpose.

1. Configure Redis authentication:

a. Open the redis.windows.config and locate the following lines:

requirepass 6ed18d5c7df443940...

masterauth 6ed18d5c7df443940...

b. Replace the temporary authentication password with a strong password that is unique
to your organization. For more information see the note about requirepass in the
configuration file.

Warning: It is strongly recommended that you use a strong password that is unique to your
organization. For more information about the importance of using a strong password, see
the redis.windows.conf file.

2. Install the Redis Server as a service:

redis-server --service-install redis.windows.conf --service-name RedisService --port 6379

After installation, the RedisService is available in the Windows Service Management
Console.

3. Start the Redis Server service:

redis-server --service-start --service-name RedisService

The Redis master server configuration is complete and ready to accept connections.

4. Configure the Changepoint web site:

a. In the Changepoint web.config file, locate the following lines:

<add key="cache.Password" value="6ed18d5c7df443940..." />

<add key="cache.Servers" value="servername:6379" />

b. Replace the values of the authentication password, server and port number as
specified in the Redis configuration file.

c. Repeat for the WebAPI web.config file.

d. Repeat for the WebSockets web.config file.

5. Configure the global.asa file:
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a. Locate the following lines:

Application("cache.Password") = "6ed18d5c7df443940..."

Application("cache.Servers") = "servername:6379"

b. Replace the values of the authentication password, server, and port number as
specified in the Redis configuration file.

Multiple web server deployment, without high availability
A multiple web server deployment requires a Redis server to be designated as the Redis
master, and all additional servers to be configured as Redis slave servers. In this type of
environment, all read/write requests are directed to the master, and read-only requests
preferably target a Redis slave server.

Note:With this configuration, if the master server goes down, then an operator must
intervene manually to promote a slave server to the master role.

The process for configuring this sample deployment includes the following:

• Two Changepoint web servers:

• Web01 (Redis Master)

• Web02 (Redis Slave)

• A single master Redis server with authentication enabled:

• Redis service name: RedisService*

• Redis port: 6379*

• A single slave server Redis server with authentication enabled:

• Redis service name: RedisService

• Redis port: 6379

1. Configure Web01 as the Redis master server by following the procedure in "Single web
server deployment" on page 33, but do not configure the Changepoint web site.

2. Configure Web02 as the Redis slave server:

a. Follow the procedure in "Single web server deployment" on page 33, but do not
configure the Changepoint web site.

b. Navigate to the Redis installation path (default installation path is <cp_root>\Redis).
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c. Configure Redis Replication. Open the redis.windows.config and locate the
following lines:

# slaveof <masterip> <masterport>

# masterauth <master-password>

d. Uncomment the lines, and configure the replication parameters:

slaveof Web01 6379

masterauth 6ed18d5c7df443940...

Note: The passwords used for masterauth and requirepass must all be the same
within a master-slave configuration.

3. Install the Redis Service:

redis-server --service-install redis.windows.conf --service-name RedisService --port 6379

4. Start the Redis Server service:

redis-server --service-start --service-name RedisService

The Redis slave server configuration is complete, and ready to accept connections.

5. Configure the Changepoint web sites. Make the following edits to the web.config files on
all web servers:

a. In the Changepoint web.config file, locate the following line:

<add key="cache.Password" value="6ed18d5c7df443940..." />

a. Replace the value of the authentication password.

b. In the following line:

<add key="cache.Servers" value="Web01:6379;Web02:6379" />

c. Add the values for all of the Redis servers and their port numbers as specified in the
Redis configuration file.

d. Make the same changes in the WebAPI web.config file.

e. Make the same changes in the WebSockets web.config file.

6. Make the following edits to the global.asa files on all web servers:

a. Locate the following lines:

Application("cache.Password") = "6ed18d5c7df443940..."

Application("cache.Servers") = "servername:6379"
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b. Replace the values of the authentication password

c. Add the values for all of the Redis servers and their port number as specified in the
Redis configuration file.

Note: The cache.Servers value must contain all Redis servers and their defined listening
ports, separated by semicolons. For example:

Application("cache.Servers") = "Web01:6780;Web02:6781;Web03:6379;Web04:6379"

Multiple web server deployment with high availability
Using Redis Sentinel, you can create a Redis deployment that handles service outages without
manual intervention. Redis Sentinel provides monitoring of the Redis deployments, and
automatic failover when failures occur.

The high availability configuration is based on a multiple server deployment to which Redis
Sentinel is added. Therefore the starting point is to create a multiple server deployment as
described in "Multiple web server deployment, without high availability" on page 35. The
following diagram outlines the deployment.

The process for configuring this sample deployment includes the following:

• Configure three Changepoint web servers:

• Web01 (RedisMaster)

• Web02 (RedisSlave1)

• Web03 (RedisSlave2)

• Implement single master Redis server with authentication enabled

• Redis service name: RedisMaster

• Redis port: 6780

• Implement slave instance of Redis server with authentication enabled

• Redis service name: RedisSlave1

• Redis port: 6781

• Implement slave instance of Redis server with authentication enabled

• Redis service name: RedisSlave2
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• Redis port: 6782

• Implement Redis Sentinel

Configure a multiple server deployment

Configure a multiple server deployment by following the procedures in "Multiple web server
deployment, without high availability" on page 35

Installing Redis Sentinel

1. On each of the web servers, copy the existing Redis folder to a folder named Sentinel.

Note: Each web server can have only one Sentinel instance, regardless of the number of
websites that are installed on the server.

2. From the Sentinel folder, edit the following lines in the sentinel.conf file by replacing
the port number and password with the appropriate values:

port <sentinel-port>

sentinel monitor <master-name> <ip> <redis-port> <quorum>

sentinel auth-pass <master-name> <password>

sentinel down-after-milliseconds <master-name> <milliseconds>

sentinel failover-timeout <master-name> <milliseconds>

sentinel parallel-syncs <master-name> <numslaves>

logfile "sentinel.log"

Based on the example in this guide, the values would be:

port 26380

sentinel monitor RedisMaster Web01 6780 2

sentinel auth-pass RedisMaster rx6RB2CHt1lYkQnm$2jc3#CgL

sentinel down-after-milliseconds RedisMaster 30000

sentinel failover-timeout RedisMaster 180000

sentinel parallel-syncs RedisMaster 1

logfile "sentinel.log"

port <sentinel-port>

The port that the Sentinel instance will run on.

sentinel monitor <master-name> <ip> <redis-port> <quorum>

Specifies the master server to be monitored, and to consider it in ODOWN (Objectively
Down) state only if at least the number of Redis Sentinel servers specified in <quorum> agree.
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Warning: The master name cannot include special characters or spaces. The valid
characters are: A-z, 0-9, and the characters ".-_" (period, dash, and underscore).

Note: Regardless of the number that is defined as the ODOWN quorum, the majority of
Redis Sentinel servers must be online to start the failover process. In this example, if the
quorum of two (2) Sentinel instances detect that the master Web01 is not available, the
failover process begins the process of promoting one of the slave servers as the new
master.

Slave servers are autodiscovered by Sentinel, therefore you do not have to specify slave
servers in any way. Sentinel rewrites the configuration file by adding the slave servers using
additional configuration options. The configuration file is also rewritten when a slave server is
promoted to master.

sentinel auth-pass <master-name> <password>

Set the password to use to authenticate with the master and slave servers. Useful if there is a
password set in the Redis instances to monitor.

sentinel down-after-milliseconds <master-name> <milliseconds>

Number of milliseconds that the master (or any attached slave server or Sentinel server) must
be unavailable (as in, not accepting reply to PING, continuously) to be considered in S_
DOWN state (Subjectively Down).

sentinel failover-timeout <master-name> <milliseconds>

Specifies the failover timeout in milliseconds.

sentinel parallel-syncs <master-name> <numslaves>

The number of slave servers that can be reconfigured simultaneously to point to the new slave
server during a failover. Use a low number to avoid all slave servers being unreachable while
performing a synchronization with the master.

Starting Redis Sentinel (Console mode)

From a command line prompt on each of the servers, go to the Sentinel folder, and issue the
following command:

redis-server sentinel.conf --sentinel

As each Sentinel server comes online, you should receive output similar to the following:
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[5372] 16 Jan 11:54:18.485 # Sentinel runid is 5b50429514954dab8f24a099aaf3e1442fe2f2ac

[5372] 16 Jan 11:54:18.486 # +monitor master RedisMaster 127.0.0.1 6780 quorum 2

[5372] 16 Jan 11:54:56.816 * -dup-sentinel master RedisMaster 127.0.0.1 6780 #duplicate of

127.0.0.1:26381 or 3b1854570beabaaac8551db88bb5dd51625424c2

[5372] 16 Jan 11:54:56.817 * +sentinel sentinel 127.0.0.1:26381 127.0.0.1 26381 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 11:55:02.787 * -dup-sentinel master RedisMaster 127.0.0.1 6780 #duplicate of

127.0.0.1:26383 or 53525d1ebcbb8627ed3dcfbc84b858e31626c2db

[5372] 16 Jan 11:55:02.788 * +sentinel sentinel 127.0.0.1:26383 127.0.0.1 26383 @

RedisMaster 127.0.0.1 6780

The output shows that each Sentinel server found the master server and autodiscovered the
slaves. This particular configuration is hosted on the same machine, which is why there are
multiple references to 127.0.0.1.

If the master were to go offline, you will receive output similar to the following:

[5372] 16 Jan 12:00:42.415 # +sdown master RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:42.475 # +odown master RedisMaster 127.0.0.1 6780 #quorum 2/2

[5372] 16 Jan 12:00:42.475 # +new-epoch 4

[5372] 16 Jan 12:00:42.475 # +try-failover master RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:42.476 # +vote-for-leader 5b50429514954dab8f24a099aaf3e1442fe2f2ac 4

[5372] 16 Jan 12:00:42.478 # 127.0.0.1:26383 voted for

5b50429514954dab8f24a099aaf3e1442fe2f2ac 4

[5372] 16 Jan 12:00:42.478 # 127.0.0.1:26381 voted for

5b50429514954dab8f24a099aaf3e1442fe2f2ac 4

[5372] 16 Jan 12:00:42.567 # +elected-leader master RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:42.571 # +failover-state-select-slave master RedisMaster 127.0.0.1

6780

[5372] 16 Jan 12:00:42.662 # +selected-slave slave 127.0.0.1:6781 127.0.0.1 6781 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:42.662 * +failover-state-send-slaveof-noone slave 127.0.0.1:6781

127.0.0.1 6781 @ RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:42.726 * +failover-state-wait-promotion slave 127.0.0.1:6781 127.0.0.1

6781 @ RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:43.534 # +promoted-slave slave 127.0.0.1:6781 127.0.0.1 6781 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:43.536 # +failover-state-reconf-slaves master RedisMaster 127.0.0.1

6780

[5372] 16 Jan 12:00:43.599 * +slave-reconf-sent slave 127.0.0.1:6782 127.0.0.1 6782 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:44.562 * +slave-reconf-inprog slave 127.0.0.1:6782 127.0.0.1 6782 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:44.562 * +slave-reconf-done slave 127.0.0.1:6782 127.0.0.1 6782 @

RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:44.628 # -odown master RedisMaster 127.0.0.1 6780

[5372] 16 Jan 12:00:44.628 # +failover-end master RedisMaster 127.0.0.1 6780
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[5372] 16 Jan 12:00:44.628 # +switch-master RedisMaster 127.0.0.1 6780 127.0.0.1 6781

[5372] 16 Jan 12:00:44.629 * +slave slave 127.0.0.1:6782 127.0.0.1 6782 @ RedisMaster

127.0.0.1 6781

[5372] 16 Jan 12:00:44.629 * +slave slave 127.0.0.1:6780 127.0.0.1 6780 @ RedisMaster

127.0.0.1 6781

In this scenario, 2 Sentinel servers agreed that the master is not responding. Because the
majority of Sentinel servers are online, a leader is agreed upon and a new master (6781) is
elected and all remaining slaves are reconfigured accordingly. The Sentinels continue to
monitor for the missing server.

If the old master comes back online you will see similar output to the following:

[5596] 16 Jan 12:05:55.564 * +convert-to-slave slave 127.0.0.1:6780 127.0.0.1 6780 @

RedisMaster 127.0.0.1 6781

Note: Sentinel does not promote the old master, but reconfigures it as a slave of the new
master.

Installing Redis Sentinel Service

From a command line prompt on each of the servers, go to the Sentinel folder and issue the
following command:

redis-server --service-install sentinel.conf --service-name Sentinel --sentinel

The service is configured as Autostart and will be launched as "NT AUTHORITY\Net-
workService". Upon successful installation, a success message is displayed and Redis exits.
Sentinel will listen on the port number that is specified in the sentinel.conf file.

This command does not start the service.

Uninstalling Redis Sentinel Service

From a command line prompt on each of the servers, go to the Sentinel folder and issue the
following command:

redis-server --service-uninstall sentinel.conf --service-name Sentinel --

sentinel

This command removes the Sentinel service configuration information from the registry. Upon
successful uninstallation, a success message is displayed and Redis exits.

This command does not stop the service.

Starting the Redis Sentinel Service
redis-server --service-start --service-name Sentinel
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This command starts the Redis Sentinel service. Upon successful startup, a success message
is displayed and Redis service is started. You can also start the service by using the Services
dialog or the net start command.

Stopping the Redis Sentinel Service

redis-server --service-stop --service-name Sentinel

This command stops the Redis Sentinel service. Upon successful termination, a success
message is displayed and Redis exits. You can also stop the service by using the Windows
Services Management Console or the net stop command.

Common Redis Sentinel commands

Querying the status of Redis Sentinel

Redis is installed with client application called redis-cli.exe that enables command line
console to interact with and manage Redis and Redis Sentinel services.

redis-cli -p 26380

127.0.0.1:26380> ping

PONG

127.0.0.1:26380>

Show the state and information of a master

SENTINEL master <master name>

Example:

sentinel master MyRedisInstance

127.0.0.1:26380> SENTINEL master MyRedisInstance

1) "name"

2) "MyRedisInstance"

3) "ip"

4) "127.0.0.1"

5) "port"

6) "6781"

7) "runid"

8) "5a9d14a5a72c87e203a92650c4cd17dfe1f66394"

9) "flags"

10) "master"

11) "pending-commands"

12) "0"

13) "last-ping-sent"

14) "0"

15) "last-ok-ping-reply"

16) "117"
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17) "last-ping-reply"

18) "117"

19) "down-after-milliseconds"

20) "60000"

21) "info-refresh"

22) "2113"

23) "role-reported"

24) "master"

25) "role-reported-time"

26) "815163"

27) "config-epoch"

28) "4"

29) "num-slaves"

30) "2"

31) "num-other-sentinels"

32) "2"

33) "quorum"

34) "2"

35) "failover-timeout"

36) "180000"

37) "parallel-syncs"

38) "1"

Return the IP address and port number of a master

SENTINEL get-master-addr-by-name <master name>

Example:

127.0.0.1:26380> sentinel get-master-addr-by-name MyRedisInstance

1) "127.0.0.1"

2) "6781"

127.0.0.1:26380>

Show a list of slave servers and their states for a master

SENTINEL slaves <master name>

Example:

127.0.0.1:26380> sentinel slaves MyRedisInstance

1) 1) "name"

2) "127.0.0.1:6782"

3) "ip"

4) "127.0.0.1"

5) "port"

6) "6782"

7) "runid"

8) "9925a92da3a3770684532dd77cdf687b72137b0d"

9) "flags"
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10) "slave"

11) "pending-commands"

12) "0"

13) "last-ping-sent"

14) "0"

15) "last-ok-ping-reply"

16) "582"

17) "last-ping-reply"

18) "582"

19) "down-after-milliseconds"

20) "60000"

21) "info-refresh"

22) "3686"

23) "role-reported"

24) "slave"

25) "role-reported-time"

26) "1228352"

27) "master-link-down-time"

28) "0"

29) "master-link-status"

30) "ok"

31) "master-host"

32) "127.0.0.1"

33) "master-port"

34) "6781"

35) "slave-priority"

36) "100"

37) "slave-repl-offset"

38) "1939136"

2) 1) "name"

2) "127.0.0.1:6780"

3) "ip"

4) "127.0.0.1"

5) "port"

6) "6780"

7) "runid"

8) "33c8446fd8218705843aac4f057aaf7812eb9699"

9) "flags"

10) "slave"

11) "pending-commands"

12) "0"

13) "last-ping-sent"

14) "0"

15) "last-ok-ping-reply"

16) "582"

17) "last-ping-reply"

18) "582"

19) "down-after-milliseconds"
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20) "60000"

21) "info-refresh"

22) "3686"

23) "role-reported"

24) "slave"

25) "role-reported-time"

26) "1228352"

27) "master-link-down-time"

28) "0"

29) "master-link-status"

30) "err"

31) "master-host"

32) "127.0.0.1"

33) "master-port"

34) "6781"

35) "slave-priority"

36) "100"

37) "slave-repl-offset"

38) "1"

Common Redis Sentinel scenarios

To view the complete set of Redis commands, go to: https://redis.io/commands.

Scenario: Master server goes off line, need to promote a slave server to master.

localhost:6781> SLAVEOF NO ONE

Scenario: New master has been designated, need to attach existing slave servers
to new master (localhost 6781).

localhost:6782> SLAVEOF localhost 6781

localhost:6783> SLAVEOF localhost 6781

Scenario: Query current replication settings

localhost:6780> INFO Replication

# Replication

role:master

connected_slaves:1

slave0:ip=::f0f3:a200:0:0,port=6781,state=online,offset=3025,lag=0

master_repl_offset:3025

repl_backlog_active:1

repl_backlog_size:1048576

repl_backlog_first_byte_offset:2

repl_backlog_histlen:3024

Scenario: Query information related to memory consumption

localhost:6780> INFO Memory
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# Memory used_memory:2011808

used_memory_human:1.92M

used_memory_rss:1938032

used_memory_peak:2048576

used_memory_peak_human:1.95M

used_memory_lua:36864

mem_fragmentation_ratio:0.96

mem_allocator:jemalloc-3.6.0

Using arguments to send a command to redis-cli

C:\Redis>redis-cli -h localhost -p 6780 -a "rx6RB2CHt1lYkQnm$2jc3#CgL" PING

PONG
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Overview of configuration

After you have completed the installation, perform the following configuration steps:

1. Configure the settings for token authentication as follows:

a. Open the Enterprise\Web.config file, and then replace the default value of the
WebApiSecret setting with a unique string of UTF-8 characters with a recommended
size of 64 bytes. For example, you can use any combination of 64 single byte
characters.

b. Open the Enterprise\WebAPI\Web.config file and then replace the value of
WebApiSecret with the same unique string used above.

c. Open the Enterprise\WebSockets\Web.config file, and then replace the
value of WebApiSecret with the same unique string used above.

d. In a load balanced environment, ensure that you use the same WebAPISecret
value within the environment.

Note: For security reasons, it is strongly recommended that you use a different
WebAPISecret value for each Changepoint instance that you deploy.

2. Set the permissions on the Changepoint folders.

For more information, see "Setting permissions on the Changepoint folders" on page 48.

3. Review the default settings for the Changepoint scheduled jobs, and change them as
required.

For more information, see "Configuring Changepoint Scheduled Jobs" on page 83.

4. Install and set up the optional components as required. For more information, see:

• "Installing Changepoint Windows Services" on page 53.

• "Configuring an Archive database" on page 173

• "Installing and Configuring Single Sign-on" on page 147

• "Setting up mobile access to Changepoint" on page 179.

• "Installing the Changepoint online help" on page 177.

• "Setting up a Client Portal website" on page 179
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• "Setting up a survey response website" on page 180.

• "About Microsoft Exchange/Outlook synchronization" on page 181

• "Configuring batch printing" on page 182.

• "About installing Changepoint APIs" on page 183.

5. If you have not already done so, configure the database connection settings for the
Changepoint websites, installed Windows services, and scheduled job executables.

For more information, see "Configuring database connection settings" on page 65.

6. To verify connectivity, sign into all websites.

7. Review "Optimizing Performance" on page 211 for performance optimization
recommendations.

8. Run the chained scheduled jobs by starting Update Time Rate, and ensure that Resource
Demand Calculation completes successfully.

9. As required, enable or disable financial analysis record types. For more information, see
"Enabling financial analysis record types" on page 249.

10. As required, add fiscal periods to group data. For more information, see "Adding fiscal
periods to group financial analysis data" on page 249.

Setting permissions on the Changepoint folders

On the web server:

1. Set NTFS security for the Changepoint\tempimages folder to allow Full Control for all
users and groups.

2. To allow users to export survey results, grant authenticated users Modify access to the
<cp_root>\Temp folder.

About setting up Changepoint websites for SSL

If Changepoint websites are set up for SSL in Changepoint Administration, then changes are
needed in the Web.config files for Changepoint.

If you plan to install SSO, these changes are made when you run the PowerShell script for
your chosen SSO endpoint type.
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To use SSL with application authentication, follow the instructions in "About application
authentication" on page 148.

Enabling HTTP Compression
It is recommended that you enable both static and dynamic compression.

Note: You must be a member of the Administrators group on the local computer to run
scripts and executables. As a security best practice, log onto your computer using an
account that is not in the Administrators group, and then use the runas command to run
your script or executable as an administrator. The script assumes that
inetpub\Adminscripts is located on the system drive. The script performs an IIS reset
when the configuration is complete.

1. In IIS Manager, on the Compression page, select:

• Enable dynamic content compression

• Enable static content compression

2. Restart IIS.

3. To ensure proper content expiration on the client side, follow the instructions in the
Microsoft Knowledge Base article 319384.

http://support.microsoft.com/default.aspx?scid=kb;en-us;319384

4. At a command prompt, run:

Changepoint\Utilities\HTTP Compression Utility\HTTPCompressionConfigIIS.bat

If you receive the following error message when you run the .bat file, you can safely
ignore it:

ERROR ( message:New scheme object missing required attributes. Cannot add

duplicate collection entry of type 'scheme' with unique key attribute

'name' set to 'deflate'. )

Tech Notes and Knowledge Base Articles

Search the Microsoft TechNet articles for more information on enabling HTTP compression.

Setting Global IIS Parameters
Use IIS Manager to do the following for each Changepoint website:

1. On the Connections panel, select the website.
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2. Double-click the ASP feature.

3. Expand Limit Properties.

a. Set the value of the Maximum Requesting Entity Body Limit to 10000000

b. Set the value of the Response Buffering Limit to 10000000

4. In the Actions panel, click Apply.

5. Restart IIS.

Configuring IIS to allow plug-in and expense template downloads
To allow users to download .exe plug-ins from Changepoint Preferences, you must configure
the appropriate permissions in IIS.

If you have added .exe files to the deny list on your IIS server, then in the URL tab of the
Request Filter Module add the following URLs:

/ChangepointMSP.exe

/ChangepointOutlookSetup.exe

To allow users to download the expense template, add the following URL:

/ChangepointExcelExpenses.exe

Importing licences for a new installation
Use Changepoint Administration to import the licenses for granting users access to
Changepoint. You need a user license file for each user.

Note: You must configure the login settings for Changepoint Administration before you
can import licenses.

1. Open Changepoint Administration.

2. To sign into Changepoint Administration for the first time, use cpadmin for both the user
ID and password.

If Changepoint is not registered, the Import Licenses dialog appears.

3. Click Choose File to locate and open the Changepoint license file (*.lic).

4. Click Import.

The License Management view displays the license file information.

5. Click Close.
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For more information about licensing, see the Changepoint Administration Guide.
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Installing a Changepoint Windows service

The Changepoint Windows services require access to the database server, but do not have to
be installed on the same server as the database or websites.

For information about installing and configuring a specific Changepoint Windows service,
see the topic for the service.

Warning: If you change the default installation path, then you must install all services in
a separate folder and not in the <cp_root> folder.

1. Do one of the following:

• From the Changepoint installer, click the Services tab and click the <servicename>
Service link.

• Run the service installation program from the product media:

\Changepoint\Services\<installation program name>

2. Follow the prompts until the installation completes.

3. Configure the database connection settings for the service.

For more information, see "About configuring database connection settings" on page 65.

4. If necessary, edit the service configuration file to configure the service. The service
configuration file, by default, is located in the installation directory.

Note: This is the same file that you edit to configure the SQL connection settings for the
service in step 3.

5. Start the service.

Uninstalling a Changepoint Windows Service

Use the Windows Control Panel to uninstall the service.

Changepoint Email Notification service
The Changepoint Email Notification service queues messages for the Changepoint Mail
service.
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If you enable any email notifications in Changepoint Administration, you must install the
Changepoint Email Notification service and the Changepoint Mail service, and make sure that
these services run at suitable intervals. If these services do not run often enough, the
EmailAuditStaging, EmailAuditNotification, and EmailQueue tables in the Changepoint
database can grow very large.

If you do not enable email notifications, then it is sufficient to install and run only the
Changepoint Mail Service. If in doubt, install and run both services.

Installation information

Use the following information with the generic procedure for installing and configuring a
Changepoint Windows service:

Information needed Notes

Installation Program name Changepoint Email Notification Service Installer.exe

Installation path Default: <cp_root>\Changepoint Email Notification Service\

Configuration file CPEmailNotification.exe.config

Configuration settings

SendInterval How often (in minutes) the service sends notifications.

Default value: 5

Recommended value: 5 or greater

Changepoint Exchange Synchronization Service
The Changepoint Exchange Synchronization service synchronizes Microsoft Exchange Server
calendar entries with Changepoint calendars.

It is recommended that you install the service on the Changepoint Web Server. However, the
service can be installed on any server that has network access both to the Changepoint
database server and the server that runs Exchange Web Services.

Note:

• The Exchange Autodiscover service must be running. For more information, see
"Configuring the Microsoft Exchange Autodiscover Service" on page 58.
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• Only the primary email account associated with each Exchange account can be
synchronized with Changepoint.

Using the AD/Exchange admin console

1. Create a domain user account to be used within Exchange to impersonate users. This
account does not require a mailbox. Example: CpExSyncService (UPN =

CpExSyncService@example.domain.com).

2. In the Exchange admin console permissions tab, create a new admin role with the
following details:

• Name: Changepoint Exchange Synchronization Service

• Roles: ApplicationImpersonation

• Members: The domain user account that you just created (CpExSyncService)

If you prefer to use PowerShell, you can issue the following statement:

New-ManagementRoleAssignment –Name: "Changepoint Exchange Synchronization Service" –

Role:ApplicationImpersonation –User: " CpExSyncService"

On the machine that will run the Changepoint Exchange Synchronization Service

1. Create a user account for the Changepoint Exchange Synchronization Service. Ensure that
the user account has the “Log on as service” right.

Note: You must provide the credentials for this user account during the installation of the
Changepoint Exchange Synchronization service.

2. Log in to the machine using the user account that you just created.

3. Create a generic Windows credential for the service:

a. In the Windows Control Panel, open the Credential Manager and selectWindows
Credentials.

b. Click Add a generic credential.

• Internet or network address: Changepoint Exchange Synchronization Service
• User name: The UPN of the domain user account that was created for Exchange

impersonation, for example: CpExSyncService@example.domain.com.
• Password: Password for the domain user account.

c. Click OK to save the credential.
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Note: If you change the service login account, you must also create a new generic
credential for the login.

Installing the Changepoint Exchange Synchronization Service

Use the following information with the generic procedure for installing and configuring a
Changepoint Windows service.

Information needed Notes

Installation Program name Exchange Synchronization Service.exe

Installation path Default: <cp_root>\Changepoint Exchange

Synchronization Service\

Configuration file CPSynchronizationService.exe.config

User account and password for the

service

User account and password for the Changepoint

Exchange Synchronization Service.

Configuration settings

SynchSchedule Interval in minutes for synchronizing between

Changepoint and Exchange.

Default: 15

NewUserHistory Number of days from the current date to go back when

synchronizing new users.

Default: 5

SynchronizationDirection 0 – synchronization is bidirectional

1 – synchronization is unidirectional from Changepoint to

Exchange

2 – synchronization is unidirectional from Exchange to

Changepoint.

Default: 0

PurgeAutodiscoveryCache Number of days to retain cache values before

rediscovering resource CAS server settings.

Default: 1
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Information needed Notes

RetryAutodiscovery Failures 0 – the Autodiscovery cache is filled once, and failed CAS

server lookups are ignored until the next time the

Autodiscovery cache is replenished

1 – failed Autodiscovery CAS server lookups are re-

evaluated each time the synchronization is executed

Default: 0

ConflictResolutionMethod For bidirectional synchronization, defines which

modification is accepted when a calendar entry has been

edited in both Changepoint and Exchange.

E – the Changepoint modification is ignored and the

Exchangemodification is applied

C – the Exchangemodification is ignored and the

Changepoint modification is applied

N – the earlier modification is ignored and the later

modification is applied.

Default: N

Note: The setting does not apply to unidirectional
synchronization.

If a conflict occurs between a deletion and an update, the

deletion is applied regardless of the setting.

LogInformativeEvents 0 – informativemessages are not logged to the event log

1 – informativemessages are logged to the event log

Default: 1

ForcePersistenceInTarget 0 – the target system in a unidirectional synchronization is

overwritten by the source when changes occur in the

target

1 – the target system in a unidirectional synchronization is

not overwritten by the source when changes occur in the

target

Default: 0

MaxOccurencesToSyncWhenNoEndDate

Specified

Maximum number of recurring appointments going to

Changepoint from Outlook on the Exchange

synchronization.

Default: 50
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Configuring the Microsoft Exchange Autodiscover Service

The Changepoint Exchange Synchronization service depends on the Microsoft Exchange
Server Autodiscover service. The Autodiscover service provides the Exchange Web Services
URL for each user that is being synchronized.

Ensure that the Autodiscover service can be accessed by the user running the Changepoint
Exchange Synchronization service. By default, communications to the Autodiscover service
use SSL. The SSL certificate must be valid for the Autodiscover service.

Connections to the Autodiscover service are attempted in the following order:

1. Autodiscover service URLs found within the Active Directory (AD) Service Connection
Point (SCP)

2. https://<smtp-address-domain>/autodiscover/autodiscover.xml

3. https://autodiscover.<smtp-address-domain>/autodiscover/autodiscover.xml

Changepoint Mail Service
The Changepoint Mail service sends automated emails from Changepoint. You can install the
service on any machine that has access to the SQL Server where the Changepoint database is
hosted. The service also requires access to an SMTP server, either locally or through the
network in order to relay mail.

If you are upgrading the Changepoint Mail Service, you must uninstall the old service first, and
then install the new service.

Note: If you enable email notifications in Changepoint Administration, you must install the
Changepoint Mail service and the Changepoint Email Notification service, and make sure
that these services run at suitable intervals. If these services do not run often enough, the
EmailAuditStaging, EmailAuditNotification, and EmailQueue tables in the Changepoint
database can grow very large.

If you do not enable email notifications, then it is sufficient to install and run only the
Changepoint Mail Service.

Error messages

The Changepoint Mail service removes badly formed email addresses from the To, Cc, and
Bcc lines of the emails, and logs them in the Changepoint Mail service server as:

Unable to send email to malformed email address: address
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See the Event Viewer, Applications and Services Logs > Changepoint.

Installation information

Use the following information with the generic procedure for installing and configuring a
Changepoint Windows service.

Information needed Notes

Installation Program name Changepoint Mail Service Installer.exe

Installation path Default: <cp_root>\Changepoint Mail Service\

Configuration file CPMail.exe.config

Configuration settings

SmtpServer IP address or fully qualified domain name of the SMTP server that the

Changepoint Mail service uses.

Default: 127.0.0.1

Ensure that the SMTP server allows mail to be relayed from themachine

on which the Changepoint Mail service is hosted.

Note: If virus protection is enabled on the server that hosts the
Changepoint Mail service, consider adding a scanning exception for the

Changepoint Mail service to prevent it from being falsely detected as a

mass mailing worm.

SmtpPort The port used to contact the SMTP server.

Default: 25

FromAddress Default from address to use when a from address is not supplied when the

mail is queued.

Default: username@domain.com

FromAddressDisplayName Default name to display in the email’s from address when a from address

is not supplied when themail is queued.

Default: username

SendInterval How often (in minutes) the service sends new notifications.

Default value: 5

Recommended value: 5 or greater
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Changepoint Report Prerender Service
The Changepoint Report Prerender service is used with the Changepoint Report Scheduler
service. It is responsible for advanced delivery option management and report object rendering
of group and cross-tab tables.

The Changepoint Report Prerender service can be installed on any server that has access to
the SQL Server where the Changepoint database is hosted. The service requires the following
access:

• HTTP access to the URL configured in the Report Prerender service in the server
integration page in Changepoint Administration (General Setup > Server Integration).

• Access to a Changepoint website that is configured with application authentication. If the
Changepoint website is set up for Windows integrated authentication, see "Using both
application authentication and SSO" on page 148.

Note: The service is incompatible with Enhanced session management, which is the
option that restricts authenticated users to one active session per browser container.

Installation information

Use the following information with the generic procedure for installing and configuring a
Changepoint Windows service.

Information
needed

Notes

Installation

Program name

Report Prerender Service Installer.exe

Installation path Default: <cp_root>\Changepoint Report Prerender Service\

Configuration file ReportPrerenderService.exe.config

Configuration settings

CompanyProfile Identifies whether to use PPM or PSA terminology. Valid values are ITD (PPM)

and PSO (PSA).
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Information
needed

Notes

AccessCheck When set to true, access checks are done before a report is generated, but

resources can design reports that bypasses security if they have the required

permissions.

When set to false, access checks are not done.

The default setting is True.

CommandTimeOut Number of seconds that the service queries the database for a call before timing

out. The default is 600 seconds.

ReportTimeout Number of minutes that a report takes to be generated before it times out. The

default is 30minutes.

MaxReportThread Number of reports that can be generated concurrently. The default value is 5. The

highest number of reports that can be processed concurrently is 25.

Configuring the Report Prerender Service

You must configure the server where the Report Prerender Service is installed.

1. Disable the Internet Explorer enhanced security configuration.

Use the Server Manager to turn off Configure IE ESC for both Users and
Administrators.

2. Enable the submission of non-encrypted form data.

For both Computer Configuration and User Configuration, use the Group Policy
Object Editor to enable Submit non-encrypted form data in the Internet Explorer
Administrative Templates

3. Assign the Changepoint site to the local intranet zone.

For both Computer Configuration and User Configuration:

a. Use the Group Policy Object Editor to add the Report Prerender Service URL to the
computer’s Intranet zone.

b. If the server implements SSL, use the Group Policy Object Editor to enable the
setting Do not prompt for client certificate selection when no certificates or only
one certificate exists.

4. To use SSL with the Report Prerender website:
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a. Set the Report Prerender Service to Log On As Administrator.

b. In Internet Explorer Tools > Options > Advanced, clear the Security option to Check
for server certificate revocation.

c. Edit \Windows\System32\drivers\etc\hosts to map the IP address of the website to
the URL.

5. Sign in to Changepoint Administration:

a. Disable enhanced session management (General > Session Security).

b. Set up the Report Prerender Service URL (General > Server Integration).

6. Restart the server.

Upgrading Internet Explorer on the server

When the Report Prerender Service is installed, a value is written in the Windows registry
according to the version of Internet Explorer installed on the server:

• Internet Explorer 11: Value = 9000

• You can modify the registry key value when applicable

Entry: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet

Explorer\MAIN\FeatureControl\FEATURE_BROWSER_EMULATION

Name: ReportPrerenderService.exe

Value: 9000

Entry on 64-bit OS is:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Internet

Explorer\Main\FeatureControl\FEATURE_BROWSER_EMULATION Value: 9000

Changepoint Report Scheduler Service
The Changepoint Report Scheduler Service is a Windows Service that queries the Changepoint
database to locate scheduled reports that require processing. It can be installed on any server
that has access to the Changepoint database server.

Installation information

Use the following information with the generic procedure for installing and configuring a
Changepoint Windows service:
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Information
needed

Notes

Installation

Program name

Report Scheduler Service Installer.exe

Installation path Default: <cp_root>\Changepoint Report Scheduler Service\

Configuration file ReportSchedulerService.exe.config

Configuration settings

CompanyProfile Determines whether the installation uses PPM terminology or PSA terminology.

Valid values are ITD (PPM) and PSO (PSA).

AccessCheck Determines whether an access check is required before a report is generated.

When True, access checks are done, but a resource can design a report that

bypasses security if they have the required permissions. When False, access

checks are not done.

The default setting is True.

CommandTimeOut Determines themaximum amount of time the service can take to query the

database for a call before timing out.

The default is 600 seconds.

ReportTimeout Number of minutes a report can take to generate before it times out.

The default is 30minutes.

MaxReportThread Maximum number of reports that can be generated concurrently.

The default value is 5. The highest possible value is 25.

Using the Report Scheduler Service Controller

1. Click Start and select Programs > Changepoint > Changepoint.

2. Click Report Scheduler Service Controller.

The Report Scheduler Service Controller icon is added to the task bar. The service is
stopped.

• To start the service, right-click the stopped icon on the task bar and select Start.

The service runs in the background.
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• To pause the service, right-click the started icon and select Pause.

• To resume after pausing, right-click the paused icon and select Continue.

• To stop the service, right-click the started icon and select Stop.

• To check the product version number, right-click the icon and select About.

Managing Changepoint Windows Services
You manage the Changepoint Windows Services the same way as other Windows services.

To start, stop, and set the startup type for services, use the Administrative Tools >
Component Services in the Windows Control Panel.
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About configuring database connection settings

To access the database, each Changepoint application requires an encrypted connection
string, which is stored in a configuration file. To encrypt the database connection settings,
you use the Login Settings utility.

The default path to the utility is:

<cp_common>\LoginSettings\Login Settings.exe

Default user ID and password

The configuration files that contain the connection strings are password protected. By
default, the user ID is USERID and the password is PASSWORD (case-sensitive) in all of the
configuration files.

The first time that you access a configuration file using the Login Settings utility, you must
use the default user ID and password. You then specify the user ID and password that are
used for database access, as described in "Required accounts and permissions" on page 15.
The login settings utility encrypts these values and updates the configuration file with the
encrypted values.

Configuring database connection settings
These are the general instructions for using the Login Settings utility. For more information,
see the database connection settings topic for the application.

1. Run:

<cp_common>\LoginSettings\Login Settings.exe

The Changepoint Connection Settings dialog box appears.

2. From the Connection Settings list, select the application.

3. In the File Location field, browse to the configuration file for the application.

4. Enter the user ID and password of the account for database access, then click OK.

Note: The first time you run the Login settings utility on a configuration file, use
“USERID” and “PASSWORD” (case sensitive) for the User ID and Password.
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5. In the Connection Settings section, specify the server name, database name, and time-out
information to be used in the connection string.

Time-out is optional and can be left blank, or can be used to specify the ADO
connection.timeout value (in seconds) used in the connection string.

The .asp implementations use the time-out values specified in the Connection Settings
dialog. The .NET implementations (.aspx) use the CommandTimeOut setting value
specified in the application Web.config file instead.

6. In the User ID and Password fields, enter the user ID and password for the SQL account
for accessing the Changepoint database.

7. To verify the connection string, click Test.

8. Click Save.

Database connection settings for Batch Print

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default: <cp_root>\BatchPrint\PrintInvoices.exe.config

User ID (for file) Initial Default: USERID

Password (for file) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Changepoint

The Changepoint option updates the DSN, DataDSN, and DSN2 information in the Global.asa
and Web.config files in the Changepoint folder. You only have to select the Global.asa file
because the Web.config file inherits the same values that you input.
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Note: To render reports in Changepoint, you must also configure the Changepoint Report
Server. If your organization has a separate reporting database, then specify its server name
and database name for the Changepoint Report Server settings; otherwise, use the same
server name and database that you entered for Changepoint.

Field Notes

Connection Settings Enterprise

File location Default: <cp_root>\Enterprise\Global.asa

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database

access)

Password (for

database access)

Field Notes

Connection Settings Enterprise Report Server

File location Default: <cp_root>\Enterprise\Global.asa

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Server for the separate reporting database, if used. Otherwise, the name of the

main Changepoint database server.
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Field Notes

Database Name of the separate reporting database, if used. Otherwise, the name of the

main Changepoint database.

TimeOut TimeOut for the separate reporting database, if used.

User ID (for database

access)

User ID for the separate reporting database, if used.

Password (for

database access)

Password for the separate reporting database, if used.

Database connection settings for Changepoint Email Notification Service

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default:
<cp_root>\Changepoint Email Notification Service

\CPEmailNotification.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)
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Database connection settings for Changepoint Exchange Synchronization
Service

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default:
<cp_root>\Changepoint Exchange Synchronization Service

\CPSynchronizationService.exe.config

User ID (for file) Initial Default: USERID

Password (for file) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Changepoint Export Publishing Service

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default: <cp_root>\Changepoint Export Publishing Service

\CPExportPublishingService.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut
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Field Notes

User ID (for database access)

Password (for database access)

Database connection settings for Changepoint Mail Windows Service

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default: <cp_root>\Changepoint Mail Windows Service

\CPMail.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Changepoint Report Prerender Service

You must configure the connection settings for the Changepoint Report Prerender Service and
for the Reports DSN information for the Report Designer Report Server, even if you are not
deploying a separate report server.

If your organization has a separate reporting database, then specify its server name and
database name for the Report Designer Report Server settings. Otherwise, use the same
server name and database that you entered for Changepoint Windows Services, Scheduled
Jobs and Utilities.
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Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default: <cp_root>\Changepoint Report Prerender Service

\ReportPrerenderService.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Changepoint Report Scheduler Service

You must configure the connection settings for the Changepoint Report Scheduler Service and
for the Reports DSN information, even if you are not deploying a separate report server.

If your organization has a separate reporting database, then specify its server name and
database name for the Report Designer Report Server settings. Otherwise, use the same
server name and database that you entered for Changepoint Windows Services, Scheduled
Jobs and Utilities.

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilities

File location Default: <cp_root>\Changepoint Report Scheduler Service

\ReportSchedulerService.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD
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Field Notes

Server

Database

TimeOut

User ID (for database

access)

Password (for

database access)

Field Notes

Connection Settings Report Designer Report Server

File location Default: <cp_root>\Changepoint Report Scheduler Service

\ReportSchedulerService.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Server for the separate reporting database, if used. Otherwise, the name of the

main Changepoint database server.

Database Name of the separate reporting database, if used. Otherwise, the name of the

main Changepoint database.

TimeOut TimeOut for the separate reporting database, if used.

User ID (for database

access)

User ID for the separate reporting database, if used.

Password (for

database access)

Password for the separate reporting database, if used.
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Database connection settings for Changepoint Report Server

Field Notes

Connection Settings Enterprise Report Server

File location Default: <cp_root>\Enterprise\Global.asa

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Server for the separate reporting database, if used. Otherwise, the

name of the Changepoint database server.

Database Name of the separate reporting database, if used. Otherwise, the

name of the Changepoint database.

TimeOut TimeOut for the separate reporting database, if used.

User ID (for database access) User ID for the separate reporting database, if used.

Password (for database

access)

Password for the separate reporting database, if used.

Database connection settings for Cognos Client Tools

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Jobs and Utilitiesr

File location Default: <cp_root>\Cognos\CognosClientTools.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut
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Field Notes

User ID (for database access)

Password (for database

access)

Database connection settings for Data Archiving Source SQL server

Field Notes

Connection Settings Data Archiving (Source SQL Server)

File location Default: <cp_root>\Data Archiving\Data Archiving.ini

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database

access)

Database connection settings for Data Archiving Target SQL server

Field Notes

Connection Settings Data Archiving (Target SQL Server)

File location Default: <cp_root>\Data Archiving\Data Archiving.ini

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD
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Field Notes

Server

Database

TimeOut

User ID (for database access)

Password (for database

access)

Database connection settings for Infiniti Launch

Field Notes

Connection Settings Infiniti Launch

File location <cp_root>Intelligent Forms\Websites\

InfinitiLaunch\Web.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Infiniti Server value

Database InfinitiDB value

TimeOut

User ID (for database access) User ID that has dbo access to the InfinitiDB.

Password (for database

access)

Password of User ID that has dbo access to the InfinitDB.

Changepoint Web Services

URL

http://{{WSAPIServer:port}}/CPWebService/VerifyUser.asmx

Infiniti URL http://{{InfinitiServer:port}}/Infiniti/produce/service/platform.asmx
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Database connection settings for Infiniti Scheduler

Field Notes

Connection Settings Inifiniti Scheduler

File location <cp_root>Intelligent Forms\

IntelledoxScheduler\

IntelledoxScheduler.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Infiniti Server value

Database InfinitiDB value

TimeOut

User ID (for database access) User ID that has dbo access to the InfinitiDB

Password (for database

access)

Password of User ID that has dbo access to the InfinitDB

Database connection settings for Intelligent Forms

You use the Login settings utility to update the settings for an Intelligent Forms instance or to
configure an additional Intelligent Forms instance for example, a test instance.

1. Run: <cp_common>\LoginSettings\Login Settings.exe.

2. In the Connection Strings field, select Intelligent Forms Database Setup.

Intelligent Forms Setup dialog box options

Field Notes

New Database Server Server that hosts the new Changepoint database and Infiniti

database.

New Changepoint Database Name of the new Changepoint database.
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Field Notes

New Changepoint User ID User ID for the new Changepoint database.

New Changepoint Password Password for the new Changepoint database.

Infiniti Database Name of the Infiniti database.

Infiniti User ID User ID for the new Infiniti database.

Infiniti Password Password for the new Infiniti database.

Old Changepoint API URL URL for the previous Changepoint API.

New Changepoint API URL URL for the new Changepoint API.

Old Database Server Server that hosted the previous Changepoint database.

Old Changepoint Database Name of the previous Changepoint database.

Old Changepoint User ID SQL account for accessing the Changepoint database.

Old Changepoint Password Password for the SQL account.

Old Infiniti URL URL for the previous Infiniti instance.

New Infiniti URL URL for the new Infiniti instance.

Database connection settings for Intelligent Forms (Changepoint Data
Services, Manage, and Produce

Note: You must configure the database connection settings for each of the Web.config
files, that is for Changeponit Data Services, Manage, and Produce.

Field Notes

Connection Settings Intelligent Forms (Changepoint Data Services, Manage, and

Produce)

File location <cp_root>\Enterprise\Intelligent Forms\

ChangepointDataService\Web.config

<cp_root>\Enterprise\Intelligent Forms\Manage\Web.config

<cp_root>\Enterprise\Intelligent Forms\Produce\Web.config
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Field Notes

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Infiniti Server value

Database InfinitiDB value

TimeOut

User ID (for database access) User ID that has dbo access to the InfinitiDB

Password (for database

access)

Password of User ID that has dbo access to the InfinitDB

Database connection settings for Report Designer

You must configure the settings for both Report Designer and the Report Designer Report
Server, even if you are not deploying a report server.

If your organization has a separate reporting database, then specify its server name and
database name for the Report Designer Report Server settings; otherwise, use the same server
name and database name that you entered for Report Designer.

Field Notes

Connection Settings Report Designer, Web Services

File location Default: <cp_root>\ReportDesigner\Web.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)
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Field Notes

Connection Settings Report Designer Report Server

File location Default: <cp_root>\ReportDesigner\Web.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server Server for the separate reporting database, if used. Otherwise,

the name of themain Changepoint database server.

Database Name of the separate reporting database, if used. Otherwise,

the name of themain Changepoint database.

TimeOut TimeOut for the separate reporting database, if used.

User ID (for database access) User ID for the separate reporting database, if used.

Password (for database access) Password for the separate reporting database, if used.

Database connection settings for RESTful API

Field Notes

Connection Settings RESTful API

File location <cp_root>\Enterprise\WebAPI\Web.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut
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Field Notes

User ID (for database access)

Password (for database

access)

Database connection settings for CPEffectiveDates scheduled job

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Job, and Utilities

File location Default: <cp_root>\ScheduledJobs\

CPEffectiveDates.exe.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Release Guest Licenses scheduled job

Field Notes

Connection Settings Changepoint Windows Services, Scheduled Job, and Utilities

File location Default:

<cp_root>\ScheduledJobs\CPGuestLicenses.exe.config

User ID (for File) Initial Default: USERID
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Field Notes

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Transport Tool

Field Notes

Connection Settings Transport Tool

File location Default: <cp_root>\Enterprise\web.config

User ID (for file) Initial Default: USERID

Password (for file) Initial Default: PASSWORD

Server Server that CPTransport database it installed on.

Database CPTransport

TimeOut

User ID (for database

access)

User ID that has dbo access to CPTransport Database

Password (for database

access)

Password of User ID that has dbo access to CPTransport Database
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Database connection settings for Web Services API

Field Notes

Connection Settings Report Designer, Web Services

File location Default: <cp_root>\API\CP Web Services\web.config

User ID (for file) Initial Default: USERID

Password (for file) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database access)

Database connection settings for Web Sockets

Field Notes

Connection Settings WebSockets

File location <cp_root>\Enterprise\WebSockets\Web.config

User ID (for File) Initial Default: USERID

Password (for File) Initial Default: PASSWORD

Server

Database

TimeOut

User ID (for database access)

Password (for database

access)
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About Changepoint scheduled jobs

Changepoint scheduled jobs run at various intervals to ensure that data is refreshed and up-
to-date. Some of the scheduled jobs run individually and independently. Others have
dependencies and are run as part of a sequence of scheduled jobs.

Chained scheduled jobs

Some scheduled jobs have dependencies on other scheduled jobs, and for this reason, a
scheduling chain has been set up for these jobs.

The steps in the chain are:

1. Update Time Rate job

• By default, the Update Time Rate job starts at 12.01 AM.

• When it completes, whether it failed or succeeded, the Update Time Rate job starts
the Resource Demand Calculation job.

2. Resource Demand Calculation job

• If the Resource Demand Calculation job fails, none of the remaining jobs in the
chain is started.

• If the Resource Demand Calculation job succeeds, it starts the Financial Analysis
Summary job.

3. Financial Analysis Summary job

• Whether the Financial Analysis Summary job succeeds or fails, it starts the
Calculate Project Costs and Portfolio Calculation Engine jobs (these jobs run in
parallel).

4. Calculate Project Costs job

5. Portfolio Calculation Engine job

6. Populate Demand and Capacity job

Reasons for the Dependencies

All the jobs in step 2–step 5 of the chain have dependencies on step 1, which is the Update
Time Rate job. The Resource Demand Calculation job runs upon completion of the Update
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Time Rate job regardless of the pass/fail status of the Update Time Rate job.

Do not alter the sequence of jobs in the chain, because:

• The Update Time Rate jobs needs to run and finish successfully before the Financial
Analysis Summary job starts to ensure that the most recent data from the Time table is
retrieved and costs are updated in FinAnnSummary table.

• The Update Time Rate job needs to run and finish successfully before the Resource
Demand Calculation job starts to ensure that a portfolio can retrieve the most recent data
from the Time tables.

• Until the Update Time Rate job has finished running, no data is available for display in the
portfolio for cost metrics.

• Bad data can cause some of the steps in the Portfolio Calculation Engine job to fail;
however, it may not be necessary to fail the entire job. Go through the job history and
Windows EventLog for more details.

Running the Update Time Rate job more frequently

To run the Update Time Rate job more frequently than once a day without initiating the
chained scheduled jobs, create another scheduled job (for example, Update Time Rate Hourly)
that does not launch the Resource Demand Calculation job. Schedule the new job to run at the
chosen interval, but leave a gap when the chain of scheduled jobs is running.

For example, to run Update Time Rate Schedule every hour throughout the day, if:

• Update Time Rate is scheduled for 12:01AM, its default start time, and

• your job history tells you that the average time taken by the chained jobs is 4 hours, and
that Update Time Rate takes, on average, 30 minutes

set the schedule for Update Time Rate Hourly to hourly, starting at 5:00 AM and ending at
11:00 PM.

This leaves is a gap of 5 hours (4 hours for the chained jobs, plus an hour of a buffer) from the
time that the chained jobs start until the first run of Update Time Rate Hourly job.
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It also allows a buffer of 30 minutes from the end of the last run of Update Time Rate Hourly
until the chained jobs start.

Scheduled Jobs reference list
The following table lists the scheduled jobs that are included with Changepoint. The times and
frequencies listed are the default settings. The statuses (enabled or disabled) are the
recommended settings. For a new installation, all scheduled jobs are disabled. For an upgrade,
the existing status of each job is maintained.

Review and reschedule the jobs as required according to the needs of your organization.

The names of the scheduled jobs that appear in SQL Server Manager are prepended by the
database name and an underscore, for example “Changepoint_Adjust Daylight Savings”.

Adjust Daylight Saving scheduled job

Sets a flag in the time zone table to indicate which time zones are currently observing daylight
savings time.

File or Stored Procedure AdjustDaylightSaving

Schedule Daily at 3:01 AM

Status Enabled

Archive Aged Entities scheduled job

Validates all relevant entities (including those previously validated by the Archive Validation
job), archives them into the archive database, then removes them from the Changepoint
database.

Before running the job for the first time, create an empty archive database on the target server.
The .dtsx file must exist on the source server; it is not required on the target archive server.
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File or Stored Procedure ARC_ValidateProjectRequests

ARC_ValidateProjects

ARC_ValidateEngagement

ARC_ValidateFinalization

<cp_root>\Data Archiving\Data Archiving.dtsx

Schedule Not scheduled

Status Enabled

Archive Validation scheduled job

Validates entities to be archived and generates archive validation logs.

File or Stored Procedure ARC_ValidateProjectRequests

ARC_ValidateProjects

ARC_ValidateEngagement

ARC_ValidateFinalization

Schedule Not scheduled

Status Enabled

Auto Dispatch Request to Queues scheduled job

For request types for which queues have been configured, sends qualifying requests to queues.

File or Stored Procedure AutoDispatch

Schedule Every 5minutes

Status Enabled

Auto Escalate Requests scheduled job

Escalates requests based on a Service Level Agreement.
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File or Stored Procedure AutoEscalate

Schedule Every 30minutes

Status Enabled

BatchCommit Invoices scheduled job

Commits batch invoices, which populates the necessary data for the Batch Invoice Process
Report.

The batch invoice commit can also be done through the UI. Your organization’s policies
determine which method you use.

If you set up a schedule for this job, it is recommended that you set the job to run during off-
peak hours and ensure that the job does not overlap other jobs.

File or Stored Procedure BatchCommitInvoice

Schedule Not scheduled

Status Enabled

BatchInvoicingGetInvoiceDefaultList scheduled job

Starts the batch invoice/cross charge generation process, using selections previously saved
from the Batch Invoice/Cross Charge report.

File or Stored Procedure BI_BatchGetInvoiceDefaultList

Schedule Daily at 3:30 AM

Status Enabled

Calculate Project Costs scheduled job

Calculates budget, planned costs and actual costs at the project, task and task assignment
levels. This job populates the ProjectCostInfo table that is used to generate the earned value
data providers
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Note: Do not set an independent schedule for this job. The Calculate Project Costs job is
called by the Financial Analysis Summary job, and both are included in the chained
scheduled jobs. For more information, see "Chained scheduled jobs" on page 83.

File or Stored Procedure dbo.EVR_Calculate ProjectCosts

Schedule Not scheduled

Status Enabled

CheckTimeToApprove scheduled job

Generates the You have time to approve email notification.

File or Stored Procedure CheckTimeToApprove

Schedule Daily at 5:00 AM

Status Enabled

CleanResourceAvailability scheduled job

Removes availability calendar entries that are more than (default) 30 days old. This job is
optional, but recommended if your organization has a large number of availability entries.
Removing the old entries helps to minimize table size.

To change the default number of days, edit the job step to pass the @ndays parameter to the
stored procedure.

To change the value to n days, add the parameter as follows:

CleanResourceAvailability @ndays = n

The larger the number of days, the larger the database size.

For more information, see "Editing parameters for scheduled jobs " on page 101.

File or Stored Procedure CleanResourceAvailability

Schedule Daily at 12:00AM

Status Disabled
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CPEffectivedates scheduled job

Activates effective dates for work history information about a resource.

You must encrypt the database connections settings for CPeffectiveDates.exe. For more
information, see "About configuring database connection settings" on page 65.

CPEffectiveDates.exe uses both sets of server name and database name parameters (from the
Login Settings utility and from the command line).

File or Stored
Procedure

<cp_root>\ScheduledJobs\ CPeffectiveDates.exe

[DATABASETYPE], [DATABASESERVER], [DATABASE]

Where:

[DATABASETYPE] – SQL

[DATABASESERVER] – name of Changepoint database server

[DATABASE] – name of Changepoint database

Schedule Daily at 12:00:01 AM.

Status Enabled

CPExtended_Compile stats and purge data scheduled job

Compiles statistics from Traces table in the CPExtended database, and purges old trace data.
Default threshold is one month.

File or Stored Procedure CompileStatsAndPurgeData

Schedule Every Sunday at 2:00 AM

Status Disabled

CPFullText scheduled job

Populates the full text catalogs for both knowledge management and request items. Items that
have been created since the previous job run cannot be located until after the subsequent job
run.

Note: Enable either CPFullText or CPFullText using background updates, but not both.
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File or Stored Procedure sp_fulltext_catalog

Schedule Daily at 12:15 AM.

Status Enabled

CPFullText using background updates scheduled job

Updates the catalog immediately using incremental updates. A full-text rebuild is performed
weekly in case any of the incremental updates fails.

Note: Enable either CPFullText or CPFullText using background updates, but not both.

File or Stored Procedure sp_fulltext_catalog

Schedule Weekly on Sunday at 4:00 AM.

Status Disabled

CPTempDB_Clean up idle-orphaned schemas scheduled job

Removes schema for low use schemas. By default, schemas that have not been accessed for
14 days will be removed. Schemas will not be removed when the schema owner is currently
logged into Changepoint.

File or Stored Procedure exec CPTempDBCleanupOrphanedSchemas 14

Schedule Weekly on Sunday at 2:00 AM.

Status Enabled

Financial Analysis Summary scheduled job

Populates the tables used by the financial analysis data provider, for use in reporting and
analysis.

Do not set a schedule for this job. The Financial Analysis Summary job is called by the
Resource Demand Calculation job, and both are included in the chained scheduled jobs. For
more information, see "Chained scheduled jobs" on page 83.
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A step in the Financial Analysis Summary job detects if the Portfolio CalculationEngine job
exists and is enabled. If not, it clears the portfolio recalculation table, which is normally
processed and cleared by the portfolio job.

If you have re-named the portfolio calculation engine job, do one of the following:

• Re-enable it under the exact name "Portfolio Calculation Engine"

• Remove the step from the Financial Analysis Summary job to ensure the data is not
truncated when portfolio information is being calculated.

Note: If you have multiple instances of the Financial Analysis Summary job and have
renamed the jobs with unique names, remove the step.

File or Stored Procedure FinAnnSummary_ToDate

FinAnnSummary_ToDateTwo

FinAnnSummary_Forecast

FinAnnSummary_Unbillable

RD_GetRDMonetaryData

msdb..sp_start_job@job_name = 'Calculate Project

Costs'

msdb..sp_start_job@job_name = 'Portfolio Calculation

Engine'

Schedule Not scheduled

Status Enabled

IPM Calculation Engine scheduled job

The Copy Assignments step copies the metric assignments (if the carry forward option is
selected) from the previous IPM period to the current period. This step runs only on the first
day of the period.

The Calculate Raw Data step gathers data from the Changepoint database, generates raw data
and inserts it into the MetricRawData table. This calculation gathers only data that is required
since the last time the calculation ran. If the raw data is from a previous period (refdate), the
system inserts a record into the IPIReCalcuLastPeriod table. From this table, the calculation
engine can re-calculate the data from the end of the day for a previous period.
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In the Calculate Metric Data step, the IPM Calculation engine calculates raw data that is
associated with a resource who is assigned to a metric. It inserts the results into the
MetricData table. This calculation calculates only the raw data based on the current IPM
period. The criteria are as follows:

• The resource is assigned to a metric and the assignment is not deleted

• The metric is not deleted

• The standard metric is not deleted

• The engine includes an IPM re-calculation step that re-calculates the last day of the
previous period if metric data for the last period is detected.

The Clean up step clears the raw data tables of information that is no longer required.

File or Stored Procedure IPI_periodcopy

IPICalculationEngine

IPI_ReCalcuLastPeriod

IPI_deleteRawData

Schedule Daily at 10:30 PM.

Status Enabled

PercentOfContractIncurred scheduled job

Notifies the Engagement/Initiative Manager if:

• the invoiced/cross-charged amount is near the threshold (80% of the contract approved
amount), or

• the contract approved amount has been exceeded.

Generates the email notifications for “ContractApproved amount near threshold” and
“ContractApproved amount has been exceeded”.

File or Stored Procedure PercentOfContractIncurred

Schedule Weekly on Sunday at 7:00 PM

Status Disabled
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PerformanceCPGrowth scheduled job

Monitors the growth of Changepoint database files and tables.

For more information, see "Monitoring database growth" on page 102.

File or Stored Procedure PerformanceCollectAndCalculateDbGrowth

Schedule Daily at 11:50 PM

Status Enabled

Populate Demand and Capacity scheduled job

Populates table tblDemandAndCapacity used by table Demand and Capacity data provider, for
use in reporting and analysis.

File or Stored Procedure PopulateDemandAndCapacity

Schedule Daily at 2:00AM

Status Enabled

Portfolio Calculate Report Cards

Calculates customer/client report card information used by the customer/client report card and
customer/client radar reports.

All data is stored in a table on the Changepoint database server, and is displayed when the
report card is generated for a specific customer/client profile, or when the Customer/Client
Radar report is run.

Note: Financial information is displayed in the user’s home currency.

Because the job normalizes all of its financial calculations to the most common currency
specified in the global workgroups, at least one global workgroup must have a currency
selected.

If you use Survey Management, enable this job.
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File or Stored Procedure PF_CalculateReportCards

Schedule Daily at 10:00 PM

Status Disabled

Portfolio Calculation Engine scheduled job

This job performs all the calculations required by portfolio management. The parameter in the
second step determines whether the step runs: set to 0 or greater to run, less than 0 to skip.

Do not set a schedule for this job. The Portfolio Calculation Engine job is called by the
Financial Analysis Summary job, and both are included in the chained scheduled jobs. For
more information, see "Chained scheduled jobs" on page 83.

File or Stored Procedure ProjectToSubProjects

PF_AutomaticUpdate 1

PF_FiscalPeriodEndReCalc

PF_ReCalcuLastPeriod

PFRollupProjectNoBillingOffice

PopulateProjectCost

PF_BudgetvsActual

PFRequestCost

PFRequestEffort

PFPlanningHoursEffort

PFRemainingHoursCost

PFPlanningHoursCost

PFUninvoicedBillingAmount

PFPlanningHoursBillingAmt

PFRevRecAmount

PFRequestBillingAmount

PFRemaingBillingAmt

PF_RecalcuLastPeriod_UsrEntr

PF_CalculationEngine

PFPortfolioSummary

PF_Recalc_RollupPortfolios

PFRollup_CalcEngine

Schedule Not scheduled

Status Enabled
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Process Expense Approval scheduled job

Processes expense approver records and updates the records with the approver and status in a
table accessed by the standard Changepoint You have expense reports to approve
notification.

If no engagement approver is defined, the expense record is updated with the line approver.

If no line approver is defined, this job automatically approves the record.

File or Stored Procedure ProcessExpenseApproval

Schedule Every 30minutes

Status Enabled

Process Time Entries for Approval scheduled job

Processes time records pending approval, and stores the records in a table accessed by the
standard Changepoint You have time to approve notification.

File or Stored Procedure ProcessTimeApproverRecords

Schedule Every 30minutes

Status Enabled

Reindex and Update Statistics daily scheduled job

Calculate statistics for the indexes it updates in the Changepoint database for SQL Query
Optimizer purposes.

File or Stored Procedure (scripts)

Daily Reindex

Defrag Indexes

Daily Update Statistics

Schedule Daily at 6:00AM.

Status Enabled
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Reindex and Update Statistics weekly scheduled job

Updates statistics for all rows in all tables in the Changepoint database for SQL Query
Optimizer purposes.

File or Stored Procedure (scripts)

Weekly Reindex

Weekly Update Statistics

Schedule Weekly on Sunday at 3:00 AM

Status Enabled

Release Guest Licenses scheduled job

Releases licenses of Client Portal users whose access has expired.

You must encrypt the database connections settings for CPGuestLicenses.exe. For more
information, see "About configuring database connection settings" on page 65.

CPGuestLicenses.exe uses both sets of server name and database name parameters (from the
Login Settings utility and from the command line).

File or Stored
Procedure

<cp_root>\ScheduledJobs\CPGuestLicenses.exe [DATABASETYPE],

[DATABASESERVER], [DATABASE]

Where:

[DATABASETYPE] – SQL

[DATABASESERVER] – name of the Changepoint database server

[DATABASE] – name of the Changepoint database

Schedule Daily at 12:00 AM

Status Enabled

Release Held Locks scheduled job

Releases system locks from the RecordLock table after there has been no activity for the
designated time by deleting locks that belong to a Login session that has expired. Does not
apply to PRJ or MSP. Default is 330 seconds.

The designated time can be set in the step.

For more information, see "Editing parameters for scheduled jobs " on page 101.
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File or Stored Procedure ReleaseLocks 330

Schedule Every 6minutes.

Status Disabled

Resource Demand Calculation scheduled job

Performs the updates to budgets for which the option to replace values in past periods with
actual values has been enabled.

Updates the daily effort in the budgets based on changes made to fiscal period amounts.

Updates the working days table which is used by various parts of the application (such as
resource demand analysis).

Warning: Do not set a schedule for this job. This Resource Demand Calculation job is
called by the Update Time Rate job, and both are included in the chained scheduled jobs.
For more information, see "Chained scheduled jobs" on page 83.

File or Stored Procedure SetWorkingDays

UpdateRD_NonWorkingDaysTable

RollupProjectsByFiscalPeriods

BU_ReplacePastWithActuals

BU_SaveDailyEffort

msdb..sp_start_job@job_name = 'Financial Analysis

Summary'

Schedule Not scheduled

Status Enabled

Resource Utilization scheduled job

Notifies the manager of a resource whose forecast hours related for the following week are
less than 80% or more than 100% of a full week.

Generates the “Resource on Bench” and the “Resource Overloaded” email notifications.
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File or Stored Procedure ResourceLoad

Schedule Once a week on Sunday at 7:20 PM.

Status Disabled

Revenue Recognition Tentative scheduled job

Runs the revenue recognition tentative process with saved values as of the last time “start on
schedule” was chosen in the process.

File or Stored Procedure RevRec_Tent_Schedule

Schedule Once a day at 5:30 AM

Status Disabled

Session Clean Up scheduled job

Disconnects user sessions under the following circumstances:

• The user did not sign out of Changepoint properly and the session has been inactive for
more than 5.5 minutes (330 seconds). This can occur when the user closes the browser
without signing out, or when the user’s computer shuts down unexpectedly.

• The user has been logged on for more than 1 day.

• The user is accessing Changepoint using a mobile device and has not interacted with
Changepoint for more than 5.5 minutes (330 seconds).

Note:When the user accesses Changepoint through a computer, as long as the main
window is open, a keep-alive is triggered every 5 minutes to update the user’s Session
record to prevent being logged off. With mobile access, the behavior is different.

Deletes inactive Resource Management Worksheet session IDs, and temporary session data
for Resource Management Worksheet and Project Worksheet.

The default value for the allowed period of inactivity is 5.5 minutes (330 seconds). To modify
this time, change the optional seconds parameter that is passed to the SessionCleanup stored
procedure called by the Session Clean Up scheduled job.

For more information, see "Editing parameters for scheduled jobs " on page 101.
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To maintain performance for the Resource Management Worksheet, it is strongly
recommended that you activate the Session Cleanup scheduled job.

File or Stored Procedure SessionCleanup

Schedule Every 5minutes

Status Enabled

Survey Set Expired Survey scheduled job

Changes the status of expired “Automated” surveys to “Inactive”.

Deletes all pending approval survey records from the SurveySanTrigger table when the
associated project or opportunity is deleted.

File or Stored Procedure SV_SetExpiredSurveyInactive

DeleteSurveySanTrigger

Schedule Once a day at 1:00 AM

Status Disabled

Task Slippage scheduled job

Sends the notification to Project Manager and Engagement/Initiative Manager when either of
the following occurs:

• the resource forecasts a later date than the original plan on the task

• the resource forecasts a larger number of hours than the original planned hours

Used by the “Task slippage” email notification.

File or Stored Procedure TaskSlippage

Schedule Once a week on Sunday at 8:00 AM.

Status Disabled
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Time Conformance scheduled job

Sends email notices to resources whose total hours for the previous week were not in
conformance with the required hours.

Generates the “Time sheet compliance report” email notification.

File or Stored Procedure CheckTimeConformance

Schedule Once a week on Sunday at 8:00 PM.

Status Disabled

Update Time Rate scheduled job

Updates the billing/cross charge rates, cost rates, fixed fee IDs and the billable/chargeable
flag in the time tables based on resource/billing role/staffing level combinations and effective
dates. Also updates the task actual cost into the task assignment table that is used by the
Microsoft Project interface.

The Update Time Rate job is the first job in a chain of dependent scheduled jobs. For more
information, see "Chained scheduled jobs" on page 83.

File or Stored Procedure TI_UpdateTimeBillingRate

UpdateAssignmentCost

msdb..sp_start_job@job_name = 'Resource Demand

Calculation'

Schedule Once a day at 12:01 AM.

Status Enabled

Validate UDFs scheduled job scheduled job

Calculates and populates calculated field values for all entities for which a calculated
configurable field has been configured. Before the calculation occurs, the job checks that the
calculation formula is valid. If the formula is invalid, the job bypasses the field and writes a
message to the Windows event log.
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File or Stored Procedure ValidateFormulas

UpdateUDFCalculationField

Schedule Once a day at 2:00 AM.

Status Enabled

Workflow Management scheduled job

Starts the workflow process, populates default configurable fields for system-generated
resource requests, and processes workflow escalations for all records.

Note:WorkflowEscalation.exe requires a trusted connection.

File or Stored
Procedure

<cp_root>\ScheduledJobs\ WorkflowEscalation.exe

[DATABASESERVER], [DATABASE]

Where:

[DATABASESERVER] – name of Changepoint database server

[DATABASE] – name of Changepoint database

Schedule Every 30minutes

Status Enabled

Editing parameters for scheduled jobs
Some of the scheduled jobs call stored procedures or run .exe files using parameters.

1. Access SQL Server Management Studio.

1. In the Object Explorer tree view, expand the following nodes:

ServerName > SQL Server Agent > Jobs

2. Right-click the job, and then select Properties.

The Job Properties dialog appears.

3. Select the Steps page, and then double-click the step that contains the parameter.

The Job Step Properties dialog appears.

4. In the Command field on the General page, edit the parameter value as required.
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5. Click OK.

6. Click OK again.

Monitoring database growth
The PerformanceCPGrowth scheduled job monitors the growth of database files and tables.
The job gathers information on table growth, file growth, and I/O statistics. By default, the job
collects counter data once a day. The data is stored in the following database tables:

• perfCPFileGrowth – Stores daily details about file growth. Data is saved for 70 days.

• perfCPFileGrowthSum – Stores monthly aggregate data on file growth. Data is saved for
10 years.

• perfTableGrowth – Stores daily details about table growth. Data is saved for 70 days.

• perfTableGrowthSum – Stores monthly aggregate data on table growth. Data is saved for
10 years.

• CPstartuptimes – Stores the startup times. Some counters are cumulative from the last
SQL Server start. At startup they are reset.

You can use the data in these tables to monitor database growth over time. Under normal use,
the database will grow. The database tables and files may shrink if auto-shrink is enabled or if
you use the archiving functionality to move old data from the database to an archive database.

Abnormal database file shrinkage or growth could result in the following issues:

• server resources consumption

• performance problems

• physical file fragmentation

• a need for more maintenance

Therefore it is recommended that you monitor the database growth to diagnose potential
issues.

You can use the following sample queries in SQL Server Management Studio to access the
data gathered by the PerformanceCPGrowth scheduled job.
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File Growth Details Query

The following query retrieves file growth details over the past 50 days based on the current
server date and time.

declare @StartDate datetime, @EndDate datetime

set @StartDate = GetDate()-50

set @EndDate = GetDate()- 1

exec performanceCPfilesGrowthDetails @StartDate,@EndDate

GO

File Growth Summary Query (for a range of months)

The following query retrieves file growth summary data for October 2012 – November 2012.

/**********************

Parameters:

Start year

Start month

End year

End month

**********************/

exec performanceCPfilesGrowthSum 2012,10,2012,11

GO

File I/O Details Query

THE FOLLOWING QUERY RETRIEVES FILE I/O DETAILS (READS, WRITES, READS+WRITES)

OVER THE PAST 50 DAYS BASED ON THE CURRENT SERVER DATE AND TIME.

declare @StartDate datetime, @EndDate datetime

set @StartDate = GetDate()-50

set @EndDate = GetDate()- 1

exec performanceCPFilesWritesDetail @StartDate,@EndDate

exec performanceCPFilesReadsDetail @StartDate,@EndDate

exec performanceCPFilesIODetail @StartDate,@EndDate

GO
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File I/O Summary Query

The following query retrieves file I/O summary data (reads, writes, reads+writes) for
November 2012.

exec performanceCPfilesWriteSum 2012,11

exec performanceCPfilesReadSum 2012,11

exec performanceCPfilesIOSum 2012,11

GO

Table Growth Details Query

The following query retrieves table growth details over the past 50 days based on the current
server date and time.

This query contains two optional parameters for the column to order by (default: table name)
and for the number of rows in the output list.

declare @StartDate datetime, @EndDate datetime

set @StartDate = GetDate()-50

set @EndDate = GetDate()- 1

/******************

parameters:

Start date

End date

Column to order by (optional)

Number of rows in the output list (optional)

******************/

exec performanceTableGrowthDetail  @StartDate,@EndDate

exec performanceTableGrowthDetail  @StartDate,@EndDate, 'RowsGrowth'

exec performanceTableGrowthDetail  @StartDate,@EndDate, 'RowsGrowth', 30

exec performanceTableGrowthDetail  @StartDate,@EndDate, NULL, 20

GO

Table Growth Summary Query

The following query retrieves table growth summary data for the specified range of months.
For a single month, set the start month and year parameters equal to the end month and year.

This query contains two optional parameters for the column to order by (default: table name)
and for the number of rows in the output list.

/******************
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parameters:

Start year

Start month

End year

End month

Column to order by (optional)

Number of rows in the output list (optional)

******************/

exec performanceTableGrowthSum 2011,10,2012,10

exec performanceTableGrowthSum 2011,10,2012,10,'InitialSize_kb'

exec performanceTableGrowthSum 2011,10,2012,10,'InitialSize_kb',10

exec performanceTableGrowthSum 2011,10,2012,10,NULL,10

GO

Retaining daily demand distributions in past fiscal periods
By default, the daily distributions for demand are removed from past fiscal periods by the
Resource Demand Calculation job. However, you can retain the daily distribution data by
specifying a lag period in days after the fiscal period before the data is to be removed.

Warning: If you specify a lag period, then you must monitor the database to manage the
database size and avoid performance degradation in certain areas.

The database administrator must run the following query to set the number of days for the lag
period. The following query adds a 60 day lag after the end date of the fiscal period.

DECLARE @DailyAllocationCleanUpLag INT = 60--- Number of lag days

UPDATE ServerSettings SET DailyAllocationCleanUpLag = @DailyAllocationCleanUpLag
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Overview of Cognos BI installation and configuration

Installation and configuration of Cognos BI takes place in several stages, which are
described in the following sections:

• "Stage 1. Creating the Cognos Content Store database" on page 109

• "Stage 2. Installing the Cognos App Tier" on page 110

• "Stage 3. Configuring the Cognos App Tier" on page 111

• "Stage 4. Installing the Cognos gateway" on page 114

• "Stage 5. Configuring Changepoint server integration for Cognos BI " on page 115

• "Stage 6. Assigning Changepoint security features for access to Cognos functionality" on
page 115

• "Stage 7. Importing the Changepoint metadata package" on page 116

• "Stage 8. Setting up the data source for IBM Cognos" on page 117

• "Stage 9. Setting the security settings in Cognos" on page 119

For information about installing the Changepoint-Cognos Sync Utility, see "About the
Changepoint-Cognos Sync Utility " on page 120.

About installing multiple instances of Cognos BI

For information about installing multiple App Tier and Gateway instances, see "Installing
Additional Instances of Cognos App Tier and Gateway" on page 131.

You can configure Cognos BI to use multiple databases, for example to implement a Test
and Training setup. For more information, see "Installing Additional Instances of Cognos
App Tier and Gateway" on page 131.

To configure Cognos for reports from more than one database, you must create and configure
a separate connection to the data source for each database. For more information, see the
IBM Cognos Business Intelligence Administration and Security Guide.

Note: For more information about the IBM Cognos software, see the IBM Cognos
product documentation.
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Preparing to install Cognos BI
In addition to the standard Changepoint requirements, you require an overall understanding of
the following:

• architecture of a Cognos BI solution

• TCP/IP port assignments within the deployment environment (multiple App Tier and
gateway instances)

About roles and feature mapping between Cognos and Changepoint

Access to Cognos functionality is based on resource roles and features in Changepoint. During
installation, Changepoint roles are mapped to Cognos groups, and Changepoint features are
mapped to Cognos roles. The Cognos groups and roles control resources’ access permissions
to objects, such as directories, folders, and content in the Cognos software.

Each Cognos role has a specific set of access permissions. For a description of these roles,
see the IBM Cognos Business Intelligence Administration and Security Guide.

The following table shows how the predefined Cognos roles are mapped to Changepoint
features.

Cognos role Changepoint feature

Authors Cognos Professional Author

Consumers Base User License

Directory Administrators Cognos Administrator

Portal Administrators Cognos Administrator

Query Users Cognos Business Author

Report Administrators Cognos Professional Author

Server Administrators Cognos Administrator

Systems Administrator Cognos Administrator
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Installation parameters for Cognos BI

Before you start the installation, use the following table to determine the parameter values for
your installation. You are prompted for this information during installation and configuration.

Note: For server names, always use the fully-qualified domain name.

Field Description

Changepoint database server name,

and port or instance name

Changepoint database name

Changepoint database connections

account ID and password

SQL account and password used to give the

Changepoint applications access to the database.

SQL server administrator ID and

password

“sa” or equivalent account

Cognos dispatcher port (optional) If required, port to use in place of “9300”.

SMTP mail server name and port Used to send notifications from Cognos

Email account and password Used to send notifications from Cognos

Email address of default sender Used as the “From” address on notifications from

Cognos

Changepoint website URL and port

Changepoint website name

Whether Changepoint website uses

SSL

Cognos App Tier server name

Stage 1. Creating the Cognos Content Store database
Note: If you are upgrading Cognos BI, do not perform this stage.

1. On the Changepoint database server, log in as a system administrator.

2. From the root of the Cognos BI media, run setup.exe.
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3. Click Step 1: Create Content Store Database.

The Select Database appears.

4. In the Select the SQL Server that Changepoint is installed on field, enter the name of
the Changepoint database server.

5. In the Changepoint Database Name field, enter the name of the Changepoint database.
The default name is Changepoint.

6. In the Changepoint Id field, enter the login ID of the SQL account used to give the
Changepoint applications access to the database.

7. In the Login ID and Password fields, enter the SQL server administrator (sa) user ID and
password.

8. Click Start.

Stage 2. Installing the Cognos App Tier
1. Log into the Cognos App Tier server as system administrator.

2. Disable the server’s antivirus software, or exclude %ProgramFiles%\IBM.

Note: If you choose to keep your antivirus software running, the installation will take
much longer because the antivirus software scans each file that is installed.

3. From the root of the Cognos BI media, run setup.exe.

4. Click Step 2: Install and Configure Cognos App Tier.

The CAP Configuration dialog box appears.

5. In the SQL Server that Content Store and Changepoint is installed on field, enter the
name of the Changepoint database server.

6. In the Changepoint Database Name field, enter the name of the Changepoint database.
The default name is Changepoint.

7. In the Changepoint Id and Password fields, enter the SQL account and password used to
give the Changepoint applications access to the database.

8. Click Start.

9. Right-click Computer, and select Properties > Advanced system settings >
Performance > Settings > Data execution prevention.
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10. In the Data Execution Prevention tab, do one of the following:

• Select Turn on DEP for essential Windows programs and services only

• Select Turn on DEP for all programs and services except those I select, then add
as exceptions all Cognos executables in the Cognos directories, for example, java.exe,
cogbootstrapservice.exe, etc.

The default Cognos root directory is: %programfiles%\ibm\cognos\c10\

11. If you changed the selected option in step 10, restart the server.

Stage 3. Configuring the Cognos App Tier
The Cognos Application Tier components are configured using the IBM Cognos Configuration
application.

1. On the Cognos App Tier server, log in as administrator.

2. From the Start menu, launch IBM Cognos Configuration.

3. Click OK to acknowledge that the configuration files have been updated.

To configure environment properties

1. In the Explorer pane, select Environment.

2. Complete the following fields in the Environment - Group Properties pane:

Field Description

Each URI field that

includes

localhost:9300, for

example, External

dispatcher URI

Change localhost to the name of the Cognos App Tier server (that

is, the name of the local machine). SomeURI fields, for example,
Content Manager URIs, have anEdit button that opens a dialog

box to edit multiple URIs

Gateway Settings >
Gateway URI field

Enter the URI and port of the Changepoint website, and append:
/ibmcognos/cgi-bin/cognosisapi.dll

For example:
http://cp.domain.com.localcp:80/ibmcognos/cgi-

bin/cognosisapi.dll
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Note: By default, Cognos BI uses port 9300 for the dispatcher. To change the dispatcher
port, replace 9300 with the new port number in all dispatcher and Content Manager URIs.
You must provide the URIs of the Internal and External dispatchers in Stages 4 and 5
respectively.

To configure authentication properties

1. In the Explorer pane, select Security > Authentication.

2. In the Authentication - Component Properties pane, Inactivity timeout in seconds
field, enter 43200.

3. In the Explorer pane, select Security > Authentication > Cognos.

4. In the Cognos - Namespace - Resource Properties pane, Allow anonymous access?
list, select False.

Note: Set this parameter to False regardless of whether you use Single Sign-on (SSO) for
Changepoint.

5. In the Explorer pane, right click Security > Authentication, and select New resource >
Namespace.

The New Resource - Namespace dialog box appears.

6. In the Name field, enter Changepoint.

7. In the Type list, select Custom Java Provider.

8. Click OK.

9. In the Explorer pane, select Security > Authentication > Changepoint.

10. Complete the following fields in the Changepoint - Namespace - Resource Properties
pane:

a. In the Namespace ID field, enter Changepoint.

b. In the Java class name field, enter com.changepoint.cap.CapControl. The Java
class name is case-sensitive.

c. In the Selectable for authentication list, select True.

To configure Content Manager properties
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1. In the Explorer pane, right click Data Access > Content Manager > Content Store, and
select Delete.

2. In the Explorer pane, right click Data Access > Content Manager, and select New
resource > Database.

The New resource - Database dialog box appears.

3. In the Name field, enter Content Store.

4. In the Type list, selectMicrosoft SQL Server database.

5. Click OK.

6. In the Explorer pane, select Data Access > Content Manager > Content Store.

7. Complete the following fields in the Content Store - Database - Resource Properties
pane:

a. In the Database server with port number or instance name field, enter the name
and port or instance name of the Changepoint database server.

b. In the Database name field, enter ContentStore.

Note: This is the default name of the content store database that was created in "Creating
the Cognos Content Store database" on page 109.

8. Click in the User ID and password field, then click the Edit button.

9. In the User ID field and Password and Confirm Password fields, enter the SQL account
and password used to give the Changepoint applications access to the database.

10. To test the Content Manager database connection, right click Data Access > Content
Manager > Content Store, and select Test.

To send Cognosworkflow notifications by email

1. In the Explorer pane, select Data Access > Notification.

2. Complete the following fields in the Notification - Component Properties pane:

a. In the SMTP mail server field, enter the name and port of the mail server to use to
send notifications.

b. In the Default sender field, enter the email address to use as the "From" address on
email notifications.
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Note: This does not have to be the same account that is in the Account and password
field

3. Click in the Account and password field, then click the Edit button, and complete

the Value - User ID and password dialog box:

a. In the User ID field, enter the user ID for any valid account on the mail server. This
is the account that notifications are sent from.

b. In the Password and Confirm Password fields, enter the password of the user ID
account.

Note: If you do not configure a mail server, when you start the IBM Cognos service, a
warning message appears when the mail server connection is tested. You can ignore the
warning.

To save the Cognos App Tier configuration

1. Click Save.

2. When the Close button is enabled, click it.

3. To start the IBM Cognos service, click the Start button.

Stage 4. Installing the Cognos gateway
1. On each Changepoint web server, sign in as administrator.

2. Disable the server’s antivirus software, or exclude %ProgramFiles%\IBM.

Note: If you choose to keep your antivirus software running, the installation will take
much longer because the antivirus software scans each file that is installed.

3. From the root of the Cognos BI media, run setup.exe.

4. Click Step 3: Install and Configure Cognos Gateway.

5. Complete the CP_CognosGateway dialog box:

a. In the Cognos Dispatcher URI field, enter the server name from the Internal
dispatcher URI of the Cognos App Tier server. For example:

cognos.domain.com.changepoint

Note: Do not include the port, or the path /p2pd/servlet/dispatch.
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b. In the Dispatcher Port field, enter the port assigned to the internal dispatcher: default
9300, or the value you set in Stage 3.

c. If the Cognos App Tier uses SSL, select the Use SSL for Dispatcher URI check box.

6. Click Next.

7. Select the name of your Changepoint website in the Choose the Changepoint Enterprise
website list.

8. Click Next, then click Install.

Stage 5. Configuring Changepoint server integration for Cognos BI
1. Sign in to Changepoint Administration.

2. Select General > Server Integration.

3. Select the Enable Cognos integration check box.

4. In the Cognos application tier URL field, enter the External dispatcher URI of the
Cognos App Tier server. For example:

http://cognos.apptier.ext.changepoint.local:9300/p2pd/servlet/dispatch

5. Click Save.

Stage 6. Assigning Changepoint security features for access to
Cognos functionality

By default, all Changepoint resources can access Cognos Connection and Cognos Workspace
and do the following:

• run reports

• set up report schedules

You can enable Changepoint resources to create their own portals in Cognos Workspace. For
more information, see "Setting the security settings in Cognos" on page 119

The Base User security feature controls the general access granted to all resources. To allow
resources to access other Cognos reporting functionality, you must assign the following
Cognos-related features to resources or roles:

• View Reports feature – View Cognos reports and/or workspaces in the Reports tree view
in Changepoint.
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• Cognos Business Author feature – Create or edit a report using Analysis Studio, Query
Studio or Cognos Workspace Advanced.

• Cognos Professional Author feature – Create or edit a report using Report Studio,
Analysis Studio, Query Studio or Cognos Workspace Advanced, and manage report
scheduling.

• Cognos Administrator feature – Administer IBM Cognos software configuration, server
settings, and all security aspects; install and run the Changepoint-Cognos Sync Utility.

For more information about assigning the security features to resources and roles, see the
Changepoint Administration Guide.

Stage 7. Importing the Changepoint metadata package
If you have more than one Changepoint website, apply this procedure on only one.

1. Sign in to Changepoint as Changepoint administrator.

2. Click Cognos > Cognos Connection.

3. Click Launch > IBM Cognos Administration.

4. Click Configuration > Content Administration, and click the New Import button.

5. In the Deployment archive section, select ContentStore, then click Next.

6. In the Password field, enter Changepoint, then click OK.

7. In the Specify a name and description - New Import Wizard pane, in the Name field,
change the default from Export ContentStore to Import ContentStore.

8. Click Next, then click Next again.

9. In the Select an action - New Import Wizard pane, select the Save and run once
option, and click Finish.

10. Complete the Run with options - Import ContentStore pane:

a. In the Time option section, select Now

b. Select all the Content check boxes.

c. In the Report specification upgrade option section, select Keep the existing report
specification versions.
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d. In the Store IDs option section, select Do not assign new IDs during import. Ignore
the warning message.

11. Click Run, then click OK.

12. To view run history and confirm that the package was imported successfully, clickMore,
and then click View run history.

13. Click Close.

The Configuration > Administration pane displays two packages: Import ContentStore,
and Export ContentStore. These packages are not required.

14. Select the check boxes for both packages, and click the Delete button.

15. Click Log off.

Note: If a base user needs to run a report that contains a link to a profile page, you must
grant “Execute” permissions to the HTML Items in Report capability to the base user.
For more information, see the IBM Cognos Business Intelligence Administration and
Security Guide.

Stage 8. Setting up the data source for IBM Cognos
Note: If you have more than one Changepoint web site, apply this procedure on only one.

1. Sign in to Changepoint as Changepoint administrator.

2. Click Cognos > Cognos Connection.

3. Click Launch > IBM Cognos Administration.

4. Click Configuration > Data Source Connections.

5. Click New Data Source .

6. In the Name field, enter “Changepoint,” and then click Next.

7. Complete the Specify the connection - New Data Source pane:

a. In the Type list, select Microsoft SQL Server (SQL 20XX Native Client) version that
matches the SQL Server version of the database server.

b. In the Isolation level options, select Specify a value.

c. In the Specify a value list, select Read Uncommitted.
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d. Select the Configure JDBC connection check box.

8. Click Next.

9. Complete the Specify the Microsoft SQL Server (SQL 20XX Native Client)
connection string dialog box (version matches the SQL Server version of the database
server):

a. In the Server name field, enter the name of the database server.

b. In the Database name field, enter the name of the database.

c. Select the Signons option.

d. Select the Password check box.

e. Select the Create signon that the Everyone group can use check box.

f. In the User ID field, and Password and Confirm Password fields, enter the SQL
account and password used to give the Changepoint applications access to the
database.

10. Click the Test the connection link:

a. Click Test, then click Close.

b. Click Close again.

11. Complete the following fields in the Specify the Microsoft SQL Server (JDBC)
connection string dialog box:

a. In the Server name field, enter the name of the Changepoint database server.

b. In the Database name field, enter the name of the Changepoint database.

12. Click the Test the connection link:

a. Click Test, then click Close.

b. Click Close again.

13. Click Next, then click Finish.

The Configuration tab now displays the Changepoint data source under Directory >
Cognos.

118 | Changepoint 2017



Stage 9. Setting the security settings in Cognos

14. Click the Changepoint data source link to show the data source connection – also named
Changepoint.

15. Restart Cognos Services on the Cognos AppTier.

Stage 9. Setting the security settings in Cognos
When Cognos imports user information from Changepoint, every user is given the Cognos
administrator role. This procedure removes that role from all users, except for those users that
have specifically been assigned the Cognos Administrator feature.

Optionally, you can grant Changepoint users the access rights to create their own portals in
Cognos Workspace.

To remove the administrator role fromChangepoint users

1. Sign in to Changepoint as Changepoint administrator.

2. Click Cognos > Cognos Connection.

3. Click Launch > IBM Cognos Administration.

4. Click Security, then click Cognos.

5. Scroll to the System Administrator role, and then clickMore.

6. Click Set Members, and select Everyone.

7. Click the Remove link.

8. Click OK.

To grant Changepoint users the access rights to create portals in CognosWorkspace

Changepoint users require the Assemble capability to create portals in Cognos Workspace,
which you must set up in Cognos Connection. You grant Execute permissions on the Use
Advanced Dashboard Features permission (in the Executive Dashboards section) for the
Consumers group.

1. Sign in to Changepoint as Changepoint administrator.

2. Click Cognos > Cognos Connection.

3. Click Launch > IBM Cognos Administration.

4. Click Security, then click Cognos.
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5. In the left pane, click Capabilities.

6. In the Capabilities section, click Executive Dashboards.

7. Click the down arrow beside Use Advanced Dashboard Features, and then select Set
Properties.

8. Click the Permissions tab.

9. Click Add.

10. Click Cognos, then select the Consumers check box.

11. Click the arrow button to add Consumers to the Selected entries, and then click OK.

12. Click the Consumers check box, and then in the Execute row, click the check box in the
Grant column.

13. Click OK.

About the Changepoint-Cognos Sync Utility
The Changepoint-Cognos Sync Utility synchronizes the Changepoint-Cognos data model of the
database with Changepoint. You must synchronize the data model when:

• you import a base data model that you received from Changepoint Canada ULC. The base
data model contains the default field labels for the standard fields in the supported
languages.

• you make one or more of the following changes in Changepoint Administration:

• create a configurable field

• modify a configurable field label

• modify the field label of a standard field that is included in the model.

Hardware and software requirements

For details of the hardware and software requirements of the workstation that is used to run
the Changepoint-Cognos Sync Utility, see the Changepoint Product Architecture and
Technology Matrix and the Changepoint Hardware Recommendations Guide.
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Synchronization process overview

After you upgrade to 2017 and install and configure Cognos BI, you must import the base data
model supplied with 2017, and then synchronize the model. This initial synchronization creates
a new revision with your configurable fields, and labels that you modified before you upgraded.

New revisions are incremental, which means that only configurable fields that have been
added and field label changes that have been made since the previous revision are
synchronized.

The length of time for the synchronization depends on the number of configurable fields that
you have, and the number of field labels that have been changed in Changepoint Administration
since the last time that a revision was created. Only fields that have values in Changepoint are
synchronized. That is, if you create a new configurable field for which there are no values, the
field and the label for that configurable field are not synchronized.

Tip: Record the length of time that it takes to import the base data model and create the
initial revision during testing. This information will help you to plan the production
implementation.

Note: Use the fully-qualified domain name for server names.

About the Changepoint-Cognos Sync Utility log file

The log file CognosUILog.txt is located in:

<application data directory>\Local\Changepoint\Changepoint\Cognos
Automation\Logs

Warning: The Sync Utility does not monitor the size of the log file. You must manually
delete or truncate the log file.

Ad hoc changes to field labels in reports

To make a one-time field label change in a report without changing the Changepoint-Cognos
data model, either set the Text Source Source type to text for the field label and manually
override the value in a single language, or set a text source variable for the field label, then use
the Cognos Condition Explorer to set the value. For more information, see the IBM Cognos
Report Studio User Guide.

About using the Sync Utility with multiple App Tier and gateway instances

When you install the Changepoint-Cognos Sync Utility, it is configured for a specific database
on a specific database server.
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Therefore, if you have multiple databases (for example, separate databases for production,
test, and training), then you require a separate administrator workstation with the Sync Utility
installed on it for each database, even if all of the databases use the same SQL Server version.

Upgrading the Sync Utility

You must always use the version of the Sync Utility that corresponds to the Changepoint
version.

To upgrade the Sync Utility, you must uninstall the previous release sync prerequisite and
Sync Utility from the Windows Control Panel, and then install the current release version.

Installing the Sync Utility

By default, the Changepoint-Cognos Sync Utility is installed and configured for the PSA
version of Changepoint. To configure the Sync Utility for Changepoint PPM, see step 11.

To install the prerequisites for the sync utility

1. Disable User Access Control.

2. From the root of the Cognos BI media, run setup.exe.

3. Click the Cognos Sync Utility Tab and select Step 1: Install Changepoint Sync Tool
Prerequisites. The Sync Tool prerequisites must be reinstalled on each client.

4. Click Next, then click Install.

To install the sync utility

1. As administrator, from the root of the Cognos BI media, run setup.exe.

2. Click on the Cognos Sync Utility Tab and select Step 2: Install Changepoint Sync
Utility.

3. In the Cognos Dispatcher Server Name field, enter the name of the Cognos App Tier
server.

4. In the Dispatcher Port field, enter the port used for the Cognos dispatcher.

5. If the Cognos App Tier uses SSL, select the SSL Enabled check box.

6. In the Enterprise Website Server Name field, enter the name of the Changepoint web
server.

7. In the Enterprise Port field, enter the port used by the Changepoint website.
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8. If the Changepoint website uses SSL, select the SSL Enabled check box.

9. Click Next, then click Install, then click Finish.

10. In the Changepoint Connection Settings dialog box:

a. In the Connection Settings list, select Changepoint Window Service, Scheduled
jobs and Utilities.

b. In the File location field, browse to:

<cp_common>\Cognos Client Tools\CognosClientTools.exe.config

For more information, see "Configuring database connection settings" on page 65.

A shortcut named Changepoint Cognos Sync Utility is added to the Start menu.

11. To configure the Sync Utility for Changepoint PPM:

a. Open the CognosClientTools.exe.config file in a text editor.

b. Search for the CompanyProfile key, and change its value from PSO to ITD.

c. Save and close the file.

12. Import the initial base data model from the Cognos BI media Setup/Model folder.

Uninstalling the Sync Utility

You uninstall the Sync Utility from the Windows Control Panel.

Importing the base data model
When you import a base data model, the previously imported base data model and later
revisions are replaced by the newly imported base data model.

Note: To include configurable fields and modified field labels in the model, you must
create a new revision after importing a base data model.

1. Launch the Changepoint-Cognos Sync Utility, and sign in with your user ID and password.

2. In the Changepoint-Cognos Sync Utility dialog box, click Import Revision.

3. Select the zip file that corresponds to the Changepoint version:

• Model.zip (Changepoint PSA)

• Model-ITD.zip (Changepoint PPM)
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4. Click OK.

Adding customized field labels and configurable fields to the data model

To add configurable fields and field label changes to the data model, you must create a new
revision after importing the base data model.

1. Launch the Changepoint-Cognos Sync Utility, and sign in with your user ID and password.

2. In the Changepoint-Cognos Sync Utility dialog box, click New Revision.

The New Revision dialog box appears.

3. In the Comments field, enter a comment.

4. Do the following:

• To import configurable fields, select the Include configurable field delta check box.

• To import new or changed field labels or page content strings, select the Include
language string delta check box.

5. Click Publish Model.

6. Advise report creators to open each of their reports in the Cognos report design tool and
follow the prompts to accept the changed package.

Reverting to a previous version of the base data model

You can revert to the imported base data model, or to a previous revision. All revisions that
were published after the one you revert to are deleted.

1. Launch the Changepoint-Cognos Sync Utility, and sign in with your user ID and password.

2. In the Changepoint-Cognos Sync Utility dialog box, double-click the version you want to
revert to.

3. In the Model Detail dialog box, click Revert model.

4. Advise report creators to open each of their reports in the Cognos report design tool and
follow the prompts to accept the changed package.

About publishing an unsecured Changepoint-Cognos data model
You can create a Changepoint-Cognos data model that is not bound to normal access
restrictions within Changepoint by publishing an unsecured version of the latest data model.
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The unsecured model is published to a data package called ChangepointUnsecured by
default.

The reports that use the ChangepointUnsecured package include all of the data that complies
with the report criteria, regardless of whether the resource who creates or generates the report
has access to the data. In contrast, the access to profile pages in Changepoint from links in
reports still requires that the resource has security access to the data.

Note: You can publish an unsecured data model of the latest data model only. Each time
you create a revision of the data model (for example, to add configurable fields to the
model), you must also publish the unsecured model to keep them both in sync.

The basic steps for creating an unsecured data model are:

1. Publishing an unsecured version of the Changepoint-Cognos data model.

2. Restricting access to the resulting ChangepointUnsecured package.

Publishing an unsecured Changepoint-Cognos data model

1. Sign into the Changepoint-Cognos Sync Utility.

2. In the Changepoint-Cognos Sync Utility dialog box, double-click the latest revision.

3. In the Model Detail dialog box, click Publish unsecured model.

The unsecured model is published to the a package with the default name of
ChangepointUnsecured.

To change the default name of theChangepointUnsecured package

1. Open the following file in an editor:

<cp_common>\Cognos Client Tools\CognosClientTools.exe.config

2. Change the value of the "Cognos.UnsecuredPackage" parameter to the desired default
name for the package.

Tips for using the ChangepointUnsecured package

You use the ChangepointUnsecured package the same way as any other package in Cognos.
For more information about using packages, see the IBM Cognos product documentation.
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Changing a report to the unsecured package:

In Report Studio, open the report and select File > Report Package. Select the
ChangepointUnsecured package. Save the report.

Tip: You can create a copy of a report, and then change the copied report to use the
ChangepointUnsecured package.

If you are using ‘copy report from clipboard’, double-check which package the report is using.
It will use the package from the source report, which may not be the intended package.

• You can also change the package in Cognos Connection, Report properties.

Best practices

Save reports into folders under their respective packages (Changepoint or
ChangepointUnsecured) so that they can be easily distinguished and secured.

Deleted records are not filtered

Deleted records are not automatically filtered out of the ChangepointUnsecured package.
Most query subjects have a deleted flag that you can add to reports to filter out deleted data.
The exceptions are global workgroups and materials. To filter out deleted data in query
subjects that do not have a deleted flag, add a small SQL query and join it to the query subject.

Cognos infers data relationships based on predefined inter-model relationships

In some cases, Cognos infers a data relationship between two query subjects by using the
predefined inter-model relationships and determines its own path for joining the two, which
might provide unexpected results and can make queries inefficient.

For example, for Task and Request query subjects, Cognos uses the relationship between Task
and Time Combined, and Request and Time Combined to infer a relationship between Task and
Request. The common expectation would be it would use a direct relationship between Task
and Request.

In the Changepoint-Cognos data model, the access checking that is included in query subjects
is sometimes used by Cognos to infer data relationships. However, because the unsecured data
model does not include that access checking, some relationships cannot be inferred, which
might cause errors in reports that do not have errors when using the Changepoint package.
Therefore it may be necessary to include more fields or filters in the queries to allow Cognos
to determine a relationship in the unsecured model.

Some examples from the accelerator reports package:
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There are cascading prompts for customer, engagement and project in the following reports:

• Actual vs planned Recognition billing effort and cost amounts by project

• Actual vs planned Recognition effort cost and margin amounts summary by project

The solution was to do the following:

1. Create a separate query using the Project query subject for each of the customer,
engagement and project prompts.

2. Use the queries in the respective ‘Customer’, ‘Engagement’ and ‘Project’ prompts on the
prompt page.

3. For the project query, add the filters (the same filters and parameters that are in the main
query used in the report tables):

‘[|CustomerId] in ?Customer?’

‘[|AssociatedEngagementId] in ?Engagement?’.

Cascading prompts for Project/Budget Revision number in the following reports:

• Budget revision comparison by fiscal period

• Budget vs Actual by fiscal period

The solution was to create separate queries using the budget details query subject for each
of the project and revision number prompts.

Use the queries in the respective prompts on the prompt page.

For the revision number query, add the filter (the same filter and parameter that is in the main
query used in the report tables):

'[|ProjectId] = ?Project?'

Restricting access to the ChangepointUnsecured package

To limit the access that resources have to the ChangepointUnsecured package, you can
create a role in Changepoint and then restrict access to the package in Cognos Connection to
the group that is mapped to the role.

Note: You can similarly restrict access to the package based on a IBM Cognosrole that is
mapped to a Changepoint feature. Keep in mind however that some Changepoint features
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map to multiple IBM Cognos roles. For more information, see "About roles and feature
mapping between Cognos and Changepoint" on page 108.

To restrict access to aChangepointUnsecured package using a Changepoint role

1. In Changepoint Administration:

a. Create a role, but do not map it to any security features.

b. Assign the role to the resources who require access to the ChangepointUnsecured
package for creating reports.

Tip: To ensure that the role is immediately visible in Cognos Connection, assign the role
to yourself, at least temporarily, then access IBM Cognos connection.

2. In Cognos Connection:

a. Remove access to all the Report Studio capabilities from the Everyone group.

b. Set up access to all the Report Studio capabilities for the group that corresponds to the
Changepoint role that you created.

c. Select the Delete the capabilities of all child entries check box at the bottom of the
view.

For more information, see "Set Up Object Capabilities for a Package" in the Cognos
Connection online help or the IBM Cognos Business Intelligence Administration and
Security Guide.

Restricting access to the reports in the ChangepointUnsecured package

1. In Changepoint:

a. Create a Changepoint role. You can use the same role that was created to restrict
access in Report Studio to the package.

b. Assign the role to the resource who require access to the reports in the
ChangepointUnsecured package. You can temporarily assign the role to yourself to
ensure it appears immediately in Cognos Connection.

2. In Cognos Connection:

a. Edit the properties for the ChangepointUnsecured package.

b. On the Permissions tab, remove all existing entries.
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c. Add the Cognos group that corresponds to the role you wish to have access to reports
in the package.

d. Select the Delete the capabilities of all child entries check box at the bottom of the
view.

3. To set up access for different folders in the ChangepointUnsecured package to different
sets of users, you can create multiple roles and set permissions on the individual folders or
reports. Ensure that you grant 'traverse' access to the package and any higher-level folders
to the role.
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and Gateway
About installing additional instances of Cognos App Tier and
gateway

You can install additional instances of the Cognos App Tier on a server and the Cognos
gateway on a web server. For example, you could create a combined Test and Training
environment using a single physical server for the Cognos App Tier instances, and a single
physical web server for the Changepoint websites.

Note: The initial instances of the Cognos App Tier, content store database, and gateway
must be installed using the installer supplied by Changepoint Canada ULC.

Warning: The only configuration that is supported is a single Cognos App Tier instance
on a dedicated server, and a single Cognos Gateway instance on each server that hosts
an Changepoint website.

All procedures must be executed using administrative privileges.

Installation parameters for additional instances of Cognos App
Tier and gateway

The following table lists the parameter values that you will require during installation and
configuration.

Note: Use the fully-qualified domain name for server names.

Field Description

Changepoint database server name,

and port or instance name

Changepoint database name

Changepoint database connections

account ID and password

SQL account and password used to give the

Changepoint applications access to the database.

Changepoint website URL and port

Changepoint website name
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Field Description

Cognos App Tier server name

Port to use for new Cognos

instances

Default port for the initial instance is 9300

Local log server port Default port for the initial instance is 9362

Local shutdown port Default port for the initial instance is 9399

SMTP mail server name and port Used to send notifications from Cognos

Email account and password Used to send notifications from Cognos

Email address of default sender Used as the “From” address on notifications from

Cognos

Installing an additional Cognos App Tier instance
The content store database is installed on the Changepoint database server. Each App Tier
instance requires a separate content store database.

Warning: Do not run the setup program from the root of the Cognos BI media because
you will damage the existing installations.

Installing an additional content store database

1. Log into the SQL server as system administrator.

2. From the Cognos BI media, open \Setup\ContentStore\ContentStore.sql in SQL
Server Management Studio.

3. If the SQL server already contains a content store database, edit the script to give a unique
name to the database being created (for example, ContentStore_CS2).

4. Replace CPSQLUser with the SQL account used to give the Changepoint applications
access to the database.

5. Execute the script.

Installing an additional Cognos App Tier component

1. Log into the Cognos App Tier server as system administrator.

2. From the Cognos BI media, execute the Cognos BI installer:
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\Setup\Cognos\64b\winx64h\issetup.exe

3. In the Installation Directory field, enter a unique directory name (for example, c10_
at2).

4. In the Component selection section, select the Application Tier Components and
Content Manager check boxes.

5. In the Shortcut Folder field, enter a unique name for the application instance (for
example, IBM Cognos 10 - AppTier2).

6. When the installer completes, clear the Start the IBM Cognos Configuration check box,
and then click Finish.

7. From the Cognos BI media, execute the Cognos BI Fix Pack installer:

\Setup\CognosFixPack\x64\winx64h\issetup.exe

8. In the Installation Directory field, select the directory:

C:\Program Files\ibm\cognos\c10_at2

9. Copy the following files from the first application tier instance to the new application tier
instance:

%programfiles%\ibm\cognos\c10\webapps\p2pd\WEB-INF\lib\ChangepointCap.jar

%programfiles%\ibm\cognos\c10\webapps\p2pd\WEB-INF\lib\log4j.xml

%programfiles%\ibm\cognos\c10\webapps\p2pd\WEB-INF\lib\sqljdbc4.jar

%programfiles%\ibm\cognos\c10\configuration\CAP.properties

%programfiles%\ibm\cognos\c10\deployment\ContentStore.zip

10. Open the log4j.xml file, and change the path to changepointCAP.log to refer to the
directory of the new instance.

Configuring the Custom Authentication Provider (CAP)

The following procedure configures the Changepoint database that is used by Cognos for login
authentication.

1. You must use the instance of java.exe that is installed with Cognos to configure the
CAP. It is strongly recommended that you include the path to the java.exe instance in the
path system environment variable:

C:\Program Files\ibm\cognos\c10\bin64\jre\7.0\bin;

2. Run the following statements from a command line in the
<new cognos instance>\webapps\p2pd\WEB-INF\lib directory. For example:
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%programfiles%\ibm\cognos\c10_at2\webapps\p2pd\WEB-INF\lib

where c10_at2 is the unique installation directory name that you entered in "Installing an
additional Cognos App Tier component" on page 132.

3. Encrypt the database connection parameters:

java -jar changepointCAP.jar file ..\..\..\..\configuration\CAP.properties

<sqlserver> <userid> <password> <ChangepointDB>

where:

• sqlserver – name of the Changepoint database server. If required, include the instance
name.

• userid – SQL account used to give the Changepoint applications access to the database.

• password – password for the SQL account.

• ChangepointDB – name of the database.

4. Test the Encrypted Database Connection Parameters:

java -jar changepointCAP.jar ..\..\..\..\configuration\CAP.properties

Configuring an additonal Cognos App Tier component

The Cognos App Tier components are configured using the IBM Cognos Configuration
application.

Launch the newly installed instance, for example:

All Programs > IBM Cognos 10 - AppTier2 > IBM Cognos Configuration

where IBM Cognos 10 - AppTier2 is the unique shortcut folder name you entered in "Installing
an additional Cognos App Tier component" on page 132.

To configure environment properties

1. In the Explorer pane, select Environment.

2. Complete the following fields in the Environment - Group Properties pane:

3. For each URI field that includes localhost:9300, replace:

• localhost with the name of the Cognos App Tier server

• 9300 with the port for the new application instance
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4. In the Gateway Settings > Gateway URI field, enter the URI and port of the primary
gateway, and append:

/ibmcognos/cgi-bin/cognosisapi.dll

For example:

http://changepoint:80/ibmcognos/cgi-bin/cognosisapi.dll

5. In the Explorer pane, select Logging.

6. Complete the following fields in the Logging - Component Properties pane:

a. In the Enable TCP? field, select True.

b. In the Local log server port field, change 9362 to the port for the new application
instance.

7. In the Explorer pane, select IBM Cognos.

8. In the IBM Cognos - Configuration - Resource Properties pane, in the Shutdown port
field, enter the port for the new application instance.

To configure notification properties

1. In the Explorer pane, select Notification.

2. In the Notification - Component Properties pane, in the SMTP mail server field, enter
the name and port of the mail server to use to send notifications.

To configure IBMCognos Services properties

1. In the Explorer pane, select IBM Cognos services.

2. In the Component Properties list, find the row for Query Service Enabled and set it to
False.

To configure Content Manager properties

1. In the Explorer pane, right-click Content Store and select Delete.

2. In the Explorer pane, right click Data Access > Content Manager, and select New
resource > Database.

3. Complete the New resource - Database dialog box:
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a. In the Name field, enter the name of the content store database you created earlier,
for example, ContentStore_CS2.

b. In the Type list, selectMicrosoft SQL Server database.

c. Click OK.

4. In the Explorer pane, select Data Access > Content Manager > Content Store.

5. Complete the following fields in the Content Store - Database - Resource Properties
pane:

a. In the Database server with port number or instance name field, enter the name
and port or instance name of the Changepoint database server.

b. In the Database name field, enter the name of the content store database you created
earlier, for example, ContentStore_CS2.

6. Click in the User ID and password field, then click the Edit button, and complete

the Value - User ID and password dialog box:

a. In the User ID field, enter the SQL account used to give the Changepoint applications
access to the database.

b. In the Password and Confirm Password fields, enter the password of the SQL
account.

7. Click OK.

To configure authentication properties

1. In the Explorer pane, select Security > Authentication.

2. In the Authentication - Component Properties pane, in the Inactivity timeout in
seconds field, enter 43200.

3. In the Explorer pane, select Security > Authentication > Cognos.

4. In the Cognos - Namespace - Resource Properties pane, in the Allow anonymous
access? list, select False.

Note: Set this parameter to False regardless of whether you use Single Sign-on (SSO) for
Changepoint.
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5. In the Explorer pane, right click Security > Authentication, and select New resource >
Namespace.

6. Complete the New Resource - Namespace dialog box:

a. In the Name field, enter Changepoint.

b. In the Type list, select Custom Java Provider.

c. Click OK.

7. In the Explorer pane, select Security > Authentication > Changepoint.

8. Complete the following fields in the Changepoint - Namespace - Resource Properties
pane:

a. In the Namespace ID field, enter Changepoint.

b. In Java class name field, enter com.changepoint.cap.CapControl. The Java
class name is case sensitive.

c. In the Selectable for authentication list, select True.

9. Click Test.

10. Save the configuration file.

11. Click Start.

Installing additional Cognos gateway instances on a single server
Warning: Do not run the setup program from the root of the Cognos BI media. If you do so
you will damage the existing installations.

Installing an additional Cognos Gateway component

1. From the Cognos BI media, run the Cognos BI installer:

\Setup\Cognos\64b\winx64h\issetup.exe

2. In the Installation Directory field, enter a unique directory name, for example, gway2.

3. In the Component selection section, select the Gateway check box.

4. In the Shortcut Folder field, enter a unique name for the application instance, for
example, IBM Cognos 10 G2.
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5. When the installer completes, uncheck the Start the IBM Cognos Configuration check
box, and click Finish.

6. From the Cognos BI media, execute the Cognos BI Fix Pack installer:

\Setup\CognosFixPack\x64\winx64h\issetup.exe

7. In the Installation Directory field, select the directory:

C:\Program Files\ibm\cognos\c10_at2

8. Copy the following files from the first gateway instance to the new gateway instance:

%programfiles%\ibm\cognos\c10\webcontent\cognoslaunch.js

%programfiles%\ibm\cognos\c10\webcontent\default.htm

%programfiles%\ibm\cognos\c10\webcontent\index.html

%programfiles%\ibm\cognos\c10\webcontent\web.config

9. Edit the Web.config and change to the new gateway directory path. For example
C:\Program Files\ibm\cognos\c10g2\cgi-bin\cognosisapi.dll

Configuring Microsoft Internet Information Services (IIS) for IBM Cognos

Creating an application pool

1. Launch IIS Manager.

2. In the Connections pane, expand the local server node, and select Application Pools.

3. In the Actions pane, click Add Application Pool.

a. In the Name field, enter the name of the new instance, for example, IBM Cognos 10
G2.

b. From the .NET Framework version list, select .NET Framework v4.0.30319.

4. Click OK.

5. If users will create reports that embed graphics that are hosted on the web server:

a. If necessary, install WebDAV.

b. In IIS Manager, enable WebDAV.

c. Configure the WebDAV settings at the website level to set Allow Anonymous
Property Queries to True.
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Creating the IBM Cognos 10 Virtual Directory

1. In the Connections pane, right-click the Changepoint website for the new gateway, and
select Add Virtual Directory.

2. Complete the following fields in the Add Virtual Directory dialog box:

a. In the Alias field, enter ibmcognos.

b. In the Physical path field, enter the location of the web content sub-directory in the
new gateway, for example:

C:\Program Files\ibm\cognos\c10g2\webcontent

3. Click OK.

Creating an application for cgi-bin

1. In the Connections pane, right-click the new virtual directory, and select Add
Application.

2. In the Add Application dialog box, complete the following fields:

a. In the Alias field, enter cgi-bin.

b. In the Application Pool list, select the new application pool.

c. In the Physical path field, enter the location of the cgi-bin sub-directory in the new
gateway, for example:

C:\Program Files\ibm\cognos\c10g2\cgi-bin

3. Click OK.

Configuring IIS for IBM Cognos ISAPI

1. In the Connection pane, select the IBM Cognos virtual directory that the Cognos gateway
is being installed for.

2. In the Features View, double-click Handler Mappings.

3. If IBMCOGNOS-IMAPI is in the list, right-click it and then select Remove.

4. In the Actions pane, click Add Module Mapping.

5. Complete the following fields in the Add Module Mapping dialog box:

a. In the Request path field, enter cognosisapi.dll.
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b. In the Module list, select IsapiModule.

c. In the Executable field, enter the path to cognosisapi.dll, for example:

C:\Program Files\ibm\cognos\c10g2\cgi-bin\cognosisapi.dll

d. In the Name field, enter IBMCOGNOS-ISAPI.

6. Click OK, then click Yes.

Configuring an additional Cognos gateway instance

1. To launch IBM Cognos Configuration, use the shortcut to the new instance, for example:

All Programs > IBM Cognos 10 G2 > IBM Cognos Configuration

2. From the Explorer pane select Environment.

3. Complete the following fields in the Environment - Group Properties pane:

a. In the Dispatcher URIs for gateway field, replace localhost with the name of the
Cognos App Tier server you want this gateway to work with. Ensure that the URIs use
the same port number as the dispatcher.

b. In the Controller URI for gateway field, replace localhost with the name of the
local machine. Ensure that the URI uses the same port number as the new
Changepoint web site.

4. Click Save, then click Close.
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About Intelligent Forms

Intelligent Forms is a wizard-driven solution for entering data and generating documents.
You use Intelligent Forms to simplify work for resources by streamlining complex tasks and
automating data entry processes.

The Changepoint Intelligent Forms connector integrates Intelledox Infiniti with Changepoint.
After the connector is installed and the standard form templates are configured, resources
can access the standard forms from the Changepoint interface. The forms guide resources
through the process of creating or updating an entity record or creating a document.
Resources with Infiniti administrator access can access Infiniti Manage from the Intelligent
Forms menu in Changepoint Administration.

This document includes instructions that are specific to using Infiniti Manage with
Changepoint. For general information about using Infiniti Manage, please refer to the
Intelledox Knowledge Base, which is available at:

http://ixsupport.intelledox.com/kb/root.aspx.

Standard form templates
Changepoint includes seven standard form templates, which can be used as-is, or which can
be used as templates and enhanced to meet business requirements. The standard form
templates that create entity records include all of the standard fields that are mandatory by
default.

Note: The Create Project Request form is preconfigured to support three request types in
Changepoint: Issue, Risk, and Change Request. If you use different request types then
you must update the form with the appropriate request types. If you require any
assistance in applying this change, please contact Changepoint services.

Note: Before you can use the standard form templates in your Changepoint installation,
you must add all of the mandatory fields that are specific to your organization. This
includes both standard Changepoint fields and configurable fields that have been set as
mandatory in metadata.

Installation Guide | 141

http://ixsupport.intelledox.com/kb/root.aspx


10. Configuring Intelligent Forms

Form

Purpose
How to access the form

Create Engagement
Create a company and contacts, engagement,

project, tasks, and knowledgemanagement items.

Services > Create Engagement

Create Opportunity
Create an opportunity from a company profile.

Company profile > Actions menu > View > Intelligent

Forms > Create Opportunity

Create Project
Create a project from an engagement profile.

Engagement profile > Actions menu > View

> Intelligent Forms > Create Project

Create Project Request
Create a request from a project profile.

Project profile > Actions menu > View > Intelligent

Forms > Create Project Request

Project Status Report
Create a status report from a project profile.

Project profile >Actions menu > Project Status Report

Statement of Work (SOW)
Create a statement of work from an engagement

profile.

Engagement profile > Actions menu > View

> Intelligent Forms > Statement of Work (SOW)

Generate Invoice Document
Generate an invoice document in PDF format.

Invoice profile > Actions menu > View > Intelligent

Forms > Invoice Document

Configuring Intelligent Forms
After installing Intelligent Forms, you must do the following.

1. Install the Intelligent Forms general patch 18.00.118.402 according to the instructions in
the patch release notes.

2. Sign into Changepoint Administration.

3. Import the Changepoint license file (.lic) for Intelligent Forms (Tools > License
Management).

4. In user setup (Resources > User Setup), assign either the security feature Access Forms
Administration or Access Document Administration to your user. These security
features allow you to access Infiniti Manage from Changepoint Administration.

5. Sign out of Changepoint and then sign back in to trigger the security feature changes.
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6. In Changepoint Administration, click Intelligent Forms > Infiniti Manage.

7. Sign in to Infiniti Manage using "admin" for both the user name and password.

8. Enter all of the license keys for the Intelledox Infiniti software

a. In the License Holder field, enter your company name as provided with your licenses.

b. In the Product License field, enter your product license.

c. Click Save.

d. Enter each additional license into the Key field and click Add after each one.

e. Click Save.

9. Click Data Sources and then update the connection strings for each of the data sources as
follows:

a. In the Connection String field, replace {{ChangepointDB}} with the name of the
Changepoint database and {{ChangepointDBServer}} with the database server.

b. In the Connect with these credentials field, enter the user ID and password to be the
same as used in the Changepoint web.config connection string.

10. Republish the document form projects in PDF format:

a. Click Folders, then select the Project folder.

b. Click Project Status Report.

c. In the Format section, clear the “Microsoft Word Document (docx, docm) check
box.

d. Select the Portable Document Format(pdf) check box.,

e. Click Save.

f. Repeat this procedure for the following form projects:

• Statement of Work (SOW) in the Engagement folder
• Generate Invoice Document in the Invoice folder

11. Access each form project, click Design App and then add the user-defined mandatory
fields for the entities:

• Create Engagement (company, contact, engagement, project, task, task assignment)
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• Create Opportunity (company, opportunity)

• Create Project (project, task, task assignment)

• Create Project Request (request)

Note: For more information about using Design, see the Intelledox knowledge base or
contact Changepoint support to engage professional services

12. In Changepoint Administration, assign the security features for Intelligent Forms to
resources as required. For more information about the security features, see the Security
Access Reference Guide or the online help.

13. Advise resources to add the Intelligent Forms in Progress portlet to their default portal
on the home page (Preferences > Portals). Resources require the portlet to access the
partially completed forms that they have saved to continue working on later.

Tip: If all resources have access to the forms, then you can make the portlet mandatory in
personal portals (User Interface > Portlet Management).

Configuring Intelligent Forms on an SSO environment

To enable Intelligent Forms to work on a Changepoint SSO environment, you must enter the
email address (Email) and password (Web password) for each resource into their user
account in Changepoint. The email and password is required by the API for forms
authentication.

Note: The WebServicesAPI site under Enterprise must be set as Application
Authentication.

Configuring Intelligent Forms in a load-balanced environment

If you are installing Intelligent Forms in a load-balanced environment, you must ensure that all
of the URLs are configured to point to the same instance of a website and not to the Load
Balancer URL because the underlying security token must always be generated from the same
website.

1. Sign in to Infiniti Manage.

2. Click Settings > Connector Settings.

3. Select Changepoint.
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4. Ensure that all of the URLs are configured to point to the same instance of a website and
not to the Load Balancer URL.

5. In each instance of the InfinitiLaunch Web.config file, configure the following platform
keys to point to the same instance of a web server in the farm as chosen earlier and not to
the Load Balancer:

• CP_VerifyService.VerifyUser

• INFIN_PlatformService
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About Changepoint and SSO

You can implement Single Sign-On (SSO) capabilities for Changepoint users.

The following implementation options are available using Secure Token Service (STS):

• SSO using ISAPI

• SSO using ISAPI – SSL optional

• SSO using WS-Federation

• SSO using ADFS – SSL required

• SSO using Azure Active Directory – SSL required

• SSO using SAML

• SSO using SAML (ADFS) – SSL required

• SSO using SAML (PingFederate) – SSL required

The configuration scripts for ISAPI and application authentication can optionally enable SSL.

Note: Information on additional unsupported SSO providers are available as tech notes
from your customer support representative or client manager.

SSL

If you are using SSL with SSO, the SSO scripts enable SSL in the configuration files.

If you are using SSL with application authentication, the application authentication script has
an option to enable SSL.

Configuration of scripts and certificates

In each of the procedures that follow, you run one or more PowerShell scripts. These scripts
are used to install required certificates and to modify Changepoint configuration files.

Copy the contents of the \Changepoint\Utilities\Configuration\ folder on the
Changepoint product media to \<cp_common>\Configuration\.
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Changepoint add-ins and SSO

The type of authentication used on the Changepoint website determines whether end-users are
required to sign in when they use an add-in for the first time in a Changepoint session.

Changepoint authentication
type

End-users required to sign in

Application authentication No

ISAPI No

ADFS 2.0 Yes

SAML 2.0 / ADFS 2.0 Yes

About application authentication
By default, Changepoint websites are installed with application authentication for end-user
sign in. Some websites and features require application authentication, and some require
integrated Windows authentication. The following websites and features require application
authentication:

• Client Portal website

• Survey Response website

For more information, see "Setting up a survey response website" on page 180.

• Changepoint website accessed by the Report Prerender Service

Using both application authentication and SSO

You can configure a Changepoint website for either application authentication or SSO, but not
both. However, to use both application authentication and SSO, you can do the following:

1. Create two website instances that point to the same Changepoint database.

2. Configure one website instance for SSO and the other for application authentication.

3. Distribute the URLs for the website instances to users according to the type of access you
want to give them.
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Implementing application authentication

You can use these procedures to do either of the following:

• revert a website to application authentication after having implemented one of the SSO
implementations

• configure Changepoint to use application authentication with SSL

Configure PowerShell

1. Open a Windows PowerShell prompt.

2. Modify the execution policy:

Set-ExecutionPolicy Unrestricted

Stage 1 – Collect configuration parameters

Determine the actual values for the following items. They are used as replacement parameters
during configuration.

Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint, for example:
https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application files.

Default: <cp_root>\Enterprise\

RequireHTTPS Require HTTPS (True/False)

Default: False.

Stage 2 – Execute configuration scripts

Use the information collected in stage 1 to modify the configuration of the websites.

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Web Service configuration directory, default:

<cp_common>\Configuration\Enterprise

3. Execute:
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./Configuration_AppAuth.ps1

4. Follow the prompts.

Pre-installation steps for Single sign-on (SSO)

Configure PowerShell

1. Open a Windows PowerShell prompt.

2. Modify the execution policy:

Set-ExecutionPolicy Unrestricted

Install certificates

On each Changepoint web server, install and configure certificates for use with SSO.

Note: The worker process for IIS needs to read the private key of the Sign-in and Cookie
certificates. By default, this is the IIS_IUSRS group. The certificate installation scripts
prompt you for this information at the appropriate time.

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>\Configuration\Common

3. Execute:

./InstallChangepointCookieCertificate.ps1

4. Execute:

./InstallChangepointSigningCertificate.ps1

Installing SSO using ISAPI

Stage 1. Collect configuration parameters

Determine the actual values for the following items. They are used as replacement parameters
during configuration.
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Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint, for

example:
https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application files.

Default: <cp_root>\Enterprise\

RequireHTTPS Require HTTPS (True/False)

Default: False.

Changepoint_RSA_Cookie_

Transform

The name of the certificate that you use for Cookie

encryption.

Default: the "CN=ChangepointCookieCertificate"

Certificate Name.

Enterprise_SigningCertificate_

Name

The name of the certificate that you use for signing

messages.

Default: the "CN=ChangepointSigningCertificate"

Certificate Name.

Enterprise_SigningCertificate_

Thumbprint

The thumbprint of the certificate that you use for signing

messages.

Default:

"78794E4FF1BB0F5D9A53DC7B8C0B799A1FBC1BB5"

ISAPI_Mode The ISAPI mode

Default: NT

ISAPI_Header The header used when ISAPI_Mode is "HEADER", for

example:

blank

Stage 2. Create application

1. In IIS, under Enterprise, convert the RP-STS_ISAPI folder to an application:

• Alias name: RP-STS_ISAPI

• Physical path:

\<cp_root>\Enterprise\RP-STS_ISAPI

• Authentication: Only Windows Authentication
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• Application pool: Changepoint Application Pool

2. Add Default.aspx to the Default Documents for the application.

Stage 3. Execute configuration scripts

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>\Configuration\Enterprise

3. Execute:

./Configuration_SSO_ISAPI.ps1

4. Follow the prompts.

Installing SSO using WS-Federation – ADFS

Stage 1. Collect configuration parameters

Determine the actual values for the following items; these will be used as replacement
parameters during configuration.

Ensure that the ADFS_Server_URI is in the Intranet zone of the end-user's browser

Note: By default Changepoint is configured to automatically update the public keys that
are used to sign security tokens by using the published federation metadata document. In
ADFS this is https://ADFS_FederationServiceName/FederationMetadata/2007-
06/FederationMetadata.xml. If the ADFS server cannot be reached from the Changepoint
web server, you must manually update the configuration after running the configuration
script. For details see "Updating the public keys for Azure Active Directory manually" on
page 160.
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Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint, for example:
https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application files.

Default: <cp_root>\Enterprise\

Account The name of the account that IIS runs under.

Default: IIS_IUSRS

Changepoint_RSA_

Cookie_Transform

The name of the certificate that you use for Cookie encryption.

Default: the "CN=ChangepointCookieCertificate" Certificate

Name.

Enterprise_

SigningCertificate_

Name

The name of the certificate that you use for signingmessages.

Default: the "CN=ChangepointSigningCertificate" Certificate Name

is used.

Enterprise_

SigningCertificate_

Thumbprint

The thumbprint of the certificate that you use for signingmessages.

Default: "78794E4FF1BB0F5D9A53DC7B8C0B799A1FBC1BB5"

ADFS_

FederationServiceNam

e

Enter the Federation Service Name, for example:
FederationServiceName

ClaimType Enter the SSOClaim Type.

Default:
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/u

pn

Getting the federation service name

1. From the ADFS server, Launch ADFS 2.0 Management console.

2. From the left menu, select "ADFS 2.0".

3. From the Action pane select Edit Federation Service Properties.

4. The Federation Service Name can be found on the General tab.

Stage 2. Create application

1. In IIS, under Enterprise, convert the RP-STS_ADFS folder to an application:
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• Alias name: RP-STS_ADFS

• Physical path:

\<cp_root>\Enterprise\RP-STS_ADFS

• Authentication: Only Anonymous Authentication

• Application pool: Changepoint Application Pool

2. Add Default.aspx to the Default Documents for the application.

Stage 3. Execute configuration scripts

Using the information collected from stage 1 modify the configuration of the websites.

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>/Configuration/Enterprise

3. Execute:

./Configuration_SSO_ADFS.ps1

4. Follow the prompts.

Stage 4. Create relying party trust

1. On the ADFS server, launch the ADFS 2.0 console.

2. Select Action > Add Relying Party Trust.

3. Click Start.

4. Select Enter data about the relying party manually, then click Next.

5. in the Display name field, enter a name for the relying party trust, for example: RP-STS_
ADFS, and then click Next.

6. Select ADFS 2.0 profile, and then click Next, then Next again.

7. Select Enable support for the WS-Federation Passive protocol, and then enter the
Relying party WS-Federation Passive protocol URL.
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https://Enterprise_URI/RP-STS_ADFS/

Replace Enterprise_URI with the domain identifier for Changepoint.

8. Click Next, Next, Next, Next, then Close.

9. Add a Claim Rule for the Changepoint Relying Party.

For Changepoint, the default Claim rule name is "UPN".

10. Map the LDAP Attribute "User-Principal-Name" to Outgoing Claim Type "* UPN" or
"UPN".

Stage 5. Increase lifetime of security token

Increase the value of TokenLifetime property for the above relying party object to prevent
users from getting a popup message and having to re-launch the Changepoint session when the
security token using ADFS 2.0 expires. The default lifetime of a security token using
ADFS 2.0 is 60 minutes.

Set the default lifetime of a security token to 8 hours (480 minutes):

1. On the ADFS server, open a Windows PowerShell prompt.

2. Add the ADFS 2.0 snap-in:

Add-PSSnapin Microsoft.Adfs.PowerShell

3. Display the relying party TokenLifetime.

Get-ADFSRelyingPartyTrust -Name "relying_party"

where "relying_party" is the display name that you created, above.

4. Set the TokenLifetime value to 480 minutes:

Set-ADFSRelyingPartyTrust -Targetname "relying_party" -TokenLifetime 480

Updating the public keys for ADFS manually

Updating the public keys for ADFS manually includes the following steps:

• Getting the ADFS server token signing thumbprint

• Updating the Web.config file
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Getting the ADFS server token signing thumbprint

1. From the ADFS server, launch ADFS 2.0 Management console.

2. Select Service > Certificates, and then double-click the Token-signing certificate.

3. Select the Details tab.

4. Select the Thumbprint field.

5. To get the thumbprint value, remove all the spaces including the first space.

Updating the Web.config file

1. Edit <cp_root>\Enterprise\RP-STS_ADFS\web.config.

2. Find the ida:FederationMetadataLocation key under the <appSettings> element and clear
its value:

<add key="ida:FederationMetadataLocation" value="" />

3. Find the <issuerNameRegistry> element under <system.identityModel> and replace it
with the following:

<issuerNameRegistry

type="System.IdentityModel.Tokens.ValidatingIssuerNameRegistry,

System.IdentityModel.Tokens.ValidatingIssuerNameRegistry">

<authority name="https://ADFS_FederationServiceName/adfs/services/trust">

<keys>

<add thumbprint="ADFS_Server_Token_Signing_Thumbprint" />

</keys>

<validIssuers>

<add name="https://ADFS_FederationServiceName/adfs/services/trust" />

</validIssuers>

</authority>

</issuerNameRegistry>

Installing SSO using WS-Federation – Azure Active Directory

Stage 1. Collect configuration parameters

Determine the actual values for the following items. These will be used as replacement
parameters during configuration.

Ensure that the ADFS_Server_URI is in the Intranet zone of the end-user's browser.
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Note: By default Changepoint is configured to automatically update the public keys that
are used by Azure Active Directory to sign security tokens. These keys rollover on a 6
week schedule, but in an emergency may rollover sooner. If the Azure Active Directory
cannot be reached from the Changepoint web server, you must manually update the
configuration after running the configuration script. For details see "Updating the public
keys for Azure Active Directory manually" on page 160

Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint, for

example:

https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application files.

Default: <cp_root>\Enterprise\

Account Enter the account that IIS runs under.

Default: IIS_IUSRS

Changepoint_RSA_Cookie_

Transform

The name of the certificate that you use for Cookie

encryption.

Default: the "CN=ChangepointCookieCertificate"

Certificate Name.

Enterprise_SigningCertificate_

Name

The name of the certificate that you use for signing

messages.

Default: the "CN=ChangepointSigningCertificate"

Certificate Name is used.

Enterprise_SigningCertificate_

Thumbprint

The thumbprint of the certificate that you use for signing

messages.

Default:

"78794E4FF1BB0F5D9A53DC7B8C0B799A1FBC1BB5"
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Parameter Description

Azure_Login_URI TheWS-Federation Sign-On Endpoint, for example:
https://login.windows.net/893e9ba3-1b78-44d8-

aca9-105fab957fed/wsfed

Get this value from Stage 4 below.

ClaimType Enter the SSOClaim Type.

Default:
http://schemas.xmlsoap.org/ws/2005/05/

identity/claims/name

Stage 2. Create application

1. In IIS, under Enterprise, convert the RP-STS_ADFS folder to an application:

• Alias name: RP-STS_ADFS

• Physical path: \<cp_root>\Enterprise\RP-STS_ADFS

• Authentication: Only Anonymous Authentication

• Application pool: Changepoint Application Pool

2. Add Default.aspx to the Default Documents for the application.

Stage 3. Create relying party trust

1. Log in to the Windows Azure Management Portal at https://manage.windowsazure.com
with sufficient permissions to add an application (relying party) to the Directory.

2. From the left menu select Active Directory.

3. From the main content area select the Directory you want to configure.

4. Select Applications.

5. Click the Add button at the bottom of the page.

6. Select Add an Application my organization is developing.

• Name: Changepoint (friendly name)

• Type: Web Application and/or Web API

7. Select Single Sign-On.
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• Sign-on URL: https://Enterprise_URI/RP-STS_ADFS/

• App ID URI: https://Enterprise_URI/RP-STS_ADFS/

8. Click the Complete button.

Stage 4. Determine the WS-Federation sign-on endpoint

1. Log in to the Windows Azure Management Portal at https://manage.windowsazure.com
with sufficient permissions to view the Directory.

2. From the left menu select Active Directory.

3. From the main content area select the Directory you want to configure.

4. Select Applications.

5. Click the View Endpoints button at the bottom of the page.

6. Note the value ofWS-Federation Sign-On Endpoint.

Stage 5. Execute configuration scripts

Using the information collected from stage 1 modify the configuration of the websites.

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>\Configuration\Enterprise

3. Execute:

./Configuration_SSO_AAD.ps1

4. Follow the prompts.

5. Ensure that the WS-Federation Sign-On Endpoint value in \Changepoint\RP-STS_

ADFS\.web.config matches the value that was determined in "Stage 4. Determine the WS-
Federation sign-on endpoint" on page 159.

For example:

< add key="ida:FederationMetadataLocation" value="https://login.microsoftonline.com/

xxxxxxxxxx/federationmetadata/2007-06/federationmetadata.xml" />
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Updating the public keys for Azure Active Directory manually

Updating the public keys for ADFS manually includes the following steps:

• Getting the token signing thumbprint

• Getting the Azure Active Directory Issuer

• Updating the Web.config file

Getting the Azure Active Directory token signing thumbprint

1. Log in to the Windows Azure Management Portal at https://manage.windowsazure.com.

2. From the left menu select Active Directory.

3. From the main content area select the Directory you want to configure.

4. Select Applications.

5. Click on the View Endpoints link on the command bar.

6. From the list of single sign-on and directory endpoints, copy the Federation Metadata
Document link.

7. Open a new tab in the browser, and go to the URL that you just copied. You will see the
contents of the Federation Metadata XML document.

8. For the purposes of updating an application to use a new key, locate each
<RoleDescriptor> block, and then copy the value of each block's <X509Certificate>
element. For example:

9. Paste the value of the <X509Certificate> element into a text editor, remove trailing
whitespace, and then save the file with a .cer extension.

10. Double-click the Token-signing certificate that you just created.

11. Select the Details tab.

12. Select the Thumbprint field.

13. To get the thumbprint value, remove all the spaces including the first space.
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Getting the Azure Active Directory Issuer

1. Log in to the Windows Azure Management Portal at
https://manage.windowsazure.com

2. From the left menu select Active Directory.

3. From the main content area select the Directory you want to configure.

4. Select Applications.

5. Click on the View Endpoints link on the command bar.

6. From the list of single sign-on and directory endpoints, copy the Federation Metadata
Document link.

7. Open a new tab in the browser, and go to the URL that you just copied. You will see the
contents of the Federation Metadata XML document.

8. The EntityDescriptor element contains an EntityID attribute. The value of the EntityID
attribute represents the issuer. For example:

https://sts.windows.net/72f988bf-86f1-41af-91ab-2d7cd011db45/

Updating the Web.config file

1. Edit <cp_root>\Enterprise\RP-STS_ADFS\web.config.

2. Find the ida:FederationMetadataLocation key under the <appSettings> element and clear
its value.

<add key="ida:FederationMetadataLocation" value="" />

3. Find the <issuerNameRegistry> element under
<system.identityModel><identityConfiguration> and replace it with the following

<issuerNameRegistry

type="System.IdentityModel.Tokens.ValidatingIssuerNameRegistry,

System.IdentityModel.Tokens.ValidatingIssuerNameRegistry">

<authority name="https://sts.windows.net/b1bfcac8-b7d1-4630-8992-

39fae1c36363/AzureAD_Issuer">

<keys>

<add thumbprint="AzureAD_TokenSigning_Thumbprint" />

</keys>

<validIssuers>

<add name="AzureAD_Issuerhttps://sts.windows.net/b1bfcac8-b7d1-4630-8992-

39fae1c36363/https://ADFS_FederationServiceName/adfs/services/trust" />

</validIssuers>
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</authority>

</issuerNameRegistry>

Installing SSO using SAML – ADFS

Stage 1. Collect configuration parameters

Determine the actual values for the following items; these will be used as replacement
parameters during configuration.

Ensure that the SAML_Identity_Provider is in the Intranet zone of the end-user's browser.

Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint, for example:
https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application files.

Default: <cp_root>\Enterprise\

Changepoint_RSA_

Cookie_Transform

The name of the certificate that you use for Cookie encryption.

Default: the "CN=ChangepointCookieCertificate" Certificate Name

Enterprise_

SigningCertificate_

Name

This is the name of the certificate that you use for signingmessages.

Default: the "CN=ChangepointSigningCertificate" Certificate Name

Enterprise_

SigningCertificate_

Thumbprint

The thumbprint of the certificate that you use for signingmessages.

Default: "78794E4FF1BB0F5D9A53DC7B8C0B799A1FBC1BB5"

SAML_Identity_

Provider

The SAML Identity Provider URI, for example:
https://adfsserver/adfs/ls/

SAML_Identity_

Provider_Type

The type of the SAML Identity Provider:

ADFS20

SAML_Issuer The SAML Issuer required by the IDP.

Leave blank.
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Parameter Description

SAML_Identity_

Provider_Signing_

Key

This is the SAML Identity Provider Signing Key required by the IDP.

Leave blank.

ClaimType Enter the SSOClaim Type.

Default:
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/upn

Stage 2. Create application

1. In IIS, under Enterprise, convert the RP-STS_SAML folder to an application:

• Alias name: RP-STS_SAML

• Physical path: \<cp_root>\Enterprise\RP-STS_SAML

• Authentication: Anonymous and Forms Authentication

• Application pool: Changepoint Application Pool

2. Add Default.aspx to the Default Documents for the application.

Stage 3. Execute configuration scripts

Using the information collected from stage 1 modify the configuration of the websites

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>\Configuration\Enterprise

3. Execute:

./Configuration_SSO_SAML.ps1

4. Follow the prompts.

Stage 4. Create relying party trust

1. On the ADFS server, launch the ADFS 2.0 console
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2. Select Action > Add Relying Party Trust.

3. Click Start.

4. Select Enter data about the relying party manually, then click Next.

5. Enter a Display name, for example, RP-STS_SAML, and then click Next.

6. Select "ADFS 2.0 profile" and click Next, then Next.

7. Select Enable support for the SAML 2.0 WEBSSO protocol and enter the Relying party
SAML 2.0 SSO service URL

https://Enterprise_URI/RP-STS_SAML/

Replace Enterprise_URI with the domain identifier for Changepoint.

8. Click Next.

9. Add a Relying party trust identifier.

https://Enterprise_URI/RP-STS_SAML/

Replace Enterprise_URI with the domain identifier for Changepoint.

10. Click Next, Next, Next, then Close.

11. Add a Claim Rule for the above Changepoint Relying Party.

For Changepoint, the default Claim rule name is "UPN".

a. Select Claim rule template "Send LDAP Attributes as Claims".

b. Select Attribute store "Active Directory".

12. Map the LDAP Attribute "User-Principal-Name" to Outgoing Claim Type "UPN".

13. Specify that the Secure Hash Algorithm for this Relying Party Trust uses 'SHA-256':

a. Double-click the newly created relying party and select the Advanced tab.

b. Select the SHA-256 secure hash algorithm.

c. Click OK.

Stage 5. Increase security token lifetime

Increase the value of TokenLifetime property for the above relying party object to prevent user
from getting a popup message and having to re-launch the Changepoint session when the

164 | Changepoint 2017



Installing SSOusing SAML – ADFS

security token using ADFS 2.0 expires. The default lifetime of a security token using
ADFS 2.0 is 60 minutes.

Set the default lifetime of a security token to 8 hours (480 minutes):

1. On the ADFS server, open a Windows PowerShell prompt.

2. Add the ADFS 2.0 snap-in:

Add-PSSnapin Microsoft.Adfs.PowerShell

3. Display the relying party TokenLifetime:

Get-ADFSRelyingPartyTrust -Name "relying_party"

where "relying_party" is the display name from step 5 of "Create relying party trust" on
page 163 above.

4. Set the TokenLifetime value to 480 minutes:

Set-ADFSRelyingPartyTrust -Targetname "relying_party" -TokenLifetime 480

5. Set the signing certificate revocation check to none:

Set-ADFSRelyingPartyTrust -Targetname "relying-party"

-SigningCertificateRevocationCheck none

6. Set the encryption certificate revocation check to none:

Set-ADFSRelyingPartyTrust -Targetname "relying-party"

-EncryptionCertificateRevocationCheck none

Stage 6. Encrypt messages from identity provider (optional)

1. Determine the actual values for the following items. These will be used as replacement
parameters during configuration.

• Enterprise_EncryptingCertificate_Name – The name of the certificate that you use for
signing messages. Default: the "CN=ChangepointSigningCertificate" Certificate.

2. Edit \RP-STS_SAML\Web.config .

Replace Enterprise_EncryptingCertificate_Name with the actual value.

3. Specify the Encrypting Certificate used for this Relying Party Trust:

a. Copy ChangepointSigningCertificate.cer from the Changepoint configuration
directory to a local folder on the SAML Provider Server.
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b. Double-click the newly created relying party and select the Encryption tab.

c. Click the Browse button and select the certificate that you copied in step 3step a.

d. Click OK.

Installing SSO using SAML – PingFederate

Stage 1. Collect configuration parameters

Determine the actual values for the following items; these will be used as replacement
parameters during configuration.

Ensure that the SAML_Identity_Provider is in the Intranet zone of the end user's browser.

Parameter Description

Enterprise_URI The domain identifier that you use for Changepoint e.g.,
https://changepoint.abc.corp

Enterprise_Path The location of the Changepoint web application

files.Default:
<cp_root>\Enterprise\

Changepoint_RSA_

Cookie_Transform

The name of the certificate that you use for Cookie

encryption. Default:

"CN=ChangepointCookieCertificate"

Enterprise_Signing

Certificate_Name

The name of the certificate that you use for signing

messages.Default:

"CN=ChangepointSigningCertificate"

Enterprise_Signing

Certificate_Thumbprint

The thumbprint of the certificate that you use for signing

messages. Default:

"78794E4FF1BB0F5D9A53DC7B8C0B799A1FBC1BB5"

SAML_Identity_Provider The SAML Identity Provider URI, for

example:https://pingfederateserver/idp/SSO.saml2

SAML_Identity_Provider_

Type

The type of the SAML Identity Provider:

PingFederate.
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Parameter Description

SAML_Issuer The SAML Issuer required by the IDP

Leave blank.

SAML_Identity_Provider_

Signing_Key

This is the SAML Identity Provider Signing Key required by

the IDP.

Leave blank.

ClaimType Enter the SSOClaim Type. Default:
http://schemas.xmlsoap.org/ws/2005/05/

identity/claims/upn

Stage 2. Create application

1. In IIS, under Enterprise, convert the RP-STS_SAML folder to an application:

• Alias name: RP-STS_SAML

• Physical path: \<cp_root>\Enterprise\RP-STS_SAML

• Authentication: Anonymous and Forms Authentication

• Application pool: Changepoint Application Pool

2. Add Default.aspx to the Default Documents for the application.

Stage 3. Execute configuration scripts

Using the information collected from stage 1 modify the configuration of the websites.

1. Open a PowerShell prompt.

Note: If the server has User Account Control enabled, you must open the PowerShell
prompt using elevated administrator permissions.

2. Navigate to the Changepoint configuration directory, default:

<cp_common>\Configuration\Enterprise

3. Execute:

./Configuration_SSO_SAML.ps1

4. Follow the prompts.
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Stage 4. Create relying party trust

Create the SP Connection (relying party trust) from the PingFederate Admin Console:

1. Log in to the PingFederate Admin Console, e.g.,

https://pingfederateserver/pingfederate/app

2. In the SP Connections group, click Create New.

3. Select Do not use a template for this connection, then click Next.

4. Select Browser SSO Profiles > SAML 2.0 protocol, then click Next.

5. Select Browser SSO, then click Next, Next.

6. Enter Partner's Entity ID - https://Enterprise_URI/RP-STS_SAML/

Replace Enterprise_URI with the domain identifier that you use for Changepoint.

7. Enter Connection Name - "RP-STS_SAML" - then click Next.

8. Click Configure Browser SSO.

9. Select SP-Initiated SSO, then click Next, Next.

10. Select Configure Assertion Creation.

11. Select Standard, then click Next.

12. Select Subject Name Format:

"urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress"

then click Next.

13. SelectMap New Adapter Instance.

14. Select the Adapter Instance (this is configured by the system administrator and not
included in these instructions) e.g. "LDAPIdP", then click Next, Next.

15. Select Source - "Adapter".

16. Select Value - "username", then click Next, Done, Next, Done, Next.

Note: The value that you select depends on the Adapter that the system administrator has
set up. Typically the value is Username or Subject.

17. Select Configure Protocol Settings.
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18. Select Default - "default".

19. Select Binding - "POST".

20. Enter Endpoint URL.

https://Enterprise_URI/RP-STS_SAML/SAML/AssertionConsumerService.aspx

then click Add.

Replace Enterprise_URI with the domain identifier that you use for Changepoint.

21. Click Next.

22. Select "POST", then click Next.

23. Select Always sign the SAML Assertion, then click Next.

24. Select None, then Next, Done, Next, Done, Next.

25. Select Configure Credentials.

26. Select a certificate to digitally sign SAML messages or security tokens.

27. Select Include the certificate in the signature <KeyInfo> element.

28. Click Next, Done, Next.

29. Select Connection Status - "Active".

30. Click Save.

Stage 5. Encrypt messages from identity provider (optional)

1. Determine the actual values for the following items, which will be used as replacement
parameters during configuration:

• Enterprise_EncryptingCertificate_Name: The certificate that you use for signing
messages. Default: the "CN=ChangepointSigningCertificate" Certificate

2. Modify \RP-STS_SAML\Web.config.

Replace Enterprise_EncryptingCertificate_Name with the actual value.

3. Modify the SP Connection (Relying Party Trust) that you created earlier from the
PingFederate Admin Console.
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a. Copy ChangepointSigningCertificate.cer from the configuration directory of
Changepoint to a local folder on the SAML Provider Server.

b. Log in to the PingFederate Admin Console, e.g.,

https://pingfederateserver/pingfederate/app

c. Select the SP Connection that you created earlier.

d. Select Encryption Policy.

e. Select The entire assertion, then click Done, Done, Save.

f. Select "Configure Credentials".

g. Select "Manage Certificates".

h. Select "Import".

i. Browse to the location of the certificate that you copied above, and then click Next.

j. SelectMake this the active certificate and click Done, Done, Done, Save.

Authentication configuration scenarios

Scenario 1

IF a user is authenticated on the domain (for example, a user who is physically in the office
and logged on to the domain/network with AD credentials)

AND the IdP site (somename.yourdomain.com) is part of the user’s trusted sites in IE

AND the user’s AD account is valid/active

AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is specified in Changepoint

THEN the user will automatically be signed into Changepoint.

Scenario 2

IF a user is authenticated on the domain (for example, a user who is physically in the office
and logged on to the domain/network with AD credentials)

AND the IdP site (somename.yourdomain.com) is part of the user’s trusted sites in IE

AND the user’s AD account is valid/active
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AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is NOT specified in Changepoint

THEN the user will be presented with the native Changepoint sign-in AFTER they have been
authenticated against the IdP.

Scenario 3

IF a user is authenticated on the domain (for example, a user who is physically in the office
and logged on to the domain/network with AD credentials)

AND the IdP site (somename.yourdomain.com) is NOT part of the user’s trusted sites in IE

AND the user’s AD account is valid/active

AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is specified in Changepoint

THEN the user will be prompted with an AD login dialog box when accessing Changepoint

The user MUST authenticate via the IdP BEFORE they are signed into Changepoint.

Scenario 4

IF a user is authenticated on the domain (for example, a user who is physically in the office
and logged on to the domain/network with AD credentials)

AND the IdP site (somename.yourdomain.com) is NOT part of the user’s trusted sites in IE

AND the user’s AD account is valid/active

AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is NOT specified in Changepoint

THEN the user will be prompted with an AD login dialog box when accessing Changepoint

The user MUST authenticate via the IdP BEFORE they are presented with the native
Changepoint sign-in dialog box.

Scenario 5

IF a user is NOT authenticated on the domain (for example, a user who is on the public
internet, such as a subcontractor, an employee using a home computer, and so on)
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AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is specified in Changepoint

THEN the user will be prompted with an AD login dialog box when accessing Changepoint

The user MUST authenticate via the IdP BEFORE they are signed into Changepoint.

Scenario 6

IF a user is NOT authenticated on the domain (for example, a user who is on the public
internet, such as a subcontractor, an employee using a home computer, and so on)

AND SSO has been configured on both the Changepoint site and the IdP site

AND the user’s UPN is NOT specified in Changepoint

THEN the user will be prompted with an AD login dialog box when accessing Changepoint

The user MUST authenticate via the IdP BEFORE they are presented with the native
Changepoint sign-in dialog box.
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About configuring an archive database
For more information on archive management and archive jobs, see the Changepoint
Administration Guide.

Before entities can be archived in Changepoint, you must configure an archive database. The
archive database does not have to be on the same server as the source database; however,
you must configure the archive database by running the GenerateEmptyArcDestDB.dtsx on
the server where the source database is located. This .dtsx package only needs to be run
once.

Warning: The GenerateEmptyArcDestDB.dtsx file drops the existing archive database
(if any) and recreates it. You are responsible for backing up existing databases on the
archive server before running the .dtsx file.

The minimum recommended size for the archiving processing on the source database is the
larger of the following amounts:

• 10 GB, with an auto-growth rate of 10%

• three times the amount of data to be archived, with an auto-growth rate of 10%

This space is required for the transaction log of the Archive Aged Entities job.

Configuring an archive database

1. On the source database server, install or upgrade to 2017.

2. Copy the Data Archiving folder and its contents from the Changepoint product media:

\Changepoint\Manual Install\Data Archiving

to the following location on the source database server:

<cp_root>\Data Archiving

Note: Because this path is hard-coded in some of the required setup files, it is not
recommended that you use a different path. However, if you must use a different path,
see "Changing the default location of the data archiving folder" on page 174.

3. Update the following file with the database information for the source production server
and the destination archive server:

<cp_root>\Data Archiving\Data Archiving.ini
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For example:

[CPSQLServer]

ConnectionString=server=ServerName;database=Changepoint;uid=USERID;pwd=PASSWORD;

[ARCSQLServer]

ConnectionString=server=ServerName;database=Changepoint;uid=USERID;pwd=PASSWORD;

Note: The connection settings for generating a new archive database are not encrypted.

4. Double-click the following file:

<cp_root>\Data Archiving\GenerateEmptyArcDestDB.dtsx

The Execute Package Utility dialog opens.

5. Do the following:

a. Click the Connection Managers page.

b. Select the check boxes for the Data Archiving.ini file and the
GenerateEmptyArcDestDB.dtsx.log file.

c. Change the Connection String values for the selected files to the required path.

6. Click Execute.

On successful completion, an empty archive database is created.

7. On completion, examine the following log file for any errors:

<cp_root>\Data Archiving\GenerateEmptyArcDestDB.dtsx.log

Common errors are incorrect settings in the Data Archiving.ini file, and insufficient space.

8. Import the SQL code. For more information, see Creating a new archive database after
upgrading.

For troubleshooting issues related to archiving, see "Archive database troubleshooting" on
page 243.

Changing the default location of the data archiving folder

It is recommended that you use the default path (<cp_root>\Data Archiving) as the path for
the Data Archiving folder on the source database server. However, if you must use a different
path, the following are the changes that need to be made on the source database server to
configure the path.
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1. In SQL Server Management Studio, connect to the source database server.

2. In the Object Explorer tree view, expand:

ServerName > SQL Server Agent > Jobs

3. Right-click the Archive Aged Entities job and select Properties.

The Job Properties - Archive Aged Entities dialog displays.

4. Select the Steps page and double-click the Delete DTSX Log step.

The Job Step Properties - Delete DTSX Log dialog displays.

5. In the Command field on the General page, replace the argument of the DEL command
with the required path and click OK.

6. Double-click the Run Archive DTSX step.

The Job Step Properties - Run Archive DTSX dialog displays.

7. On the General page, do the following:

a. Click the General tab.

b. In the Package field, select Data Archiving.dtsx.

8. Do the following:

a. Click the Data sources tab.

b. Select the check boxes for the Data Archive.dtsx.log and Data Archive.ini files.

c. Change the Connection String values for the selected files to the required path.

d. Click OK.

9. Click OK.

Setting up websites on the archive database
You can set up new archive websites or upgrade existing archive websites to point to the
archive database and run reports from there. Use the InstallShield Wizard and when prompted
for details, enter the details for the archive websites instead of the standard Changepoint
websites.
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After running the InstallShield Wizard, use the Login Settings utility to configure the
connection settings to the archive database, using the following configuration files:

• Global.asa for the archive Changepoint website.

• Global.asa for the archive Changepoint Administration website.

• Web.config file for the archive Report Designer website

• WebAPI\web.config file

• WebSocket\web.config file
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Installing the Changepoint online help
You install the English online help from the Changepoint product media. The German and
French versions of the online help are on separate media. For more information on installing
the German and French online help, contact your client services representative or client
manager.

The version of help (PSA or PPM) that appears when launched from the interface is
determined by the mode that was selected when the websites were installed. You must
install the online help on each Changepoint instance.

1. On the Changepoint product media, run:

\Changepoint\Help\Online Help\setup.exe

2. Click Next, accept the license terms, then click Next again.

The Select Features screen displays.

3. Select the check boxes for the type of online help to install.

4. Click Next.

5. Select the folders for the Changepoint applications (not the Help subfolder) that you are
installing. Client Portal help is installed with the Changepoint help.

6. Click Next.

When the installation is complete, the InstallShield Wizard Complete screen displays.

7. Click Finish.

8. If you have multiple Changepoint websites, install the help on the remaining websites.

9. Confirm that the online help launches by signing in to each of the websites and selecting
the Help menu option.

Once the online help is installed, it becomes part of the Changepoint website and is removed
only if the website is uninstalled.
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Installing Changepoint eLearning
This section applies to Changepoint only. You must install the eLearning on each Changepoint
website instance.

The eLearning is on its own media, and the installation instructions are in the eLearning
release notes for the current release.

Once the eLearning is installed, it becomes part of the Changepoint website and is removed
only if the website is uninstalled.

Setting up the Changepoint Mobile app
The topic covers the setup required to enable users to use the Changepoint Mobile app.

1. Obtain the license for the Access Mobile Application (AMA) security feature, which
includes the values for the keys:

• NotificationProvider.Key1

• NotificationProvider.Key2

2. Uncomment the keys and add the values for them into the following configuration files:

• Enterprise\WebApi\web.config

• Changepoint\Changepoint Mail Service\CPMail.exe.config

3. Set up Changepoint and the Changepoint Mail Service to communicate with Amazon Web
Services over https (port 443). The SNS access point for Amazon is:

https://sns.us-west-2.amazonaws.com

4. Advise users of the following information:

• Changepoint Mobile app is available at the online app stores.

• Changepoint URL or domain, and the user ID and password that are required to sign in
to the app.

• Changepoint functionality that is available in the app.

Note: The Changepoint Mobile app is designed to be intuitive and easy to use, and it
supports a subset of the functionality of the desktop Changepoint application. Therefore
there is no end user documentation for the app.
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Setting up mobile access to Changepoint
Note: This topic refers to setting up the use of mobile devices to access the Changepoint
website. For information about setting up the Changepoint mobile app, see "Setting up the
Changepoint Mobile app" on the previous page.

The Changepoint start page automatically detects mobile browsers and redirects them to the
mobile login page.

For information on supported mobile devices, see the Changepoint Product Architecture and
Technology Matrix.

Review the default period of inactivity for the Session Clean Up scheduled job, and change if
necessary. For information on the Session Clean Up scheduled job, see "Session Clean Up
scheduled job" on page 98.

For information on configuration settings for mobile access, see "Mobile access settings" on
page 226.

Setting up a Client Portal website
If enhanced session management has been enabled in Changepoint Administration, you must
create a separate Client Portal website.

1. Use the InstallShield Wizard to create a new Changepoint website on the target server.

• For information on using the wizard, see "Installing Changepoint using the installer" on
page 23.

• If you already have a Changepoint website on this server, see "Installing multiple
Changepoint instances" on page 24.

2. Do not install SSO, but allow the website to default to application authentication.

3. Use the Login Settings utility to configure the database connection settings. For more
information, see "About configuring database connection settings" on page 65.

4. Remove the following login file from the root level of the website:

fclogin.aspx

5. In IIS, change the default document to the following login file, which is located at the root
level of the website:

fcelogin.asp
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6. In Changepoint Administration, do the following:

a. Define the Client Portal login URL that will be included in the email notifications
(General > Email Integration).

b. Enable the standard Client Portal email templates (General > Email Templates.)

c. Set up Client Portal (Client Portal Management).

7. To set up the Client Portal website for SSL, see "About setting up Changepoint websites
for SSL" on page 48.

Setting up a survey response website
A survey response website is required to allow clients, customers and internal resources to
access the Survey system and respond to surveys.

1. Use the InstallShield Wizard to create a new Changepoint website on the target server.

• For information on using the wizard, see "Installing Changepoint using the installer" on
page 23.

• If you already have a Changepoint website on this server, see "Installing multiple
Changepoint instances" on page 24.

2. Do not install SSO: allow the website to default to application authentication.

3. Use the Login Settings utility to configure the database connection settings. For more
information, see "About configuring database connection settings" on page 65

4. Remove the following login files from the root level of the new Changepoint website:

fclogin.aspx

fcelogin.asp

5. In IIS, change the default document for the new Changepoint website to the following file,
which is located at the root level of the new Changepoint website:

sredir.asp

6. In Changepoint Administration, define the URL that will be included in the Changepoint
email notifications to survey recipients (General > Email Integration).

7. To set up the Survey Response website for SSL, see "About setting up Changepoint
websites for SSL" on page 48.
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About Microsoft Exchange/Outlook synchronization
The following calendar synchronization options are available:

• Server-side (Exchange) – Server-side synchronization is handled through the Changepoint
Exchange Synchronization Service, and supports the synchronization of calendar entries
only. Each user must select one synchronization method in the Preferences view of
Changepoint. No client-side installation is required.

• Client-side (Outlook) – The Changepoint Outlook Tools must be installed on the users’
desktops. For more information, see the User Basics User Guide or the Changepoint online
help. No server-side installation is required.

Changepoint supports running a server-side synchronization and client-side synchronization
deployment in one environment. Each user must select one synchronization method in their
Changepoint preferences.

Users are discouraged from switching back and forth between the syncronization methods,
which can result in duplicate entries. During a switch, the ability to completely restore data is
dependent on the synchronization direction selected in the Changepoint Exchange
Synchronization service configuration file. The synchronization direction is controlled at the
server level and cannot be directly controlled by the end user.

If a user changes from Outlook to Exchange synchronization, the resynchronization repopulates
the cleared Changepoint calendar entries based on the Exchange data. If the user changes from
Exchange to Outlook synchronization, the cleared Changepoint calendar entries are
repopulated based on the Outlook data that is in the date range specified when the batch
synchronization is run from Outlook.

Synchronization direction

Calendar synchronization is either one-way or two-way depending on whether the process is
real-time or batch. Calendar synchronization requires that the calendar items in Outlook match
the General Calendar Synchronization Options settings (Daily Start Time, Daily End Time and
Time Zone) in the Preferences view in Changepoint.

About Microsoft Project Desktop integration

No server-side configuration is required. Users must install the Changepoint Microsoft Project
(MSP) COM Add-in on their desktops in order to link a Changepoint project to MSP through
the MSP interface. For more information, see the Changepoint User Basics User Guide or
online help.
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Configuring batch printing
You can create different print directories and use different printers for different workgroups by
using the htmlprint utility. All invoices, cross charges, and credit notes generated by the batch
printing report will be saved to the appropriate directory according to the workgroup of the
resource who runs the report.

Note: The BatchPrint directory is automatically installed if you selected the Complete
option when installing Changepoint.

1. If you upgraded Changepoint, delete the BatchPrint directory.

2. Install the BatchPrint directory on the web server by doing one of the following:

• Use the Changepoint installer to install BatchPrint (Custom > Select Features page >
Batch Print check box).

• Copy the BatchPrint directory and its contents from the Changepoint product media:

\Changepoint\Manual Install\Components\BatchPrint

3. On the web server, run:

<cp_root>\BatchPrint\htmlprint.exe

4. Review the license, and then close the Bersoft HTMLPrint window.

The htmlprint.ini file is added to the BatchPrint directory.

5. Open the htmlprint.ini file:

a. Record the information in the [Printers] section, for example:

[Printers]

0=\\printserver\printerA

1=\\printserver\printerB

2=local printer

b. Close the file.

6. Configure the database connection settings for the Batch Print configuration file
(PrintInvoices.exe.config) using the Login Settings utility (Login Settings.exe).

For more information, see "Configuring database connection settings" on page 65.

7. Open the PrintInvoices.exe.config file in the BatchPrint directory, and locate the
following entry.
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<add key="PrintServername" value=""/>

In the value attribute, insert the printer name (from the [Printers] section) for the printer
that you want to use as the default printer for batch printing. For example:

<add key="PrintServername" value="\\printerserver\printerA"/>

8. To set up different print directories and use different printers for different workgroups:

a. Under the BatchPrint directory, create subdirectories for the workgroups. Do not use
spaces in the subdirectory names. For example:

<cp_root>\BatchPrint\Finance

<cp_root>\BatchPrint\Sales

<cp_root>\BatchPrint\Marketing

b. For each workgroup subdirectory, create a utility subdirectory for the batch print
files for the workgroup. For example:

<cp_root>\BatchPrint\Finance\utility

<cp_root>\BatchPrint\Sales\utility

<cp_root>\BatchPrint\Marketing\utility

c. Set the permissions on the workgroup subdirectories to allow new files to be added and
existing files to be deleted.

d. Copy the files from the BatchPrint directory into each of the utility subdirectories.

e. Open the PrintInvoices.exe.config file in each utility subdirectory. Set the
PrintServername key to the name of the printer (from the htmlprint.ini file) for the
workgroup. For example:

<add key="PrintServername" value="\\printerserver\printerB"/>

f. Save the file.

9. In Changepoint Administration, set up batch printing:

a. Assign the BatchPrint directory to workgroups.

b. Set up access to the Batch Printing Report.

About installing Changepoint APIs

For information about installing the COM API and Web Services API, see the Changepoint
API Installation Guide.
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Installing the connection string decryption utility

1. Uninstall any previous versions of the utility using Windows Control Panel.

2. Run the following file from the 2017 product media:

\Changepoint\Utilities\Connection String Decryption\setup.exe

3. Follow the prompts.

4. In the Setup Status screen, click Finish.

The installation location now contains:

Changepoint.CommonServices.Crypto.dll

CPPubUtility.dll

Uninstalling the Connection String Decryption Utility

To uninstall the connection string decryption utility, use Windows Control Panel.

Browser settings for end users

Ensure that users configure their web browers as follows:

• Browser popup settings – Browsers must be set to allow pop-ups from the Changepoint
website URLs.

• Internet Explorer Compatibility mode – compatability mode in Internet Explorer must be
disabled by clearing the Display intranet sites in Compatibility View check box.

• Browser cache – users must clear their browser cache before logging into an upgraded
version of Changepoint. If the browser has the option to preserve data from websites that
have been added to favorites, ensure that the Favorites website data is cleared.
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About upgrading

You can upgrade to 2017 from the following Changepoint versions only:

• Changepoint 2014

• Changepoint 2014 Service Pack 1

• Changepoint 2014 Service Pack 2

Note: Unless otherwise stated, information in this chapter concerning Changepoint
websites applies to websites that were set up for mobile access, Client Portal, and
Survey Response.

Requirements for upgrading

For all software, hardware, skills and experience requirements, see "Installation
Requirements and Preparation" on page 13.

Obtain the latest patches

Check the 2017 Release Notes and Patches team folder, which is accessible through the
Client Portal, for general patches and upgrade patches that have been posted for this release.

Warning: You must apply pre-upgrade patches before doing the upgrade, otherwise the
upgrade will not be successful.

Preparing for the upgrade

Review customizations and product extensions

Upgrading can affect your customizations. Review your customizations prior to upgrading
and test them after upgrading.

If you are unsure whether any of the following information applies to you, contact your
Changepoint Canada ULC client services representative or client manager to confirm before
attempting the upgrade.

For information, see "Identifying nonstandard database objects" on page 189.

Database customizations

During an upgrade, all custom code is removed from the database, which affects existing
customizations (reports, pages, triggers, stored procedures, etc.), extensions, and
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accelerators.

Therefore, you must review and edit all custom code to account for changes in table names
and any use of user-defined data types. If you use the accelerator databases, there are custom
stored procedures and views that must be reviewed and re-applied after the upgrade.

Upgrading Intelligent Forms

The standard form templates have been revised for this release. The updated forms are on the
Changepoint media in the Changepoint\Intelligent Forms\Forms folder. You can import
these form templates using Infiniti Manage.

Warning: If you upgrading from Changepoint 2014 Service Pack 2 with the Intelligent
Forms feature installed, importing the Changepoint 2017 form templates will replace the
existing templates.

Client-side SQL Server Database Driver update

Microsoft has reported that there are vulnerabilities in the communication protocol that uses
SSL on earlier versions of Transport Layer Security (TLS) between the SQL Server client and
SQL Server database engine. Microsoft recommends upgrading to TLS 1.2 for secure com-
munication. For more information see Article ID: 3135244 on the Microsoft website.

In Changepoint 2017, the limited areas of Changepoint that used the Microsoft OLE DB Pro-
vider for SQL Server (SQLOLEDB) as the client-side driver have been modified to use the
SQL Server Native Client to provide support for TLS 1.2.

After upgrading Changepoint, you must reset the SQL Server connection string using the Login
Setting utility on all Changepoint web server instances for the global.asa file for Enterprise
and Enterprise Report Server. Failure to make this change will result in users not being able to
log into Changepoint.

1. Perform the following steps on each Changepoint web server instances:

a. Start the Login Settings utility. The utility is located in the <cp_
common>\LoginSettings folder.

b. From the Coannection Settings list, select "Enterprise".

c. In the File Location field, browse to the Global.asa file for the Changepoint website.

d. Enter USERID and PASSWORD as the user ID and password of the account for
database access, then click OK.
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e. In the Connection Settings section, specify the server name, database name, and time-
out information that was used in the previous connection string.

f. In the User ID and Password fields, enter the user ID and password for the SQL
account for accessing the Changepoint database.

g. To verify the connection string, click Test.

h. Click Save.

i. If your environment includes a Report Server, repeat the steps 2 to 8 for the
"Enterprise Report Server" as the Connection Settings.

j. Restart the Internet Information Services (IIS) to complete the process.

CPExtended database

CPExtended is a secondary database introduced in Changepoint 2014 SP2 that resides on the
same server as the main Changepoint database. CPExtended provides storage for logging error
messages and performance data as well as background job scheduling and management.
CPExtended is installed and configured automatically when you upgrade.

The new RESTful API is automatically installed and configured on the Changepoint website at
<cp_root>\Changepoint\WebAPI. If you move or change the Changepoint database, then you
must run the Login Settings utility using the RESTful API option to configure the database
connection settings for the RESTful API accordingly.

If you plan to restore your database in a different environment, see the porting instructions in
"Porting the Changepoint database" on page 207.

Website customizations

During an upgrade, the existing Changepoint websites are completely removed and new
websites are created.

You must reapply all custom pages or files that were added to the Changepoint, Report
Designer or Changepoint Administration folders after the upgrade has completed.

The configuration settings for all websites are reset to the default values, including websites
that were set up for mobile access, Client Portal, and Survey Response. Most database
connection settings are preserved.

• If you deploy Changepoint Product Extensions (any code that has been added, modified or
customized in any way), it is strongly recommended that you review the list of files in the
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Differences document for the upgrade path to assess whether there is any impact. If it
appears that any of the code associated with a product extension is at risk, contact your
client services representative or client manager before upgrading. Failure to do so may
result in the files being overwritten or deleted, and the extended functionality failing.

• If any custom pages use style sheets, a best practice is to add type_9pt.css as the first
style sheet and update existing style sheets from those with "E_" prefixes to "DEF_"
prefixes.

Assess the impact on scheduled jobs

The connections settings for the scheduled job executables are not preserved.

Upgrade to a test environment first

It is strongly recommended that you upgrade your production Changepoint database and
websites in a test environment before upgrading the production environment. If any errors
occur, report them to Changepoint Canada ULC immediately. Do not create any test
environments on your production environment.

To upgrade the Changepoint database in a test environment, back up the database and full text
catalogs on the production environment, and then restore them on the test environment.

If the test environment and production environment use the same version and edition of SQL
Server, see "Creating a test and training environment on the same server" on page 219.

If the test environment and production environment use different versions or editions of SQL
Server, see "Porting the Changepoint database" on page 207.

Database considerations

Upgrade and certification is performed using SIMPLE recovery model in the Changepoint
SQL database. For more information refer to Using Recovery Models in SQL Books Online.

Optional components and features

API

If you use the API, you must upgrade to the 2017 version of the API.

Manual use of Login Settings utility

If you run the Login Settings utility manually, be sure to use the 2017 version of the utility.
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Microsoft Dynamics GP Toolkit

If you already have the Microsoft Dynamics GP Toolkit installed, you must reinstall it after
you upgrade.

Identifying nonstandard database objects

You can create a database inventory report that identifies all nonstandard database objects that
exist in your current Changepoint database. Nonstandard database objects include all database
objects (table, view, stored procedure, functions, trigger, index, primary and foreign key
constraints) that were created by customizations, accelerators, and third-party integrations.

The database inventory report allows you to catalog existing customizations in the current
database, identify the affected customizations, and plan the migration work for the upgrade.

Note: The database inventory report does not replace any change tracking procedures or
processes that you may already have in place to track customizations, accelerators, or
third-party integrations.

Creating the database inventory report

To create the database inventory report, execute the following query against the Changepoint
database:

SELECT * FROM CPObjectsModified

The result of the query includes the following:

• custom database objects show as Added.

• standard objects that no longer exist show as Deleted.

• if a customization has been made directly to a standard database object, the object is not
identified as a customized object in the report.

• the report does not report on all CHECK_CONSTRAINTS.

Upgrade overview
There are two ways to upgrade the Changepoint database and websites:

• Use the installer.

You can upgrade the database, website files, or both. For instructions, see "Upgrading
Changepoint using the installer" on page 192.

• Upgrade manually (database only)
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You can upgrade the database manually and then use the installer to update the websites.
For instructions, see "Upgrading the database manually" on page 195.

After you upgrade the database and websites, you can upgrade the other components that you
use. For more information, see the following:

• "Installing a Changepoint Windows service" on page 53

• "About Changepoint scheduled jobs" on page 83

• "About configuring an archive database" on page 173

• "About Changepoint and SSO" on page 147

• "Installing and Configuring Other Optional Applications, Features, and Services" on page
177

Pre-upgrade steps

30 to 35 days before upgrading

On the Changepoint web server, change the content expiry of the Changepoint folders to
expire in 1 day:

\images

\css

\Help

\External\Help

\External\images

\Js

Changing content expiry settings and enabling caching of static files

You set content expiry in IIS Manager by changing the expiry options of the HTTP Response
Headers for the Enterprise websites.

1. In IIS Manager, expand servername > Sites > Enterprise.

2. Select the folder.

3. In the Home screen, double-click the HTTP Response Headers icon.

4. Select Actions > Set Common Headers.

5. Change the settings as required.

6. Click OK.
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One to two weeks before upgrading

Send an email message to users to notify them about the upgrade.

One day before upgrading

On the Changepoint web server, change the content expiry of the Changepoint folders to expire
immediately.

Immediately before upgrading

1. Print any spooled files in the BatchPrint folders.

2. Apply the applicable pre-upgrade patches according to the instructions in the patch release
notes.

3. In Changepoint Administration, lock Changepoint.

4. On the web server:

a. Back up the Changepoint files.

b. Disable IIS caching. For more information on enabling and disabling caching, see
"Changing content expiry settings and enabling caching of static files" on page 190.

c. Stop the Changepoint websites that you are upgrading.

Warning: The site names and ports that you specify during the upgrade must be unique in
IIS. If you have additional sites using the same name and/or port (in addition to the one you
are upgrading), revise or delete them in IIS before continuing. This is true even if the
additional sites are stopped or paused.

5. On the database server:

a. Stop all scheduled jobs from running during the upgrade.

b. Back up the database just before performing the upgrade.

c. Back up the Cognos content store database.

d. Back up the InfinitiDB database.

e. Drop custom full-text catalogs before the upgrade.

f. Run any database pre-upgrade scripts.

g. Apply any pre-upgrade patches.
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h. Ensure that the autogrowth property on the primary file group (which contains
Changepoint.mdf) is set to “By 100 MB, unrestricted growth” and the free space on
the disk drive of the database server is no less than 5 GB.

i. If required, port the database.

6. Create a backup copy of the Global.asa file and the Web.config files in the
Enterprise folder and WebAPI folder to use as a reference when reconfiguring after the
upgrade. The upgrade resets some of the configuration settings in the Global.asa and
Web.config files to the default values.

7. Copy the Web.config files under each folder under <cp_root>\Intelligent Forms\Websites,
as applicable:

• ChangepointDataService

• InfinitiLaunch

• IntelledoxScheduler\IntelledoxScheduler.exe.config

• Manage

• Produce

8. Create a backup copy of the configuration files for the Changepoint Windows Services.

9. If you use the Salesforce.com integration:

a. Create a backup copy of the configuration files:

• ExternalEndPoint\Web.config
• ExternalEndPoint\Configuration\Adapter.xml

b. On the SFDC Integration Toolkit media, copy the contents of the
Salesforce\ExternalEndPoint folder.

c. Paste the contents under the ExternalEndpoint folder.

d. Move the backup copies of the configuration files back to the ExternalEndpoint folder.

Upgrading Changepoint using the installer
If you are upgrading the database and websites separately, it is best to upgrade the database
first because it is easier to restore the database than to roll back the website files.
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When you upgrade using the installer, the database connection settings for only the following
components are preserved under the following conditions:

• Report Designer and Report DSN, provided that you specify the existing locations of the
websites

Note: To upgrade multiple instances, you can run the installer multiple times.

1. Follow the instructions in "Pre-upgrade steps" on page 190.

2. Copy the contents of the Changepoint product media to a location on the server.

3. Run the setup.exe file from the server location.

4. If the Existing Installed Instances Detected screen appears, selectMaintain or upgrade
the instance of this application selected below.

5. If the database to be upgraded was not detected because it was installed manually, or if
you ported the database before upgrading:

a. Select Install a new instance of this application, then select the language on the
Choose Setup Language screen.

b. Follow the prompts, then select Custom setup type.

c. On the Select Features screen, select the following options:

• Scheduled Jobs
• Upgrade Changepoint Database
• other options as required

Note: If you ported the database before upgrading, and the websites are on the same
server as the database, you must run the installation program again, and selectWebsites
Only the second time, to upgrade the websites.

6. Follow the prompts , then select Upgrade Changepoint database and select Install
Infiniti database for Intelligent Forms when applicable.

7. If Install Infiniti database is selected, enter the Changepoint URL on the Changepoint
URL information screen.

Note: This Enterprise URL entry assists with Infiniti integration, and sets values for the
Changepoint Infiniti Connector.
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8. In the SQL Connection Setting screen, enter the User ID and Password that is used by
the Changepoint web application to communicate with the Changepoint database.

9. In the Database Configuration screens, complete the fields as follows:

In the Database Server list, select the SQL Server name where the database is installed.

d. In the Login ID field, enter the SQL server sa login.

e. In the Password field, enter the SQL server sa password.

10. Enter the Changepoint Database name.

11. Enter the Intelligent Forms Database name, when the feature is selected. Default name is
InfinitiDB.

12. Click Next, and follow the prompts.

13. When the upgrade is complete, click Finish.

14. Complete the post-upgrade instructions.

See "After upgrading" on page 205.

15. Install and configure Redis, if required. If your Changepoint environment consists of a
simple web instance on a web server, then Redis is configured automatically by the
installer.

Upgrading the website using the installer
1. Copy the contents of the Changepoint product media to a location on the server.

2. Run the setup.exe file from the server location.

3. If the Existing Installed Instances Detected screen appears, selectMaintain or update
the instance of this application selected below:

4. Click Next, and then follow the prompts.

5. On the Select Features screen, select the features to be installed on the web server,
including the Login Settings feature.

6. Select Install Infiniti web application for Intelligent Forms feature when applicable.

7. On the Choose Destination Location screen, browse the folder where Changepoint
Enterprise and Report Designer are installed.

194 | Changepoint 2017



Upgrading the databasemanually

8. When applicable, select the destination location for Intelligent Forms. Default path is <cp_
root>\Intelligent Forms\Websites.

9. When applicable, select the destination location where the Changepoint Web Services API
is installed. The API is mandatory for Intelligent Forms. Default path is <cp_root>\API.

10. Click Next.

11. On the Choose Destination Location screen, select folder where the Redis cache service
is installed.

12. In the Create the Intelligent Forms Application Pool screen, enter the Application Pool
name for Intelligent Forms. Default name is CPInfiniti.

13. On the Changepoint URL information screen, enter the Changepoint URL.

14. On the SQL Connection Setting screen, specify the SQL user ID and password that will
be used by the Changepoint web application to communicate with the Changepoint
database.

15. Click Next and follow the prompts to complete the install.

16. Launch LoginSetttings.exe to configure the database connection strings. See the list in
"Installing Changepoint using the installer" on page 23.

Upgrading the database manually
It is important to perform the procedures in this section in the following order.

Note: There is no manual option for installing the InfinitiDB. To install or upgrade the
InfininitDB, you must use the Changepoint installer.

1. Follow the pre-upgrade instructions described in "Pre-upgrade steps" on page 190.

2. Copy the contents of the following folder from the Changepoint product media to a location
on the database server.

\Changepoint\Manual Install\Upgrade\

3. "Importing the database migration file" on page 195.

Importing the database migration file

1. Run the SQL import utility:

<cp_root>\Upgrade\SQLImport.exe
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Warning: You must use the SQL import utility from the new release version of
Changepoint.

The Encrypted SQL Import Utility dialog opens.

2. In the Select the Migration file to import field, select:

Changepoint.DatabaseServices.DBMigrations.dll

3. Complete the following fields:

a. In the SQL Server field, enter the name of the SQL server.

b. In the Database field, enter the name of your Changepoint database.

c. In the Login name field, enter the user ID for the SQL administrator sa account.

d. In the Password field, enter the password for the SQL administrator sa account.

4. Click Start Update.

5. Click OK to confirm.

6. Review the Changepoint.DatabaseServices.DBMigrations.log file to confirm that the
upgrade completed successfully..

Completing the upgrade on the database server
1. Check the log file for errors:

<cp_root>\InstallLog\CPInstaller.log

2. Confirm that the VersionHistory table contains the following entry:

Upgrading Changepoint database with migration package 18.00.118.000 completed

3. Apply the applicable patches. Patches are available in the 2017 Release Notes and
Patches team folders.

4. Restore and test customizations (.asp pages, custom SQL code, accelerators, and
extensions). If you started with an accelerator database, re-apply the custom views and
stored procedures.

5. To optimize performance, follow the recommendations in "Changepoint performance
guidelines" on page 211.
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6. Adjust the size of the Changepoint and tempdb databases back to the limits and settings
according to your internal administration policies. The size of the databases may have
increased due to the processing done during the upgrade.

7. Review the scheduled job settings.

8. Run the following scheduled jobs:

a. Reindex and Update Statistics daily

b. Chained scheduled jobs by starting the Update Time Rate job. Ensure that Resource
Demand Calculation completes successfully.

Note: It is recommended that you run the scheduled jobs immediately after upgrading, and
before end users sign in. For more information about scheduled jobs, see the Changepoint
Installation Guide.

Tip: The chained scheduled jobs can take a long time to run. Record the duration of the job
in the test environment so that you can plan for the initial scheduled job run on the
production database.

9. Recreate the custom full-text catalogs.

10. Restart the database server.

Completing the upgrade on the web servers
1. Apply the applicable patches.

2. Restore and test customizations (.asp pages, custom SQL code, accelerators, and
extensions). Reapply application pool customizations to the new application pools.

3. Configure the settings for token authentication as follows:

a. Open the Enterprise\Web.config file.

b. Replace the default value of the WebApiSecret setting with a unique string of UTF-8
characters with a recommended size of 64 bytes. For example, you can use any
combination of 64 single byte characters.

c. Open the Enterprise\WebAPI\Web.config file

d. Replace the value of WebApiSecret with the same unique string used above.
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e. In a load balanced environment, ensure that you use the same WebAPISecret value
within the environment.

Note: For security reasons, it is strongly recommended that you use a different
WebAPISecret value for each Changepoint instance that you deploy.

4. On each web server, do the following:

a. Start the Login Settings utility (cp_common>\LoginSettings).

b. From the Connection Settings list, select "Enterprise".

c. In the File Location field, browse to the Global.asa file for the website.

d. For the user ID and password of the account for database access, enter USERID and
PASSWORD, and then click OK.

e. In the Connection Settings section, specify the server name, database name, and
time-out information that was used in the connection string before the upgrade.

f. In the User ID and Password fields, enter the user ID and password for the SQL
account for Changepoint applications to access the database.

g. To verify the connection string, click Test.

h. Click Save.

i. If your environment includes a Report Server, repeat this procedure for the "Enterprise
Report Server" connection string.

5. Configure the database connection settings for Intelligent Forms.

6. To optimize performance, follow the recommendations in "Changepoint performance
guidelines" on page 211.

7. After upgrading, most of the configuration settings in the Global.asa and Web.config files
are reset to their default values. Change the defaults if required.

8. Restart the Changepoint website, sign into Changepoint Administration, and perform these
initial checks:

• If you purchased additional licenses, import the licenses (Tools > License
Management).
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• Assign the new security features if required. See the “Assigning new security
features” section on page 109.

• Check the server integration settings (General > Server Integration).

• Set the password complexity rules for your organization (Resources > Sign in and
Passsword Validation).

9. Restart all websites. To check connectivity, sign in to each website.

10. Application authentication is enabled on the Changepoint websites by default. For
information on changing the default authentication, see "About setting up Changepoint
websites for SSL" on page 48.

11. Restore the content expiry settings of the Changepoint folders to the values before the
upgrade. For more information, see "Changing content expiry settings and enabling caching
of static files" on page 190.

12. Enable IIS caching of static files.

13. Restart IIS.

About upgrading the archive database and websites
If you have an archive database and websites, follow the same procedure as for upgrading the
Changepoint database and websites. When prompted, substitute the details for the archive
database and websites in place of the Changepoint database and websites.

Note: The archive environment must always be at the same patch level as the production
environment, otherwise the Archive Aged Entities scheduled job might fail.

1. Upgrade the archive database and websites.

2. Copy all files except the Data Archiving.ini file from the following folder on the
Changepoint media:

\Changepoint\Manual Install\Data Archiving

Note: The Data Archiving.ini file contains the current configuration settings.

3. Paste the files into the Data Archiving folder on the archive environment.

Upgrading the archive database and websites

If you have an archive database and websites, follow the same procedure as for upgrading the
Changepoint database and websites. When prompted, substitute the details for the archive
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database and websites in place of the Changepoint database and websites.

Note: The archive environment must always be at the same patch level as the production
environment, otherwise the Archive scheduled jobs might fail.

1. Upgrade the archive database and websites.

2. Copy all files except the Data Archiving.ini file from the following folder on the
Changepoint media:

\Changepoint\Manual Install\Data Archiving

Note: The Data Archiving.ini file contains the current configuration settings.

3. Paste the files into the Data Archiving folder on the archive environment.

Configuring the archive database

If you have a website set up to access the archive database, execute the following commands
against the archiving database:

exec DBM_SetupCPTempDB

exec DBM_SetupCPExtended

exec DBM_EnableSqlDependency (with the user used in the Web.config files)

Upgrading the archive database manually

1. Follow the same procedures as for upgrading a Changepoint database to upgrade the
archiving database.

2. Run the Login Settings utility for the upgraded archive websites to connect them to the
upgraded archive database. For more information, see "Configuring database connection
settings" on page 65.

Upgrading Cognos BI
You can upgrade Cognos BI from the following versions:

• Changepoint 2014

• Changepoint 2014 SP1

• Changepoint 2014 SP2

Upgrading includes the following steps:

Note: Before you upgrade Cognos BI, ensure thatChangepoint has been upgraded.
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Note: All Cognos BI configuration is preserved for both the Cognos AppTier and
Gateway.

1. Backing up the content store database. The recommended method for backing up a content
store database is to create a deployment archive by using IBM Cognos Administration. For
more information, see Creating a deployment archive on the IBM Knowledge Center
website

2. [Upgrade from Changepoint 2014 or Changepoint 2014 SP1 only] Uninstalling the previous
version of Cognos BI. For more information, see the "Uninstalling Cognos BI" section on
page 201.

3. Installing the current version. Perform the following steps:

• "Stage 2. Installing the Cognos App Tier" on page 110.

• "Stage 3. Configuring the Cognos App Tier" on page 111

• "Stage 4. Installing the Cognos gateway" on page 114

• "Stage 5. Configuring Changepoint server integration for Cognos BI " on page 115

• "Stage 6. Assigning Changepoint security features for access to Cognos functionality"
on page 115

4. Upgrade the Sync Utility and import the new base data model. For more information, see
"About the Changepoint-Cognos Sync Utility " on page 120.

5. Restart the Cognos App Tier server.

Uninstalling Cognos BI

You must uninstall Cognos BI from each of the locations where it has been installed:

• App Tier server

• Cognos Gateway on each Changepoint web server

• Sync Utility client workstation

1. On each of the servers, go to the following folder:

C:\Program Files\ibm\cognos\c10\uninstall

2. Uninstall Cognos BI by double-clicking:

Uninstall IBM Cognos.exe
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3. Delete the Cognos IBM directory:

C:\Program Files\IBM

About upgrading Intelligent Forms
The standard form templates have been revised for Changepoint 2017. The updated forms are
on the Changepoint media in the Changepoint\Intelligent Forms\Forms folder. You can
import these form templates using Infiniti Manage.

Warning: If you upgrading from Changepoint 2014 Service Pack 2 with the Intelligent
Forms feature installed, importing the Changepoint 2017 form templates will replace the
existing templates.

Previous versions of forms

The standard form templates are based on previous versions of the forms.  Compare your
existing form project names and project IDs with the names and IDs of the standard form
templates in the following table carefully. If any existing form projects have the same name
and project ID as a standard form template, do one of the following:

To keep an existing form project

1. Open the project in Infiniti Manage (Design App).

2. Use Save As to save the project with a different name, which generates a new project ID.

3. Delete the old projects because they will cause problems when you import the new
projects.

4. Create or update the Actions menu headers and submenu items that correspond to the
forms as required.

To override an existing form project

1. Ensure that the project name and the project ID matches the ones in the table exactly.

2. Select the overwrite existing project option when importing the form.
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Standard form template Project ID

Create Engagement 5c26f4ef-2c26-4640-b9f1-6861b8610351

Create Opportunity b171a117-79b0-445c-8d94-1cbc5908f696

Create Project acdc15a6-ea63-4641-b439-b31deb439ff6

Create Project Request 9a6ccb87-a6b3-4fe1-8b01-22121d4d8311

Project Status Report 50565368-d71b-426b-b4a4-892a356b563e

Statement of Work (SOW) 66b710d6-667d-42fd-b760-59d9b80fcd57

Generate Invoice Document 4fe2c7f7-c162-45bc-92e6-b6d3dff05ff1

Configuring Infiniti Manage after upgrading

1. Install the Intelligent Forms general patch 18.00.118.402 according to the instructions in the
patch release notes.

2. Sign into Infiniti Manage.

3. Add the authenticated user license and the seven authenticated project licenses for the
standard form templates.

4. If your Infiniti version is Intelledox Infiniti 9.5.9.0, click Produce. This is to synchronize
the version between the InfinitiDB database and the Intelligent Forms websites.

5. Create the following folders (one for each main Changepoint entity):

a. Company

b. Contact

c. Engagement

d. Invoice

e. Opportunity

f. Project

g. Request

h. Resource
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Tip: It is good practice to organize form projects under the folder that corresponds to the
related Changepoint entity.

6. Import the seven Intelligent Forms project packages from the product media into Infiniti
Manage.

7. Publish each form into its corresponding folder:

a. Create Engagement – Engagement folder

b. Statement of Work (SOW) – Engagement folder

c. Create Project – Project folder

d. Project Status Report – Project Folder

e. Generate Invoice Document – Invoice folder

f. Create Opportunity – Opportunity folder

g. Create Project Request – Request folder

8. Republish the document form projects in PDF format:

a. Click Folders, then select the Project folder.

b. Click Project Status Report.

c. In the Format section, clear the “Microsoft Word Document (docx, docm) check
box.

d. Select the Portable Document Format(pdf) check box.,

e. Click Save.

f. Repeat this procedure for the following form projects:

• Statement of Work (SOW) in the Engagement folder
• Generate Invoice Document in the Invoice folder

9. Click Data Sources and then update the connection strings for each of the following data
sources:

• Changepoint DB (DS Views and UDFs)

• Changepoint DB (Tables)

• Invoice
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a. In the Connection String field, remove Provider=SQLOLEDB.1;Persist Security

Info=True; from the beginning of the string.

b. Then replace {{ChangepointDB}} with the name of the Changepoint database, and
{{ChangepointDBServer}} with the database server.

c. In the Connect with these credentials field, enter the user ID and password to be the
same as used in the Changepoint web.config connection string.

Configuring Intelligent Forms in a load-balanced environment

If you are installing Intelligent Forms in a load-balanced environment, you must ensure that all
of the URLs point the same instance of a web server in the farm and not to the Load Balancer
because the underlying security token must always be generated from the same website.

1. Sign in to Infiniti Manage.

2. Click Settings > Connector Settings.

3. Select Changepoint.

4. In each instance of the InfinitiLaunch Web.config file, configure the following platform
keys to point to the same instance of a web server in the farm as chosen earlier and not to
the Load Balancer:

• CP_VerifyService.VerifyUser

• INFIN_PlatformService

After upgrading
1. Install the Changepoint online help. For more information, see "Installing the Changepoint

online help" on page 177.

2. Install Changepoint eLearning. For more information, see "Installing Changepoint
eLearning" on page 178.

3. Upgrade or install the Changepoint 2017 Windows Services.

If you previously installed Windows services, you must uninstall the previous versions
first. For installation instructions, see "Installing a Changepoint Windows service" on page
53.

4. If required, install BatchPrint for batch printing of invoices/cross charges.

For setup information, see "Configuring batch printing" on page 182.
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5. To upgrade COM API and Web Services, see the Changepoint API Installation Guide.

6. To reinstall the Microsoft Dynamics GP Toolkit, see the Microsoft Dynamics GP Toolkit
Administration Guide.

7. Advise users to delete the browser history before signing in to the Changepoint websites
for the first time. Refer users to the browser help for instructions.

Importing User Licenses

If your organization has obtained an additional license file, use Changepoint Administration
(Tools > License Management) to import the licenses after the upgrade is complete.

Note: You require the Manage Licenses security feature to import user licenses.
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Overview

This section describes how to port the Changepoint database between different versions or
editions of SQL Server.

Note: If the version of SQL server you are currently using is not supported in the new
version of Changepoint, then you must port the database first before upgrading it.
Otherwise, the order is not important.

Porting the Changepoint database
Note: Changepoint does not support SQL Server partitions.

On the source database server

1. Log in as sa to SQL Server Management Studio.

2. Disconnect all users from the database and set it to “Restricted Access to db_owner,
dbcreator or sysadmins” only.

3. Issue a CHECKPOINT.

4. Detach the database.

5. Copy only the .mdf and .ndf database files to the target SQL server.

6. Repeat this procedure for the CPExtended database.

On the target database server

1. Copy the following folder from the Changepoint product media to any location on the
target SQL server:

\Changepoint\Utilities\Porting SQL Databases\

2. Remove the read-only attributes from the copied files.

3. Log in as sa to SQL Server Management Studio.

4. Open the following script in an editor:

<TargetServerPath>\Porting Changepoint.sql

5. If you did not use the default database name, replace “Changepoint” with the database
name.
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6. Update the full path and file names of all the .mdf and .ndf files in the script.

7. Scroll to the bottom of the script, and then edit the input value for the stored procedure
DBM_EnableSqlDependency. For more information, see the comments in the script for
details.

8. Replace the CPSQLUser string in the script with the SQL account on the target server that
will be used for the Changepoint database connection.

9. (Optional) Edit the value of the input parameter for the stored procedure DBM_
SetupCPTempDB. For details, see the comments in the script.

10. Edit the value of the input parameter for the stored procedure DBM_SetupFullText. Do one
of the following:

• To populate the full text indexes immediately: set @Populate = 0x1

• For a large sized database, it is recommended to set @Populate = 0x0, and run the
CPFullText scheduled job later.

11. Edit the value of the input parameter for the stored procedure DBM_SetupScheduledJob.
For details, see the comments in the script.

a. If you are not using the default ScheduledJobs path, replace the value of the following
variable with the path used:

@SCHEDULE_JOB_PATH = '<cp_root>\ScheduledJobs\'

b. If you are not using the default Data Archiving path, replace the value of the following
variable with the path used:

@DATAARCHIVING_JOB_PATH = '<cp_root>\Data Archiving\'

12. Update the full path and file names of all the .mdf and .ndf files in the script for the
CPExtended database.

13. Run the script against the Changepoint database.

After porting the Changepoint database
After you port the Changepoint database to the target SQL server, perform the following steps.

1. Copy the contents of the Scheduled Jobs directory from the source SQL server, for
example:

<SourceServerPath>:\<cp_root>\ScheduledJobs\*.*
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to the Scheduled Jobs location on the target SQL server:

<TargetServerPath>:\<cp_root>\ScheduledJobs\

2. After porting the database, the size of the Changepoint and tempdb databases may have
increased due to the processing done during the porting. Adjust them back to the limits and
settings as per your internal policies.

3. Run the Login Settings utility on all the applicable applications and services to change the
Server field to the correct value for the target SQL server.

For more information about using the Login Settings utility, see the Changepoint
Installation Guide.

4. If you have an archive database and you are porting the source database, do the following:

a. Copy the contents of the Data Archiving directory from the source SQL server:

<SourceServerPath>:\<cp_root>\Data Archiving\*.*

to the Data Archiving location on the target SQL server:

<TargetServerPath>:\<cp_root>\Data Archiving

b. Edit the following file:

<TargetServerPath>:\<cp_root>\Data Archiving\Data Archiving.ini

c. Change the server name in the following section and save the file:

[CPSQLServer]

Name=TargetServerName

Porting an archive database
The procedure for porting an archive database is similar to the procedure for porting a
Changepoint database, except for the following:

• Do not set up scheduled jobs on the archive database

• If the source database remains on the same server, and only the archive database is ported
to a new server, change the [ARCSQLServer] section instead of the [CPSQLServer]
section of the <TargetServerPath>:\<cp_root>\Data Archiving\Data Archiving.ini

file. Change the server name in the following section and save the file:

[ARCSQLServer]

Name=ArcSQLName
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16. Optimizing Performance
Changepoint performance guidelines

You can improve the overall performance of the Changepoint application by making the
following adjustments to the default configuration of the Changepoint website.

Enable Session Cleanup scheduled job for RMW performance

If you are using Resource Management Worksheet (RMW), it is strongly recommended that
you activate the Session Cleanup scheduled job to maintain performance.

Configuring the antivirus exclusion list
To prevent performance issues caused by virus scans, you must configure the exclusion list
in the antivirus software.

Exclusion list for the database server

To determine the exclusion list for the SQL server, refer to the following information on the
Microsoft website:

https://support.microsoft.com/en-ca/help/309422/how-to-choose-antivirus-software-to-run-

on-computers-that-are-running-sql-server

Exclusion list for the web server

Include the subdirectories as well for all the excluded directories.

1. Changepoint installation directory: <cp_root>

2. .NET Framework files:

• C:\Windows\Microsoft.NET\assembly

• C:\Windows\Microsoft.NET\Framework\v4.0.30319

• C:\Windows\Microsoft.NET\Framework64\v4.0.30319

3. IIS config folder:

%SystemDrive%\Windows\System32\inetsrv\config\

4. IIS Temporary Compressed Files

%SystemDrive%\inetpub\temp\IIS Temporary Compressed Files

5. Pagefile.sys
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6. IIS Logs files, if IIS logging is enabled. The default is:

C:\inetpub\logs\LogFiles

Performance guidelines for the Changepoint database server
The performance of the database server is particularly important when you are preparing an
environment for high user loads. High performance is achieved by splitting as many I/O calls
as possible across multiple I/O channels, disks, and spindles in order to keep I/O queuing to a
minimum while using the entire available memory in the most efficient way.

Adjust maximum SQL server memory

By default, SQL Server configured with maximum server memory set to 2147483647 MB,
which in effect is all of the server memory that is available. The default setting can result in
insufficient memory for the operating system and other applications, which can cause
instability and performance issues.

Therefore, you must adjust the value for the default setting to allow some of the server
memory for the operating system and other applications. Use the following formula:

Maximum SQL Server Memory = Maximum Physical Memory – Memory for OS

Memory for the OS is between 1 GB and 4 GB, depending on the total physical memory of the
server.

Virtualized SQL server using VMware

If you have virtualized the SQL server using VMware, review the guidelines in the
Architecting Microsoft SQL Server on VMware vSphere, best practices guide, which is
available on the Vmware website:

http://www.vmware.com/content/dam/digitalmarketing/vmware/en/pdf/solutions/sql-server-on-

vmware-best-practices-guide.pdf

Dedicated I/O channels for database file types

Each database file type should have its own dedicated I/O channel (LUN, RAID set or
physical disk):

• Database log file on a RAID 10 array

• Database ndf files on a RAID 10 array

• Database mdf file on a RAID 10 array
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• tempdb database on RAID 0

If only three channels are available, the log file and tempdb can be on one channel. Use
multiple data files for tempdb (one per CPU-Core), set the initial size to 1 GB, and set the
auto-grow to 1 GB.
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About the decrypting connection strings

This document provides code samples for using the Changepoint Public Utility
(CPPubUtility) to decrypt the reportsdsn connection string in the Global.asa for use in
customizations. For additional information, contact your client services representative or
client manager.

CPPubUtility runs under the .NET Framework. This utility provides a single method
interface, which can be used to decrypt the connection string information that is stored in an
encrypted format in the Global.asa and Web.config files.

Typically, the CPPubUtility is installed on the web server, but it can also be installed on the
database server if needed.

Changepoint Public Utility Object Interfaces

Object: CPPubUtility.Decrypt

Method: DecryptString

Public Function DecryptString(ByVal sConnectionString As String) As String

Time-out Limits for Decrypted Connection Strings

Time-out periods are enforced for the decrypted connection strings. If a time-out is set, the
decrypted connection string includes the time-out value in seconds. For example:

provider=SQLOLEDB; Server=SERVER; database=Changepoint; uid=xxj; password=xxj;

Trusted_Connection=No; Timeout=900

If there is no time-out limit, the decrypted connection string does not include a time-out
value. For example:

provider=SQLOLEDB; Server=SERVER; database=Changepoint; uid=xxj; password=xxj;

Trusted_Connection=No

Code examples for decrypting connection strings

VB

Dim cmdSQL As ADODB.Command

Dim oCPDecrypt as CPPubUtility.Decrypt

Dim sConnectionString as String

Set cmdSQL = New ADODB.Command

Set oCPDecrypt = New CPPubUtility.Decrypt
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sConnectionString = GetObjectContext("Session").Contents("DSN")

With cmdSQL

.ActiveConnection = oCPDecrypt.DecryptString(sConnectionString)

…

VBScript

Dim cmdSQL

Dim oCPDecrypt

Dim sConnectionString

set cmdSQL = server.CreateObject("Adodb.Command")

set oCPDecrypt = server.CreateObject("CPPubUtility.Decrypt")

sConnectionString = Session("dsn")

With cmdSQL

.ActiveConnection = oCPDecrypt.DecryptString(sConnectionString)

.NET

Dim cmdSQL As SqlCommand

Dim oCPDecrypt As New CPPubUtility.Decrypt()

Dim sConnectionString As String

' Get connection string from configure file

sConnectionString = ConfigurationSettings.AppSettings("SQLSettings")

' Decrypt the connection string

sConnectionString = oCPDecrypt.DecryptString(sConnectionString)

If sConnectionString <> "" Then

cmdSQL = New SqlCommand()

cmdSQL.Connection = New SqlConnection(sConnectionString)

....

Report example for using CP Decrypt Interface
This report uses the CPDecrypt Interface to display a list of resource names and email
addresses on any Changepoint customer database.

<!--#include virtual="/IncludeFiles/inSession.asp"-->

<html>

<head>

<meta HTTP-EQUIV="PRAGMA" CONTENT="NO-CACHE"

<link rel="stylesheet" type="text/css" href="/css/<%=strLCID%>_documents.css

media="screen">

<link rel="stylesheet" type="text/css" href="/css/<%=strLCID%>_docPRINT.css

media="print">

</head>

<body>

<table cellspacing=0 cellpadding=2 width='98%' border=0>

<tr>
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<td class=head style="width:80%;" valign=top>Sample Report</td>

</tr>

<tr>

<td colspan=2 class=fadeline>&nbsp;</td>

</tr>

<td>v0.1<td>

</tr>

</table>

<p><span class="SummaryHead">Date & Time run:</span>&nbsp;&nbsp;

<%=FormatDateTime(date(),1)%></p>

<%

dim sSQL, rst

Dim cmdSQL

Dim oCPDecrypt

Dim sConnectionString

set cmdSQL = server.CreateObject("Adodb.Command")

set oCPDecrypt = server.CreateObject("CPPubUtility.Decrypt")

sConnectionString = Session("reportsdsn")

With cmdSQL

.ActiveConnection = oCPDecrypt.DecryptString(sConnectionString)

.CommandType = AdCmdText

End With

sSQL="SELECT Resources.Name AS ResourceName,

ResourceAddress.EmailAddress AS ResourceEmailAddress" &_

"FROM Resources, ResourceAddress" &_

"WHERE Resources.ResourceID = ResourceAddress.Resourceid"

cmdSQL.CommandText = sSQL

set rst = cmdSQL.Execute

if not rst.EOF then

Response.Write("<table cellpadding='0' cellspacing='0' border='0'

width='100%'>")

Response.Write("<tr><td class='TableHead'>Resource Name</td>")

Response.Write("<td class='TableHead'>Resource Email Address</td>")

while not rst.EOF

Response.Write("<tr><td class='rowUnderline'>" &

rst("ResourceName").Value & "</td>")

Response.Write(<tr><td class='rowUnderline'>" &

rst("ResourceEmailAddress").Value & "</td>")

rst.MoveNext

wend

rst.Close

Response.Write("</table>")

else

Response.Write("<p><span class='SummaryHead'>No data to display</p>")

end if

set rst = nothing

%>
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</body>

</html>
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18. Creating a Test and Training Environment
You can install both a test and training environment on the same server. For illustration
purposes, the test and training environments in these topics are called TEST and TRAIN.

For each environment, the database and full text catalogs are backed up on the production
environment and restored on the test/train server.

Warning: Do not install the TEST and TRAIN instances on the Changepoint production
server. It is recommended that the production server have only one instance of the
Changepoint database.

Backing up and restoring your production database to a different server still requires backing
up the full text catalogs and running the SQL Dependencies script for each server, as
outlined in step 3 to step 4 below.

Creating a test and training environment on the same server
1. For the first database instance, run the installer on the test/train database server. When

prompted, do the following:

• Select the Database only setup type.

• For the database name, enter a name for the test database, for example, TEST.

2. For the second database instance, run the installer again on the test/train database server.
When prompted, do the following:

• Select the Database only setup type.

• Select a different <cp_root> location than the first instance.

• For the database name, enter a name for the training database, for example, TRAIN.

3. Back up the database and full text catalogs on the production environment and restore
them on the TEST and TRAIN database instances.

4. In the EnableSQLDependency.sql script (located on the Changepoint product media in
the \Changepoint\Manual Install\Upgrade folder), replace all occurrences of the
CPSQLUser string with the SQL user ID you used when running the installer to create
the test and train database instances for each database that you restored.

5. Run EnableSQLDependency.sql.

6. Run the following scripts:
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a. Setup_Full_Text.sql

b. Setup_Scheduled_jobs.sql

c. Setup-CPExtended.sql

d. Setup-CPTempDB.sql (Ensure that the value for @CPTemp_DB is different from the
name of the original CPTempDB.)

7. Run the installer on the web server for each instance you want to create (TEST and
TRAIN, for example). Each website must have a unique name and port number. Configure
the Global.asa and Web.config files using the SQL accounts you created for each
database.

8. As required, run the installer on the same server or another server to install the required
Changepoint Windows services. For more information on installing and configuring the
services, see "Installing a Changepoint Windows service" on page 53.

9. In order for users to readily distiguish between the TEST Changepoint Administration and
the TRAIN Changepoint Administration versions, do one of the following:

• Create a Corporate News Knowledge Item with an expiry several years from now
indicating that this is a test/training environment.

• Update the Registration table and add "**TRAIN**" OR "**TEST**" to the company
name, which appears at the top of the Changepoint interface when users sign in to
Changepoint.

10. Install and configure Redis.

11. Sign in to Changepoint Administration and update the server integration and email
integration settings with the appropriate URLs for each instance.

12. If you use IBM Cognos, you must port the Cognos content store database. For more
information, see "Porting the Cognos content store database" on page 220.

Porting the Cognos content store database
Porting the Cognos content store database includes the following steps:

1. Export the Cognos content store database.

2. Import the Cognos metadata package.

3. Set up the Cognos data source for the testing site.
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Export the Cognos content store database

1. Sign in to Changepoint as Changepoint administrator.

2. Click Cognos > Cognos Connection.

3. Click Launch > IBM Cognos Administration.

4. Click Content Administration, and then select the export icon.

5. Enter a name for the deployment specification (for example Changepoint, and then click
Next.

6. In the Deployment method section, click Select the entire Content Store and then click
Next.

7. In the New archive option, enter a name for the deployment archive (for example,
Changepoint_Export) and then click Next.

8. Enter an encryption password for the archive and then click OK.

9. Review the summary and then click Next.

10. Click Save and run once, and then click Finish.

11. Select Now, and then click Run.

12. Click OK.

Import the Cognos metadata package

Import the Cognos metadata package for the testing site by following the instructions in
"Importing the Changepoint metadata package" on page 116.

Set up the Cognos data source for the testing site

1. Delete the production Changepoint data source.

2. Recreate the data source following the instructions in "Setting up the data source for IBM
Cognos" on page 117.

Setting up Client Portal in a training environment
For users to access Client Portal in a training environment, you can either set up a separate
Client Portal website, or users can specify a different login page in the URL of an existing
Changepoint website, for example:
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http://servername:port/fcelogin.asp

Note: If enhanced session management is enabled in Changepoint Administration, you
must create a separate Client Portal website. For more information, see "Setting up a
Client Portal website" on page 179.
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A. Configuration file settings
About Changepoint configuration files

There are two types of files that contain configuration settings for Changepoint.

Web.config files

Web.config files are application configuration files that contain settings that apply to the
areas of Changepoint that were developed using ASP .NET web application technology
(.aspx).

There is a configuration file for each application (Changepoint, Report Designer, and Web
Services). The default locations are:

<cp_root>\Enterprise\Web.config

<cp_root>\ReportDesigner\Web.config

<cp_root>\CP Web Services\Web.config

<cp_root>\API\CP Web Services\Web.config

<cp_root>\Enterprise\WebAPI\Web.config

<cp_root>\Enterprise\WebSockets\Web.config

Global.asa file

The Global.asa file is a centralized file that contains settings that apply to areas of
Changepoint that were developed using the ASP web application technology.

The default location is:

<cp_root>\Enterprise\Global.asa

Web.config configuration file settings

Authentication settings

By default, all Changepoint website folders and files are set to application authentication. If
you set up your websites for SSL, you must change settings in the corresponding Web.config
files. To use SSL with application authentication, see "About application authentication" on
page 148.

Caching settings

• EnableSQLDependency

If set to 1, the Changepoint SQL dependency cache is enabled. Resource feature
information will be cached as resources sign into the application. The default value is 1.
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• SQLDependencyCacheDuration

The elapsed time required in minutes before the Changepoint SQL dependency cache is
cleared. The default is 240.

Cognos BI settings

Launch Cognos portlets and portals in new browser window

By default, Cognos portlets and portals are launched within the Changepoint container.
However, you can configure Cognos portlets and portals to open in a new browser window.

• Cognos.IE.LaunchPortletsInNewWindow

When set to “true”, Cognos portlets and portals are launched in a new browser window.

Cookie settings

By default, cookies are enabled. To disable cookies, edit the sessionState element and set
cookieless="true".

Export Publishing settings

These settings in the Changepoint Web.config file apply only to the export publishing resend
option in Changepoint Administration.

• Microsoft.ServiceBus.ConnectionString

The connection string that is used to access Microsoft Service Bus.

• EnableEmail

If set to 1, email notifications are enabled for export publishing errors. The Changepoint
Mail Service must be installed in order to send notifications. The default is 0.

• EmailAddress

A semicolon-separated list of email addresses to which notifications of export publishing
errors are sent. The EnableEmail setting must be enabled and the Changepoint Mail
Service must be installed in order to send notifications to the specified addresses.

Field settings

The Fields.MaxSearchResult setting defines the maximum number of records that can be
returned for certain type-ahead fields. When the maximum is exceeded, the user is prompted
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to narrow the search criteria. The default is 500.

The Fields.MaxSearchResult setting applies to the following type-ahead fields:

• new type-ahead fields (excluding the tree view type-ahead fields), which are identified by
the yellow background when the user starts entering data in the field

• new type-ahead fields for configurable fields

• scenarios comparisons

• project worksheet

There are no configuration settings for the old type-ahead fields with the clear fields icons.
The maximum search results for these fields are hard coded and vary depending on the field.

Type-ahead configurable fields on projects and requests have an internal limit of 1000 for the
maximum number of records that can be returned. The imposed limit is the lesser of 1000 or
the value of the Fields.MaxSearchResult setting.

There is a separate setting for mobile access. For more information, see "Mobile access
settings" on page 226.

File type filter settings

The upload.FileExtensionNameExcludeFilter setting defines the file types that are blocked
from being uploaded through File Upload dialogs. The default list is "exe,bat,com."

HTTP runtime settings

If required, you can modify the values of these attributes of the httpRuntime setting:

<httpRuntime executionTimeout="900" maxRequestLength="40960" ... />

The descriptions of the attributes are as follows:

• executionTimeout

The maximum number of seconds that a request is allowed to execute before being timed
out. The default is 900.

• maxRequestLength

The input buffering threshold in KB when uploading files. The default is 40960.
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Mobile access settings

The following settings are related to mobile access:

• MobileFields.MaxSearchResult

The maximum number of records that can be returned for type-ahead fields when
Changepoint is accessed using a mobile device. The default value is 25.

• SupportedMobileDevice

A semicolon-separated list of supported mobile devices as referenced in the browser’s
user-agent string. You can add unsupported mobile devices to allow them access, if
required.

Page Content IDs (PCIDs)

Each string on the user interface is associated with a page content ID (PCID). There is a
setting that you can use to to display the PCIDs instead of the strings, which can be helpful if
you want to identify certain strings.

Warning: It is strongly recommended that you enable this setting only in a test
environment.

• GlobalDebug

When set to 1, the PCIDs are displayed on the user interface instead of the strings.

Page Size

The default page size used in some areas of Changepoint (for example, project portfolio and
advanced search) is controlled by the following setting:

• PageSize

The number of records to display before paging. The default is 100.

Projects tree view settings – Web.config

The Projects tree view display is controlled by several parameters, some of which are set in
Web.config. Other parameters are set in Global.asa.

Number of projects in the Projects tree view

• tvProject.Project.RecordAmount
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Determines the number of projects (default 500) that are displayed initially in the Projects tree
view.

• tvProject.Project.PackAmount

Determines the number of projects (default 50) by which the Projects tree view is
incremented on demand.

Refresh of the Projects tree view

• tvProject.Project.AutoRefresh

When enabled (tvProject.Project.AutoRefresh=1, default), the Projects tree view is refreshed
automatically when a project is created or deleted, or when the project name is modified.

When disabled (tvProject.Project.AutoRefresh=0), the Projects tree view is not refreshed
when a project is created or deleted, or when the project name is modified, until the Filter
button is clicked.

• tvProject.Task.AutoRefresh

When enabled (tvProject.Task.AutoRefresh=1, default), the Projects tree view is refreshed
automatically when a task is created or deleted, or when the task name is modified using the
Edit Task dialog.

When disabled (tvProject.Task.AutoRefresh=0), the Projects tree view is not refreshed when
a task is created or deleted, or when the task name is modified using the Edit Task dialog,
until the Filter button is clicked.

Note:When you create or delete a task in the project worksheet, the Projects tree view is
not refreshed, regardless of the value of tvProject.Task.AutoRefresh.

Initial loading when a project is selected in the tree

See "Projects tree view settings – Global.asa" on page 230.

Copy project

See "Projects tree view settings – Global.asa" on page 230.

Scenario comparisons worksheet (SCW) settings

The following settings apply to scenario comparisons:

• ScenarioComparison.MaxViewColumnCount
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The maximum number of columns that can be selected in a view. The default is 100.

• ScenarioComparison.MaxFilterColumnCount

The maximum number of columns that can be displayed in the filter column of the Manage
Filter dialog. The default is 5000.

• ScenarioComparison.MaxFilterScenarioCount

The maximum number of items that can be selected in the Selected items list on the
Other Criteria tab of the Manage Filter dialog. The default is 50.

Resource management worksheet (RMW) settings

The following setting applies to the Resource Management Worksheet:

• ResourceManagementView.MaxRecord

The maximum number of records that can be returned for any given type-ahead field in the
Resource Management Worksheet. When the maximum is exceeded, the user is prompted
to narrow the criteria in the type-ahead field.

Some of the Resource Management Worksheet filter pages have an Engagement/Initiative
list that is populated based on selections in other fields. The maximum record setting also
applies to these Engagement/Initiative lists. The default is 200.

Time-out settings

The ASP .NET implementations (.aspx) in Changepoint use the following setting:

• CommandTimeOut

The default value is 600 seconds for Changepoint, and 30 seconds for Report Designer.

Terminology mode settings

The mode is selected when Changepoint is installed or upgraded. The only reason for changing
this setting after installation is to switch terminology.

For Changepoint PPM (Project Portfolio Management):

Application("CompanyProfile") = "ITD"

For Changepoint PSA (Professional Services Automation):

Application("CompanyProfile") = "PSO"
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Note: Other changes are required to switch terminology. For more information, see
"Switching between PSA mode and PPM mode" on page 255.

Tree view settings

The naming pattern for the tree view settings in the Web.config file is:

<add key="treeview.node.property" value="n"/>

For example, the following is a typical pair of tree view settings:

<add key="tvMyContact.Contact.RecordAmount" value="500"/>

<add key="tvMyContact.Contact.PackAmount" value="50"/>

This example sets the RecordAmount and PackAmount properties for the Contact node of the
MyContact tree view. The RecordAmount property defines the maximum the number of
records to load when the node is first expanded. The PackAmount property defines the size of
the next lot of records to load for this node. Using the above example, if there are more than
500 contacts in the database, the first expansion shows the first 500 contacts, with a “next”
link at the bottom of the list. Clicking the “next” link retrieves the next 50.

Note: You cannot use tvOpportunity.Engagement as a treeview.node pair for this
purpose.

Workflow settings

The following settings control when a filter appears in the workflow view:

• WorkFlow.Layout.StateShapeThreshold

The maximum number of states that can be displayed in the workflow view before a filter
appears.

• WorkFlow.Layout.StateTransitionThreshold

The maximum number of transitions that can be displayed in the workflow view before a
filter appears.

The filter will also appear if the total number of states and transitions in the workflow is
greater than the sum of these two settings.

Global.asa configuration file settings

Caching settings

• Application("EnableSQLDependency") = 1
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If set to 1, the Changepoint SQL dependency cache is enabled. Resource feature
information will be cached as users log onto the application.

• Application("SQLDependencyCacheDuration") = 240

The Changepoint SQL dependency cache is cleared after 240 minutes.

Cookie settings

By default, the AgentlessCookie setting is enabled:

Application("AgentlessCookie") = 1

When enabled (set to 1), a cookie will be returned to the client machine with the user’s
logon ID. The cookie can be used by monitoring software to identify a user for reporting
purposes. You can disable the setting by changing the value to 0.

Page Content ID (PCID) settings
Application("GlobalDebug")=0

When enabled, the page content IDs (PCIDs) are displayed in the user interface instead of the
PCID strings (field labels). This can be helpful to debug changes to the labels, but should only
be done in a test environment. The setting is disabled by default.

Page size

The default page size used in some areas of Changepoint (for example, project portfolio and
advanced search) is controlled by the following setting:

Application("PageSize") = 100

The value is the number of records to be displayed before paging.

Projects tree view settings – Global.asa

The Projects tree view display is controlled by several parameters, some of which are set in
Global.asa. Other parameters are set in Web.config.

Initial loading when a project is selected in the tree view

• tvProject.SkipAutoLoad

When enabled (tvProject.SkipAutoLoad=1), the Projects tree view is displayed only after a
resource clicks the Filter button.
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When disabled (tvProject.SkipAutoLoad=0, default), the Projects tree view is displayed when
the resource selects the project in the tree.

Refresh project tree after copying a project

• tvProject.CopyProject.AutoRefresh

When enabled (tvProject.CopyProject.AutoRefresh=1, default), the project tree view is
refreshed automatically when copy project is used to create a new project.

When disabled (tvProject.CopyProject.AutoRefresh=0), the project tree view is not refreshed
after a project is copied, until the Filter button is clicked.

Number of projects in the project tree view

See "Web.config configuration file settings " on page 223.

Refresh of the project tree view

See "Web.config configuration file settings " on page 223.

Reporting

The following configuration settings relate to reporting:

• Application("VacationTrackStartDate") = "YYYY-MM-DD"

The start date for reports that track vacation.

• Application("rsNotificationInterval") = 5

The interval, in minutes, that the Changepoint UI checks to see if the user has any report
schedules that have completed. If reports have completed, then a small, informational
window is displayed in the Changepoint interface.

• Application("OpenRequestsByCustomerRecordAmount") = 500

The maximum number of customer records that are returned in the customer drop-down list
on the filter page for the Open Requests by Company report.

Terminology mode

The mode is selected when Changepoint is installed or upgraded. The only reason for changing
this setting after installation is to switch terminology.

For Changepoint PPM (Project Portfolio Management):
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Application("CompanyProfile") = "ITD"

For Changepoint PSA (Professional Services Automation):

Application("CompanyProfile") = "PSO"

Note: Other changes are required to switch terminology. For more information, see
"Running both PSA mode and PPM mode on the same database" on page 256.

Time-out (ADO Commands)

To enable a global time-out value that will be used for all ADO commands, change "0" in the
following setting to the number of seconds that you want to assign to the global time-out value:

Application("GlobalCommandTimeout") = 0

When set to zero, which is the default, the global time-out setting is disabled. In this case, the
time-out utilized is either the ADO command value or the value that is supplied in connection
string.
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Changepoint installer issues

* WARNING: Redis cache service could not be installed. Ensure that service
(RedisService) and port (6379) is not in use. Please review the
RedisCacheService.log file under the InstallLog folder and install and start the
service manually.

During the Changepoint 2017 installation, Redis cache service could not be installed and star-
ted. This would typically occur if there is already a Windows service, including an existing
instance of Redis, that is using the Redis service name (RedisService), or the Redis port
(6379) is currently assigned to another process.

To properly install the Redis service, you must assign a unique service and a port that is not
currently assigned. Please refer to the "Installing and Configuring Redis" on page 31 for the
manual Redis service installation and start up commands.

Database upgrade error

If the database upgrade fails, an error message appears. Do the following:

1. Check the log file for details. The log file path is specified in the error message.

2. Restore the database from the backup you made before upgrading.

3. Resolve the issues detailed in the log file.

4. Perform a manual database upgrade.

IIS error when installing Changepoint websites

If you attempt to install the Changepoint websites on a web server, but Internet Information
Services (IIS) is missing, or the wrong version of IIS is installed, an error message appears.

Make sure that a supported version of IIS is installed on the web server and then try again.

Error: Operation failed with #X######X An attempt was made to load a program
with an incorrect format

If this error occurs during the installation of the Changepoint websites, ensure that the
required components and roles have been installed on the web server. For more information,
see the Changepoint Product Architecture and Technology Matrix.
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Error Number: 0x80004005 Description: Unspecified error Setup will now
terminate

This error might occur if you use Remote Desktop Protocol (RDP) to install Changepoint.

Increase the colors setting to more than 256 colors (Remote Desktop Connection > Display >
Colors.)

Changepoint troubleshooting issues

Empty keys error in Event log

The NotificationProvider.Key1 and NotificationProvider.Key2 keys must be configured with
valid license values to enable use of the Changepoint Mobile app.

If you have not set up Changepoint to use the Mobile app, then you must comment out the
NotificationProvider.Key1 and NotificationProvider.Key2 keys in the CPMail.exe.config file.

HTTP 403 error
Project Planning Worksheet fails to save
Preferred resources cannot be edited

If you have enabled Request Filtering on the Changepoint website or use tools such as
URLScan to restrict HTTP verbs in HTTP traffic, you must do the following:

1. Add the following verbs to the [AllowVerbs] section:

• PUT

• PATCH

• DELETE

2. Remove the same verbs from the [DenyVerbs] section.

Blocking these verbs can result in unexpected HTTP errors and functional issues in
Changepoint. As of this service pack, Changepoint deploys the new Changepoint REST API
internally (and externally as an option) to enable mobile app support and some internal product
functionality. The REST API uses the HTTP verbs in its transactions.

3. Restart the web server or web application.

Project planning worksheet does not load
Error when accessing Manage Preferred Resources
"Access to registry key 'Global' is denied" in Changepoint event log

Restart the web server. These errors can occur when registry permissions have been changed.
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Users cannot upload large attachments

In order to upload attachments up to 40 MB in size to team folders, requests, and knowledge
items, you might have to set the following in IIS Request Filtering and/or in URLScan.ini,
depending on the versions of Windows Server and IIS that you are using:

maxAllowedContentLength=40000000

Changepoint web pages do not render

Ensure that the required Windows components have been installed.

Browser not supported message in Internet Explorer (IE)

If users try to access Changepoint using Internet Explorer and receive a message that the
browser is not supported, they must do the following:

1. Disable the compatibility view setting.

2. Ensure that the Changepoint website is not in the “Websites you’ve added to Compatibility
View” list.

For more information about disabling the compatibility view setting, see the Internet Explorer
online help.

Changepoint web pages take a long time to render

The first time you access a page in Changepoint, the page is compiled and takes longer than
usual to render. If your antivirus software interferes with the compilation, a page error might
occur. If a page error occurs, navigate to the page again. Some larger pages require re-
navigating more than once. After the compilation is complete, the pages render more quickly.

Error message appears instead of the Changepoint sign-in dialog box

Ensure that the Login Settings utility has been run to configure the Changepoint configuration
files and that the database server, database name and SQL account information entered is
correct. For more information using the Login Settings utility, see "About configuring database
connection settings" on page 65.

Error message: Please contact your system admin for this error!

Refer to the Changepoint Section in the Event Viewer for the actual error message.
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Error message: Changepoint is not correctly registered

Ensure that the license file has been imported using Changepoint Administration.

Application is restarting error in the web browser

Ensure that the Changepoint application folder (<cp_root>) is excluded from antivirus scans.
For more information, see:

JavaScript errors in Internet Explorer

After an upgrade, users must delete all browsing history in Internet Explorer. If users still
encounter JavaScript errors after they have deleted the browsing history, they must delete the
temporary Internet files manually. For more information about deleting browsing history and
temporary Internet files, see the Internet Explorer online help.

Ajax errors

Ajax errors are typically a result of a configuration mismatch between the authentication
configured for the website in IIS and the authentication settings configured in the Web.config
file.

To resolve the errors, correct the mismatch. For more information, see the authentication
sections in "Overview of configuration" on page 47 and "Web.config configuration file settings
" on page 223.

Changepoint Windows Services errors in the Event Viewer

Ensure that the database connection settings have been configured properly for the
Changepoint Windows Services. For more information, see "About configuring database
connection settings" on page 65.

Repeated logon failures with “Your session is no longer active” message

This error can occur if the Changepoint websites are sharing the same application pool, or if
you attempted to install multiple website instances without specifying a unique name and port
number for each website. To resolve the issue, ensure that the application pool, website name,
and port number are unique for each website instance.

Knowledge search returns “No matches found” message

Do the following:

1. Verify that the user has the required permissions to view the records.
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2. Verify that the “CPFullText” or “CPFullText using background updates” scheduled jobs
are enabled and ran successfully.

If the user has the required permissions and the scheduled jobs ran successfully, then there
might be a full text issue. Refer to the Microsoft website for information on troubleshooting full
text issues.

Child workgroups not sorted correctly in standard reports that contain a
Resource Workgroup selection field

Cannot expand workgroups in the User Setup tree view

If one or both of the above issues occur, you must regenerate the object breakdown structure
(OBS) for workgroups:

1. From the 2017 Release Notes and Patches team folder, download the Workgroup OBS
Utility.zip file from the Utility subfolder

2. From the Workgroup OBS Utility.zip file, extract the CPRegenerateWGOBS.exe to any
client machine that has a connection to the Changepoint database server.

3. Execute CPRegenerateWGOBS.exe.

4. Enter the SQL server name, database name, SQL login, and password.

5. Click Connect.

6. From the Global Workgroup list, select the global workgroup.

7. Click Generate OBS.

SSO ADFS issues

Server Error in '/RP-STS_ADFS' Application

If users encounter an error similar to the following:

Server Error in '/RP-STS_ADFS' Application.

The data protection operation was unsuccessful. This may have been caused by not having
the user profile loaded for the current thread's user context, which may be the case when
the thread is impersonating.

Do the following on the Changepoint web server:

1. In Internet Information Services (IIS) Manager, click Application Pools
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2. Select the Application Pool used by the Changepoint web site.

3. Click Advanced Settings

4. Set Load User Profile to True, then click OK to save and close Advanced Settings

5. Re-open Advanced Settings, set Load User Profile back to False, then click OK

Changepoint Web Services API Issues

Errors related to .Net version when accessing Web Services API

If users encounter .Net version-related errors when accessing the Web Services API, and the
API is installed on a web server other than the Changepoint web server, ensure that the
application pool for the hosting website is using the required version of the .NET framework.

Changepoint Windows Services Issues

Changepoint Windows Service does not appear in Add/Remove program in
Windows Control Panel

If the Windows service you want to remove does not appear in the Add/Remove Programs in
the Windows Control Panel, then you must do the following:

1. Run the installation program for the service from the Changepoint media for the previous
release, and select Repair.

2. After the installation is repaired, you can remove the service using Add/Remove
Programs.

Changepoint Windows Service does not start

All Changepoint Windows Services validate their version numbers against the version table in
Changepoint. The version numbers must match, otherwise the service will not start, and a
message is recorded in the event log.

Emails remain queued

Due to startup timing issues, it is possible that services have been started but are not
functioning properly, which may cause emails to remain queued instead of being sent.

You can fix this problem by creating a dependency for the Changepoint Windows Services on
the MSSQLServer service. For more information, see the Microsoft knowledge base
article 193888 at: http://support.microsoft.com/kb/193888.
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Exchange Server troubleshooting

Calendar items do not synchronize from Changepoint to Outlook

• Ensure that the user has the Enable Calendar Synchronization feature.

• Ensure that the user has selected the correct calendar synchronization option in the
Preferences view in Changepoint.

Calendar items do not synchronize from Outlook to Changepoint

• Ensure the Changepoint Exchange Synchronization Service is running.

• Ensure that calendar items match the General Calendar Synchronization Options settings
(Daily Start Time, Daily End Time and Time Zone) in the Preferences view in
Changepoint.

Event log

Check the event log for messages and errors. The following table lists the common events
(EWS refers to the Exchange Web Service).

Event Comments

Description: The primary SMTP address

must be specified when referencing a

mailbox.

Error. Themessage is returned via EWS.

Users must have an Exchange primary email

address in Changepoint.

Description: Unable to create calendar item in

Exchange for user: user@domain.com

Error. Themessage is returned via EWS.

Calendar item add failed. This can happen for

a number of reasons, for example, a user is

synchronizing with an alternate email

address.

Description: Unable to update calendar item
in Exchange for user: user@domain.com

Error. Themessage is returned via EWS.

Update to calendar item failed. This can

happen for a number of reasons, for example,

a user is synchronizing with an alternate

email address.

Description: Unable to update calendar item
in Changepoint for user: user@domain.com

Error. Themessage is returned via
Changepoint. Update to calendar item failed.
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Event Comments

Description: Unable to add calendar item in

Changepoint for user: user@domain.com

Error. Themessage is returned via
Changepoint. Calendar item add failed.

Description: Autodiscover exception
occurred in DiscoverTryUrls.

Email Address: user@domain.com

Exception: The email address cannot be
found.

Warning. The email address cannot be found.

Description: Autodiscover exception
occurred in DiscoveryTryUrl.

Target url:
https://servername.domainname

/autodiscover/autodiscover.xml

Warning. Autodiscovery failed when targeting
the indicated URL.

Description: Autodiscover exception
occurred in GetRedirectUrl.

Target url:
https://servername.domainname

/autodiscover/autodiscover.xml

Warning. Autodiscovery failed when targeting
the indicated URL.

Description: Autodiscovery failed for user:
user@domain.com

Warning. Autodiscovery failed for the
indicated user.

Description: Calendar Synchronization
Started - Version: XX.XX.XXX.XXX

Information. Documents the start of a
synchronization cycle.

Description: Calendar Synchronization
Finished

Information. Documents the completion of a
synchronization cycle.

Function:
Changepoint.Synchronization.Exchange

.CreateCalendarItem

Response: ErrorCalendarDurationIsTooLong
Extended Information: Email address:
user@domain.com

Error. EWS prevents calendar items from

being created when duration is greater than

five years. This is a limitation in Exchange .
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Event Comments

Function:
Changepoint.Synchronization.Exchange

.UpdateCalendarItem

Response: ErrorCalendarDurationIsTooLong
Extended Information: Email address:
user@domain.com

Error. EWS prevents calendar items from

being updated when duration is greater than

five years. This is a limitation in Exchange .

Function:
Changepoint.Synchronization.Exchange

.GetItem

Response: ErrorItemNotFound
Extended Information: Id:
AAMkADUxOWVlNTdjLWE2OW

QtNDQwMC1hMTZmLTUyMWFk

N2RmNDk4OQBGAAAAAAAlhrFE

5hKpSK2C4OPkOtc/BwAAOrm5Pd

RuTI2+olSwbXC4AAAAATSrAAD

Bake3jpVuTLttXQS5sS3xAAzFdNI5AAA=

Error. An attempt was made to retrieve a
deleted item from Exchange. This message

can be ignored as the code responds by

recreating the deleted item.

Function:
Changepoint.Synchronization.Exchange

.UpdateCalendarItem

Response:
ErrorOccurrenceTimeSpanTooBig

Extended Information: Email address:
user@domain.com

Error. Themessage is returned via EWS.

Indicates that the time allotment for a given

occurrence overlaps with another occurrence

of the same recurring item.

SQL Server troubleshooting

SQL Server setup issues

The System Information script (SQLEnvironmentReport.sql) provides information that you can
use to troubleshoot system setup issues.

1. Log on to the SQL server machine with the local administrator account.

2. Run the following script from the Changepoint product media:

\Changepoint\Utilities\Changepoint System Information Script

\SQLEnvironmentReport.sql
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The following information is reported:

• General system information:

Host Name

OS Name

OS Version

OS Configuration

System Up Time

System Manufacturer

System Model

System Type

Processor(s)

BIOS Version

Windows Directory

Boot Device

System Locale

Input Locale

Time Zone

Total Physical Memory

Available Physical Memory

Page File

Page File Location(s)

Hotfix(s)

Network Card(s)

All Services Status

SQL Service Status

• Current SQL Instance information

Current SQL Instance

SQL Server Version

SQL Server Property

SQL Server Configure

• Database information (will list information for each database)

Database Name

Database Property

Database Files

Changepoint database troubleshooting

Password validation error when running Porting Changepoint.sql

If you receive a password validation error when running the Porting Changepoint.sql script,
reset the password to a password that conforms to your Windows security policy. If the
database has already been attached successfully, run the script again starting from:
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USE Changepoint

GO

Similarly, if you receive any other errors with this script and the database is already attached,
fix the problem and be sure to choose an appropriate starting point beyond the attachment
section when rerunning the script.

Restoring the database from a backup

When you restore the Changepoint database on a server, the service broker is disabled. Run
the following on the restored database to enable the service broker:

ALTER DATABASE <DatabaseName> SET SINGLE_USER WITH ROLLBACK IMMEDIATE

ALTER DATABASE <DatabaseName> SET ENABLE_BROKER

ALTER DATABASE <DatabaseName> SET MULTI_USER

Excessive table growth issues

If email notifications have been enabled in Changepoint Administration, verify that both the
Changepoint Email Notification Service and the Changepoint Mail service have been installed
and configured to run at regular intervals. Otherwise, the EmailAuditStaging,
EmailAuditNotification, and EmailQueue tables in the database can potentially grow to a very
large size.

Archive database troubleshooting

Archive Aged Entities Job or Data archiving[200x].dtsx fails

If the Archive Aged Entities job or Data Archiving 2005.dtsx or Data Archiving

2008.dtsx fails for any reason, and you do not want to proceed with the archiving, you must
run the following script to re-enable triggers and foreign keys on the Changepoint source
database:

C:\Program Files\Changepoint\Changepoint\Data Archiving\EnableAllTRsNFKs.sql

If required, restore the archive database from backup.

Error running Archive Aged Entities Job on Windows 2008/.NET 3.5
SP1/SQL2008

To be able to run the Archive Aged Entities job on a Windows 2008/.NET 3.5 SP1/SQL2008
environment, you must log in using a user account with local admin privileges instead of a
system account. In other words, you cannot use an account such as
LocalService/NetworkService/LocalSystem.
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Temporary Database available for troubleshooting

The Archive Aged Entities job automatically creates a temporary database named
<database name>_ArcDistribution on the source database server. The temporary database is
available for troubleshooting purposes until the next time that the job is run, when it is dropped
and recreated.

Archive database performance issues

The following performance issues have opposing solutions:

• To improve performance of the archive database for end users, you can add indexes to the
Archiving database.

• To improve the speed of the Archiving Aged Entities scheduled job, you can remove
indexes from the Archiving database.

You can add indexes by applying the Adding archiving indexes.sql script, or remove
indexes by applying the Removing archiving indexes.sql script from the following location
on the Changepoint media:

\Changepoint\Manual Install\Data Archiving\

Cognos BI installation troubleshooting

Error: RQP-DEF-0177 appears in report or workspace area

Error: “RQP-DEF-0177 An error occurred while performing operation
'sqlPrepareWithOptions' status='-201'” in the report or workspace area, likely means that the
database name in the SQL connection string for Cognos was not specified during installation.

Error: Invalid Web Content URI when configuring the App Tier

If you get this error when trying to save the configuration of the Environment node in the
Explorer pane during the configuration of the App Tier, then you must reset the Web Content
URI to the default as follows:

1. In the Explorer pane, select the Portal Services node.

2. Click in the Web Content URI field.

3. From the Cognos menu, select Edit > Reset to Default.
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Connection test fails when testing the data source configuration

If the connection test fails for either SQL or the JDBC, it likely means that no SQL Server
Native Client was installed on App Tier server, or the wrong native client was installed.

On the App Tier server, install the version of SQL Server Native Client that matches the SQL
version on the server that hosts the Cognos content store. For more information, see the
"Setting up the data source for IBM Cognos" on page 117.

Error: AAA-CFG-0008 in AppTier configuration

If the following message appears during the start of the Cognos service on App Tier:

Error: “AAA-CFG-0008 The handler class 'com.changepoint.cap.CapControl ' cannot

be loaded”.

Error: “java.lang.ClassNotFoundException: com.changepoint.cap.CapControl”.

Retest the Changepoint namespace connection.

If the test passes, restart the service.

If the test fails, delete and recreate the Changepoint namespace, then test again.

Web server error when embedding graphics that are hosted on a web server in
reports

To embed graphics that are hosted on a web server in your reports, refer to the IBM Cognos
product documentation.

If you are using URLScan, WebRequest Filtering or Application Filtering at your firewall to
block WebDAV traffic, you must make the necessary security configuration changes.

Changepoint-Cognos Sync utility troubleshooting

Timeout error when updating the model with a new revision

If there are a large number of configurable fields in the database, one or both of the following
might occur when you update the Cognos model with a new revision:

• New Revision dialog box takes a long time to appear

• “Message: Timeout expired” error in the Cognos UI log file

You can increase the timeout setting in the CognosClientTools.exe.config file:

1. As administrator, open the CognosClientTools.exe.config file:

%programfiles%\Changepoint\Cognos Client Tools\CognosClientTools.exe.config
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2. Edit the following key, then save the file. The default value is 300.

<add key="CommandTimeOut" value="1800" />

Error: BME-SP-0007 An unknown error occurred during execution

This error appears on the Details dialog box of the Sync Utility during the updating of the delta
page content and configurable fields to create a new revision of the Cognos model.

Ensure that the same version of the SQL Server Native Client is installed on the Changepoint
Cognos administrator workstation, and the server that hosts the Cognos content store.

Error: BME-SP-0032 Your user id or password is incorrect. Re-enter your logon
credentials

If you see this message when running the Sync Utility, ensure that the Changepoint database is
online by restarting the Cognos service on the App Tier.

Error: QE-DEF-0368 Unable to decrypt user name and password credentials from
the content store …

Complete message: QE-DEF-0368 Unable to decrypt user name and password credentials
from the content store. Review and save the Cognos Configuration settings to configure your
reporting environment.

This error appears on the Details dialog box of the Sync Utility during the updating of the delta
page content and configurable fields to create a new revision of the Cognos model.

1. Exit the Sync Utility.

2. In the <install location>\ibm\cognos\configuration directory, delete the following
folders:

• csk

• encryptkeypair

• signkeypair

3. Launch IBM Cognos 10 > IBM Cognos Configuration, then click Save.

4. Launch the Sync Utility.
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Troubleshooting scheduled jobs

Resource Demand Calculation scheduled job – performance issues or failure

By default, the Resource Demand Calculation scheduled job rolls up projects in batch
processing mode.

However, if the job was not scheduled to be run daily, batch mode may not handle the load
from accumulated changes. Or if there is an issue with one or more projects, the job might fail.
In both cases you can switch the job to single mode processing as a workaround to roll up
projects manually until the issues have been addressed.

To switch the Resource DemandCalculation job to singlemode processing

1. In SQL Server Management Studio, append “0” to the step that calls the stored procedure
RollupProjectsByFiscalPeriods as follows:

exec RollupProjectsByFiscalPeriods 0

2. You can then start and stop the job manually multiple times until all projects have been
rolled up.

To revert to batch processing mode, either remove the “0”, or change the “0” to “1”.

Troubleshooting Intelligent Forms

How do I troubleshoot issues that I encounter while using forms?

The errors that are generated while using forms are listed in the Management tab of Infiniti
Manage. If you do not have access to Infiniti Manage, contact your Infiniti administrator to do
this for you.

When I access a submenu item in the Actions menu, a sign-in for Infiniti appears

To enable single-sign on for Intelligent Forms, the resource's email and password must be
entered into their Changepoint user account.

When I click Intelligent Forms > Infiniti Manage, an "Access denied" error
appears

To access Infiniti Manage from Changepoint Administration, a resource must be assigned the
Global administrator role in Infiniti Manage. For more information, see "About security
features for Intelligent Forms" on page 1.
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Adding fiscal periods to group financial analysis data
Data in the Financial Analysis Data Providers is grouped by the default set of fiscal periods
selected in the Funding and Scenario Comparison Setup in Changepoint Administration.

To add other fiscal periods, insert a row into the database table FinAnnFiscalPeriod that
contains the billingofficeid of the fiscal periods.

Note: These changes must be done directly in the database table: there is no UI.

Note: It is not necessary to add every billing office or every set of fiscal periods. It is
only necessary to add one for each frequency (for example, weekly, monthly or
quarterly) that is to be reported on.

Enabling financial analysis record types
The underlying financial analysis views rely on data that is calculated by the Financial
Analysis Summary scheduled job and Calculate Project Costs scheduled jobs for specific
record types. FinAnnRecType contains all the record types. The "enabled" field indicates
which record types are enabled for calculation.

By default, only part of the record types are enabled.

Additional record types can be enabled. Existing record types can be disabled if they are not
being used (for example, the types for forecast may be disabled if status updates are not
being done and the information is not needed for reporting).

Note: These changes must be made directly in the database table: there is no UI.

To enable a record type, mark the row as "enabled" in the FinAnnRecType table in the
database.

Warning: The more record types that are enabled, the longer the processing of the two
jobs will take. This applies particularly to record types that group data at the task
assignment level. For large databases, reporting at the task assignment level may result
in performance issues. Ensure the grouped data providers are used (by month or fiscal
period) and that the report is filtered sufficiently.
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Dependencies among record types

• Types 0-26, which are enabled by default, should be left as enabled if the scenario
comparisons functionality is being used.

• If you use funding sources, leave existing record types enabled. To start using funding
sources after the upgrade, enable the appropriate record types:

• If Projects are associated with funding sources, enable record types 28, 29, 42, 43.

• If Requests are associated with funding sources, enable types 1, 3, 7, 9, 21, 22, 23.

• If Opportunities (Candidates) are associated with funding sources, enable types 11, 12,
13, 14.

• If any type that is related to invoiced items (type 1, 2, 20, 32, 37, 38, 39, 40, 41, 46) is
enabled, enable type 0.

• If type 12 is used, enable type 11.

• If type 14 is used, enable type 13.
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Creating a custom form

You can create a custom form by doing the following.

1. In Infiniti Manage:

a. Create the form project.

b. Configure the form project to use Changepoint data.

c. To create a form that creates or updates entities, configure the form project to push
and pull Changepoint data.

2. Make the form available to resources in Changepoint. In Changepoint Administration,
create the Actions menu subheader and submenu item to make the form available to
users in Changepoint.

Configuring a form project to push and pull Changepoint data

To enable a form project to push data to and pull data from Changepoint, you must add three
label questions to the form project in Infiniti Manage. The answer to the questions are
parameters that are populated at run time and provide the information that is required for
authentication and handshaking between Infiniti Launch and Changepoint.

Question Answer Save by unique label

Session ID Session ID sno

Resource ID Resource ID rid

Entity ID Entity ID cpguid

1. In Changepoint, click Intelligent Forms > Manage.

2. Click the Projects tab, and then select the project.

3. Add a question for each of the following IDs. Enter the same ID text for both the
question and the answer:

• Session ID

• Resource ID 
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• Entity ID

4. For each of the questions, do the following:

a. Expand the question and then select the answer.

b. In the Properties tab, expand the Answer File Properties section.

c. Select the Save to answer file check box.

d. Click the Save by unique label option.

e. In the text field, enter the text as follows:

• For Session ID, enter sno
• For Resource ID, enter rid
• For Entity ID, enter cpguid

About creating form projects that create or update entities

You can create an intelligent form that creates an entity record or updates an existing entity
record. For example, you can create a form that guides resources through the process of
creating or updating a request record.

You create a form project in Infiniti Manage (Infiniti Manage > Design App), where there is
a default set of Changepoint actions for creating and updating each of the main entities. The
actions include the standard fields and configurable fields for the entity. For each field you can
specify a fixed value or a reference to an answer value.

You add the actions to the final page in a forms project, and the actions are triggered when the
form is submitted. When the forms project is complete, you can configure it to be used in
Changepoint.

Adding an Intelligent Forms form to the Actions menu

To make a forms project available to resources in Changepoint, you must create a submenu
header and submenu item for it to appear in the Actions menu.

Note: The following instructions are specific to creating a submenu header and submenu
item for an Intelligent Forms form.

1. In Changepoint Administration, create the submenu header (User Interface > Actions
Menu Integration).
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2. From the submenu header, create the submenu item. In the Parameter field, you must
enter the ID of the form project, which you obtain from the initial view of the form project
in Infiniti Manage.

3. In the Access control section, you must restrict access to the form by security feature as
follows:

• If the form creates or updates an entity record, restrict access to the Access Forms
Generation security feature that is in the Intelligent Forms category.

• If the form creates a document, restrict access to the Access Document Generation
security feature

4. In User setup, assign the security feature to each of the resources who require access to
the form.

Adding logos for invoices/cross charges
Before a logo can be added to invoices for a billing office or cross charges for a cost structure,
the image file for the logo must be placed in the C:\Changepoint\Images\ folder on the
Changepoint web server.

Advise users that when they enter the path to the logo in Changepoint Administration, they
must exclude the default folder. For example, if the image file is located at:

C:\Changepoint\Images\invoicelogo.jpg

Users would enter:

/Images/invoicelogo.jpg

Adding a custom invoice/cross charge format
Before a custom invoice/cross charge format can be set up in Changepoint Administration, the
format must be created and then placed under <cp_root>.

1. Create the custom invoice/cross charge format in an ASP file.

2. Place the ASP file in the <cp_root>\core\report folder or another location under <cp_
root>.

3. Advise users that when they enter the path to the logo in Changepoint Administration, they
must exclude <cp_root>.
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Adding a custom ASP report
Before a custom ASP report can be set up in Changepoint Administration, you must add the
report file to the Changepoint web server.

As a best practice, add a Custom folder to the Changepoint/Core/Report/ path for storing
custom reports.

Advise users that when they specify the report URL in Changepoint Administration, they must
leave out the Changepoint domain, but include the file name, for example:
Core\Report\Custom\MyReport.asp.

Changing printers for batch printing
If you add or remove printers on the web server, you will likely need to reconfigure batch
printing.

1. Run the htmlprint.exe file in the BatchPrint directory on the web server.

2. Make the necessary changes to the values of the PrintServername keys in the
PrintInvoices.exe.config files.

3. In Changepoint Administration, make the necessary changes to the following workgroup
fields:

• Print Server Name field

• Default Printer field

For more information, see "Configuring batch printing" on page 182.

About changing between PSA and PPM modes
Changepoint runs in one of two modes: Changepoint PPM (Project Portfolio Management) and
Changepoint PSA (Professional Services Automation). The mode is selected during
installation, but you can switch modes after installation.

Database tables modified by the UpdateSystemDefaults stored procedure

For reference, the following is a list of the database tables that are modified when you run the
UpdateSystemDefaults stored procedure.

AccountType

AutoNumberingSetup

CategoryDescription

Chart
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ContactType

ContractType

CriteriaType

Dashboard

DialogDefault

Email

EmailParameters

ExchangeApplied

ExpenseCategory

ExpenseGLACenter

ExpPubTopic

FeatureDescription

GlobalWorkgroup

HelpDesk

InvoiceFormats

IPICategoryType

IPIMetricCalc

IPIMetricType

KMCategory

LineOfBusiness

LockType

OpportunityType

Report

ReportCategoryDescription

ReportDefinitionDescription

RequestBillingType

RequestStatus

RequestType

ResourceRequestType

ResourcesRequestInitiateLevel

RevenueTypeGLA

Role

SalesStatus

Section

SectionItem

SurveyTemplateS

SurveyTriggerType

TitleDefinitionDescription

Version

WorkflowEntity

WorkflowParticipants

WriteOffReasons

Switching between PSA mode and PPM mode
If you installed one mode but later decide to switch to the other mode, you can do this by
running a stored procedure and changing the appropriate configuration settings.
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1. Open Microsoft SQL Server Management Studio and connect to the Changepoint database
using the sa account.

2. Run the UpdateSystemDefaults stored procedure using the ITDFlag value to set the mode:

• To switch to PSA mode:

exec UpdateSystemDefaults @ITDFlag = 0

• To switch to PPM mode:

exec UpdateSystemDefaults @ITDFlag = 1

3. In the Global.asa file, do the following:

• For PSA mode, set CompanyProfile to "PSO"

• For PPM mode, set CompanyProfile to "ITD"

4. In the Web.config files for each application (Changepoint, WebAPI, and Report Designer)
do the following:

• For PSA mode, set CompanyProfile to "PSO"

• For PPM mode, set CompanyProfile to "ITD"

Running both PSA mode and PPM mode on the same database
You can run both PSA and PPM websites using the same Changepoint database.

1. Start with a PSA mode installation.

2. Run the InstallShield Wizard to create another set of Changepoint websites. When
prompted, select the Websites only setup type, and select the ITD mode.

For more information, see "Installing multiple Changepoint instances" on page 24.

3. Distribute the URLs for the PSA and PPM websites to your users according to the version
that they require.

Note: Most terms such as field and dialog box names in the Changepoint websites display
the correct values according to the specified mode. However, some terms (for example,
report names, feature names, and drop-down values in some lists) may not match the
ITDFlag setting.

ASP-based reports that support DSN
The ASP reports that can use a separate report server are:
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• All Companies/Clients

• Campaign Profitability

• Competition by Frequency

• Customer Radar

• Employee Vacation Tracking

• Engagement/Initiative Grid By Owner

• Engagement/Initiative Profitability by Month

• Engagement/Initiative Workload

• Expense Reports Approved By Me

• Expense Reports by Resource

• Expense Reports by Status

• Features Assigned to a User

• Invoice/Cross Charge Details with Net Write-offs

• Invoiced/Cross Charged Hours by Resource

• List of All Engagements/Initiatives by Company

• Losses by Competitor

• Management Responsibility By Resource

• My Contacts

• My Expense Reports

• My Knowledge Items

• My Task List

• Non-Invoiced/Non-Cross Charged Time & Expenses

• Opportunities Won/Candidates Approved

• Personal Vacation Time

• Planned Revenue Booked By Company
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• Project Completion

• Project Progress

• Project Progress All

• Project Slippage

• Project Summary by Resource

• Projects by Status by Customer

• Projects by Status by Project Manager

• Reference Customers

• Resource by Task

• Resource History

• Resource Workload

• Resources By Approver

• Resources by Function

• Task Status Compliance

• Tasks in Progress or Scheduled to Start

• Tasks Scheduled to Finish in Two Weeks

• Time & Expense by Billing Office/Cost Center

• Time & Expense by Invoice/Cross Charge Number

• Time & Expenses by Employee

• Time Submission Conformance

• Time Summary Report by Resource

• Weekly Time Sheet

• Work Performed for

• Workgroup Record History
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Setting up access to Changepoint portlets and reports in third-
party portals

Changepoint portlets and other specifically-enabled pages can be rendered directly in a
browser or in third-party portal solutions such as IBM WebSphere, CA CleverPath, and
Microsoft SharePoint, using a portlet-specific URL that is based on a common entry point.

To access portlets and reports from outside Changepoint, use the common entry point, and pass
additional parameters as required in the querystring:

The URL format is:

http://<entrypoint>&portletid=<PortletId>&params=<Params> …&url=<URL>

where:

• entrypoint – <ChangepointURL:port>/core/portlet.aspx?ui=p

• ChangepointURL:port – the URL and port number of your Changepoint website

• PortletId (required) – Id of the portlet to display (see list below)

• Params (optional) – Additional querystring parameters separated by ";"

• URL (optional) – Custom portlet URL

Notes

• If the website uses SSL, use the https protocol in place of http.

• If the website uses application authentication, portlet users are prompted for a user name
and password for access to the portlet.

• If the website uses integrated Windows authentication, or one of the other Single Sign On
(SSO) methods supported by Changepoint, portlets are displayed to authenticated users
without requiring further sign on.

• Links from a portlet to other areas of Changepoint are not supported. For example, if you
display the My Reminders portlet, then click on one of the links within the portlet (for
example, "You have time to approve"), the link target might not render or function
correctly.

• You are responsible for ensuring that the custom page renders correctly using UI=P.
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Changepoint portlet names and IDs

Portlet name PortletId

Custom portlet url *Custom

See notes below.

Campaign/ Source

Source/ Campaign Results dshCampaign

Upcoming Sources / Campaigns dshUpcomingCampaign

Client/ Customer & Contact

Find Person dshFindPerson

Engagement/ Initiative

Initiative / Engagement Warnings dshEngagement

Expense

Expense Expense

ExpenseReport ExpenseReport

Financial Management

Financial Reminders dshFinancialReminder

Invoice/ Cross Charge

Approved Cross Charges / Invoices dshApprovedInvoice

Cross Charges / Invoices Pending

Approval

dshPendingInvoice

Draft Cross Charges / Invoices dshDraftInvoice

Rejected Cross Charges / Invoices dshRejectedInvoice

Knowledge Management

Create Knowledge item dcSubmitKM
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Portlet name PortletId

KnowledgeManagement dshKM

Opportunity/ Candidate

Active Candidates / Opportunities dshActiveOpportunity

Approved Candidates / Opportunities dshOpportunityWin

Candidate / Opportunity Decision

Summary

dshOpportunityOutcome

Candidate / Opportunity Decisions dshCompetitiveOutcome

Candidate / Opportunity Rollups dshOpportunityRollup

Initiate Candidate / Opportunity

screening

rpOppScreening

Personal portlets

My Activities dshActivity

Activity List uiActFrames

My Favorite Reports dshFavoriteReport

My Links dshMyLink

My Performance dshMyPerformanceChart

My Reminders dshReminder

My Utilization dshMyUtilization

Requests Assigned ToMe dshRequestToMe

Requests Initiated By Me dshRequestByMe

Performance Management

PerformanceManagement dshPerformanceChart
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Portlet name PortletId

Project Management

Project Status by Project Manager

Report

rpProjectByStatus_PM

Reporting

Cognos reports Cognos

See notes and examples, below.

Report Detail ReportDetail

See notes and examples, below.

Report with filter page ReportDetailContainer

See notes and examples, below.

Requests

Create request dcrequest

See notes below.

Edit Request dcrequest

See notes below.

Requests Summary dshRequestSummary

Initiate Planning Request screening rpReqScreening

Resource Management

Find Person dshFindPerson

Underutilized Resources dshUnderutilizedResource

Workgroup Utilization dshWkgpUtilization

Surveys

Survey Management dshSurveyManagement

Timesheet

Timesheet Timesheet
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Examples

My reminders:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=dshReminder

Create Request:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=dcrequest

Notes

Custom

To use a custom url:

• PortletId = "*Custom"

• Url = ~/Custom/Reports/{your custom report here}.asp

Example:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=*custom&url=~/Cust

om/Reports/rpCustomRequestReport.asp

Cognos reports

ReportID is required.

• PortletID=Cognos

• Params = reportid=<ReportID>

You can find the ReportId using Changepoint Administration (see "Using Changepoint
Administration to get Report IDs" on page 265). For reports that are not in portlet format,
you can use an SQL query or IE properties.

Example:

http://<ChangepointUrl:port>/core/portlet.aspx?ui=p&portletid=Cognos&Params=repo

rtid=<ReportId>

Reports (ReportDetail and ReportDetailContainer)

ReportId is required.

• PortletId=ReportDetail

or
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• PortletId=ReportDetailContainer

• Params = reportid=<ReportId>

You can find the ReportId using Changepoint Administration (see "Using Changepoint
Administration to get Report IDs" on page 265). For reports that are not in portlet format,
you can use an SQL query or IE properties.

Example:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=ReportDetail&Param

s=reportid=D2AD8CC6-FFE9-4E2A-8980-8AFE8C766059

Requests (dcrequest)

Create Request with a tabbed layout (default is inline):

If no template is specified, the default template is used. See "Create a request using a
template" on page 264.

• PortletId = dcrequest

• Params = layout=tabbed

Example:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=

dcrequest&Params=layout=tabbed

Create a request using a template

• PortletId = dcrequest

• Params = templateid=<TemplateId>

You can find the TemplateId using a SQL query or IE properties.

Example:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=

dcrequest&Params=templateid=ff7e7079-9e0b-4856-9d7c-f9721437f737

Edit a request

RequestId is required

• PortletId = dcrequest
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• Params = action=edit; reqnum=<request number>

Example:

http://<ChangepointURL:port>/core/portlet.aspx?ui=p&portletid=

dcrequest&Params=action=edit;reqnum=SR-2012-00157

Edit a request using a template

RequestId is required.

• PortletId = dcrequest

• Params = action=edit; reqnum=<request number>;selectedtemplateid=<EditTemplateId>

You can find the EditTemplateId using a SQL query or IE properties.

Example:

http://<ChangepointURL:port>/core/

portlet.aspx?ui=p&portletid=dcrequest&Params=action=edit;reqnum=SR-2012-

00157;selectedtemplateid= ff7e7079-9e0b-4856-9d7c-f9721437f773

Using Changepoint Administration to get Report IDs

To get a report ID:

1. In Changepoint Administration, go to User Interface > Portlet Management.

2. In the Category list, select All portlets.

3. From the list of portlets, select the report.

4. In the URL field, copy the reportid=<ReportId> from the end of the URL.
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